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Notice
The information contained in this document is subject to change without notice.

Agilent Technologies makes no warranty of any kind with regard to this material, including 
but not limited to, the implied warranties of merchantability and fitness for a particular 
purpose. Agilent Technologies shall not be liable for errors contained herein or for incidental 
or consequential damages in connection with the furnishing, performance, or use of this 
material.

LIMITED WARRANTY
The material contained in this document is provided “as is,” and is subject to being changed, 
without notice, in future editions. Further, to the maximum extent permitted by applicable 
law, Agilent disclaims all warranties, either express or implied with regard to this manual 
and any information contained herein, including but not limited to the implied warranties of 
merchantability and fitness for a particular purpose. Agilent shall not be liable for errors or 
for incidental or consequential damages in connection with the furnishing, use, or 
performance of this document or any information contained herein. Should Agilent and the 
user have a separate written agreement with warranty terms covering the material in this 
document that conflict with these terms, the warranty terms in the separate agreement will 
control.

Assistance
Product maintenance agreements and other customer assistance agreements are available for 
Agilent Technologies products. For any assistance, refer to “Contacting Agilent” on page 350.
ii



Software Licensing
The Physical Layer Test System has node-locked licensing. Node-locked licenses are licenses 
that are tied to a personal computer and it’s specific ID. Agilent software looks for that specific 
ID when it starts. If the ID is not found, the software is locked and does not start. Refer to 
Chapter 1, Installing your Physical Layer Test System, for the licensing procedure.

Software Compatibility
This user’s guide is compatible with software revisions 1.101 and above. 

Document Conventions
This document uses a few conventions to make reading easier.

• Menu and dialog box items are shown in bold face type. When described in text, menus and 
sub-menus are separated by right arrows, as in File > Open > Data…

• Window and dialog box names are shown in italic font.

• Keyboard entries are shown in mono-spaced typeface.

• Network analyzer keys are displayed in �������������	� font.
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I Installation and Quick Start
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Part I guides you through the initial steps of setting up and using the physical layer test 
system.

Chapter 1, “Installing your
Physical Layer Test System”

Provides you a step-by-step physical layer test system 
installation procedure.

Chapter 2, “Becoming 
Familiar with your 
Physical Layer Test System”

Provides you detailed physical layer test system software 
and test equipment descriptions to familiarize you with 
the test system components.

Chapter 3, “Making a
Measurement using 
the Sample Device”

Provides you with a step-by-step procedure to make a 
basic measurement using the physical layer test system. 
2



1 Installing your Physical Layer Test 
System
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Installing your Physical Layer Test System
The Physical Layer Test System (PLTS) consists of the following items:

• Personal computer (PC)

• Network analyzer

• S-parameter test set 

• PLTS software

This installation procedure will lead you through a series of steps to set up your PLTS. 
The following is a list of the installation steps:

• Step 1. Set Up the Personal Computer

• Step 2. Verify your System Shipment

• Step 3. Set Up the Network Analyzer

• Step 4. Attach the Test Set to the Network Analyzer (N4464A/B − N4421A Only)

• Step 5. Install the S-Parameter Test Set on a Bench Top or in an Equipment Rack

• Step 6. Make the Interconnections between the S-Parameter Test Set and the Network 
Analyzer

• Step 7. Set Up the GPIB

• Step 8. Power up the Physical Layer Test System

• Step 9. Install the Physical Layer Test System Software 

• Step 10. License the Physical Layer Test System Software

• Step 11. Start the Physical Layer Test System Software

NOTE These installation instructions were written specifically for customers who 
have just received their PLTS. If you have already been using our S-parameter 
test set and its corresponding network analyzer, you have probably completed 
most of these installation steps. Briefly review installation steps 1 through 8 to 
ensure that your system is currently set up as recommended. Then, begin the 
software installation process by starting at “Step 9. Install the Physical Layer 
Test System Software” on page 25.
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Installing your Physical Layer Test System
Step 1. Set Up the Personal Computer
Step 1. Set Up the Personal Computer

1. Make sure that your PC meets the following minimum system controller requirements:

•  700 MHz Pentium1 III (or better) PC compatible computer 
(1 GHz Pentium III is recommended)

• Windows NT2, Windows3 2000, or Windows XP
(Windows 2000 or Windows XP is recommended)

Windows should be run with the latest service pack available.

• At least 256 megabytes of RAM
(512 MB RAM is recommended)

• CD-ROM Drive

• Supported GPIB Interface

❏ Agilent 82357A USB/GPIB Interface for Windows (which provides a direct 
connection from the USB port on your PC to GPIB instruments), 

or

❏ Supported GPIB card
(any National Instruments or Agilent 82340, 82341, or 82350 GPIB card)

(Agilent 82357A USB/GPIB Interface for Windows or any National Instruments GPIB 
card is recommended)

2. Using the PC documentation, make sure that the PC is operating properly.

3. Make sure the GPIB card is installed in the PC and that it is operating properly.

4. Make sure the PC is located near where you will position the network analyzer and the 
test set. Later in this process, you will connect the GPIB card to the Physical Layer Test 
System (PLTS) using the GPIB cable.

1. Pentium is a U.S. registered trademark of Intel Corporation.
2. Windows NT is a U.S. registered trademark of Microsoft Corporation.
3. Windows and MS Windows are U.S. registered trademarks of Microsoft 

Corporation.
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Installing your Physical Layer Test System
Step 2. Verify your System Shipment
Step 2. Verify your System Shipment

1. Unpack your system from the containers in which it was shipped.

WARNING The test system hardware is heavy. The network analyzer can weigh 
between 53 lb. (24 kg) and 64 lb. (29 kg). The test set can weigh as much 
as 20 lb. (9 kg). Use proper lifting techniques.

2. Carefully inspect the system hardware (the network analyzer and the test set) to make 
sure that it was not damaged during shipment.

NOTE If your test system was damaged during shipment, contact Agilent 
Technologies. Refer to “Contacting Agilent” on page 350.
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Installing your Physical Layer Test System
Step 2. Verify your System Shipment
3. Using Table 1-1, verify that your test set is compatible with your network analyzer and its 
installed options. Refer to “Step 3. Set Up the Network Analyzer” on page 10 for additional 
information regarding network analyzer options. If the installed options are not 
compatible, contact us before proceeding. Refer to “Contacting Agilent” on page 350.

Table 1-1 Physical Layer Test System Configurations

Test Set
Model 

Number

System
Frequency

Range

Supported Network Analyzer

Model 
Number

Optionsa

a. This table lists only the most specifically relevant options. For compatibility with options not 
listed here, contact the factory.

Required Compatible Incompatible

N4415A 30 kHz
to

6.0 GHz

8753ES 006b, 014

b. Option 006 required only for operation above 3 GHz.

002, 004, 010, 
1D5

011, 075, H16

N4416A 300 kHz
to

6.0 GHz

E8356Ac/7A/8A

c. Using this network analyzer, the maximum operating frequency is limited to 3 GHz.

015 010, 1D5

N4417Ad

d. E8356A family requires N4417A Option 103; E8801A family requires N4417A Option 104.

300 kHz
to

9.0 GHz

E8356Ac/7Ae/8A

e. Using this network analyzer, the maximum operating frequency is limited to 6 GHz.

015 010

E8801Ac/2Ae/3A 014 010, 1E1, 1E5

N4418A 50 MHz
to

20 GHz

8720ES H32 or H42 010, 012, 400 007, 085, 089

8722ESf

f. When an 8722ES is used with an N4418A, the N4418A requires Option 302. The system’s 
maximum operating frequency is limited to 20.0 GHz.

H32 or H44 010, 012, 400 007, 085, 089

N4419A 45 MHz
to

20 GHz

E8362A/B 014 010, 022, 711, 
UNL

N4421A 45 MHz
to

50 GHz

E8364A/B 014 010, 022, 711, 
UNL
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Installing your Physical Layer Test System
Step 2. Verify your System Shipment
4. Check the accessories that were shipped with your system. Your network analyzer 
accessories will be checked during the network analyzer setup. 

Item 
Number

Part Number Part Description

1 N1930-90002 User’s Guide (this document)

2 N1930A Physical Layer Test System Software CD-ROM (in envelope 
with Agilent Software License Terms printed on exterior)

3 N/A Software Entitlement Certificate (in envelope)

4 Unique to country AC Power Cord (for the test set)

5 8120-3445 GPIB Cable (3 feet)

6 Varies by Test Set 
Model and Option

Semirigid interconnect cables (refer to Step 6. Make the 
Interconnections between the S-Parameter Test Set and 
the Network Analyzer for the appropriate number of cables)

7 N/A “Port 3” Label

8 AD00658 Balanced Transmission Line PC Board Device (Sample DUT)

9 1600-1423 4 Lock Links (N4421A only) With 8 screws (0515-1499)

10 Left: Z5823-20239 
Right: Z5823-20240

2 Rear Locking Feet (N4421A only) (With 4 Screws - 2 each - 
longer: 0515-0686 and shorter: 2680-0179)
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Installing your Physical Layer Test System
Step 2. Verify your System Shipment
5. If you ordered any of the following options, check the parts. Option 1CP is shipped in a 
separate container.

Option 
Number

Item 
Number

Part Description

1CP 1A
1B

Rack mount flange kit (For use with handles)
Handles (set of 2)

B20 2 Precision 50-ohm cables (4)

060 3 4-Port Electronic Calibration Module/Kit (Not available as an 
option for the N1951A/53A/57A PLTS)

Other Calibration Kits

N/A Not Shown 85033E 3.5mm Calibration Kit (30 kHz− 9 GHz) 1

85052D 3.5mm Economy Calibration Kit (45 MHz − 26.5 GHz) 1

85056A 2.4mm Precision Calibration Kit (45 MHz − 50 GHz) 1

85050C 7 mm Precision Calibration Kit (45 MHz − 18 GHz) 2

1 Kit for SOLT Calibration; 2 Kit for TRL Calibration
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Installing your Physical Layer Test System
Step 3. Set Up the Network Analyzer
Step 3. Set Up the Network Analyzer

1. Using Table 1-2, verify that your network analyzer options are compatible with the 
physical layer test system. Incompatible options are shaded.

Table 1-2 Common Hardware Option Number Descriptions for Network Analyzers

8753ES Network Analyzer Options

002 Harmonic-Measurement Upgrade 004 Step Attenuator Upgrade

006 6 GHz Upgrade for Standard Units 010 Time Domain Capability

011 Receiver Configuration 014 Configurable Test Set

075 75 Ohm Impedance 1D5 High Stability Frequency Reference

H16 Low Noise Floor

8720ES and 8722ES Network Analyzer Options

007 Mechanical Transfer Switch 010 Time Domain Capability

012 Direct Sampler Access 085 High-Power Test System

089 Frequency Offset Mode 1D5 High Stability Frequency Reference

400 Four-Sampler Test Set H32 Front panel access to A and B samplers 
and Port 1 and Port 2 switch and 
coupler

H42 8719/8720 only: Front panel access to all 
samplers and Port 1 and Port 2 switch 
and coupler (installs options 400 & 012) 

H44 8722 only: Front panel access to R1, R2, 
A, and B samplers, and Port 1 and Port 
2 switch and coupler ports (installs 
options 400 & 012) 

E8356A, E8357A, and E8358A Network Analyzer Options

010 Time Domain Capability 015 Configurable Test Set

E8801A, E8802A, and E8803A Network Analyzer Options

010 Time Domain Capability 014 Configurable Test Set

1E1 Extended Power Range 1E5 High Stability Timebase

E8862A/B and E8864A/B Network Analyzer Options

010 Time Domain Capability 014 Configurable Test Set

016a Add Receiver Attenuators 022 Extended Memory
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Installing your Physical Layer Test System
Step 3. Set Up the Network Analyzer
2. Using the network analyzer’s Installation and Quick Start Guide, set up the network 
analyzer. 

3. If you are installing your network analyzer in an equipment rack, be sure to leave at least 
2 rack units of space below the analyzer to install the test set.

NOTE For the N4421A test set, connect the E8364A/B network analyzer to the test set 
before placing in the rack as a single unit on one set of rails. Refer to“Step 4. 
Attach the Network Analyzer to the Test Set” on page 12 for instructions. 

080a Frequency Offset 081a External Reference Switch

083a Frequency Converter Measurement 
Application

711 Standard Power Range

UNL Extended Power Range with Bias Tees

a. This option has not been tested and is not specified with the Physical Layer Test System.

Table 1-2 Common Hardware Option Number Descriptions for Network Analyzers
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Installing your Physical Layer Test System
Step 4. Attach the Network Analyzer to the Test Set
Step 4. Attach the Network Analyzer to the Test Set 
(N4464A/B Network Analyzer − N4421A Test Set Only)

If your test set is not an N4421A, continue with “Step 5. Install the Test System on a Bench 
Top or in an Equipment Rack” on page 15.

The E8364A/B network analyzer is attached with the N4421A test set using lock links at the 
front and locking feet at the rear. This hardware is supplied with the N4421A test set. Other 
network analyzers are not attached to test sets (N4415A, N4416A, N4417A, N4418A, and 
N4419A) using this hardware.

Preparing the Network Analyzer

1. Remove the four feet from the bottom of the network analyzer.

2. Remove the screws from the two lower rear panel standoffs.

3. Install the two rear locking feet where the standoffs were removed. Use part number 
Z5823-20239 on the left side of the analyzer and part number Z5823-20240 on the right 
side. Use the two longer screws to secure the feet to the analyzer.
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Installing your Physical Layer Test System
Step 4. Attach the Network Analyzer to the Test Set
Preparing the Test Set

4. Remove the trim strip from the top of the front frame.

5. Install the four lock links to the top of the front frame using eight screws.
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Installing your Physical Layer Test System
Step 4. Attach the Network Analyzer to the Test Set
Attaching the Network Analyzer to the Test Set 

6. Place the network analyzer on top of the test set ensuring that the front frame of the 
network analyzer is positioned slightly forward of the lock links that are attached to the 
the test set. Then slide the network analyzer back so the lock links engage the front frame 
of the analyzer.

7. Secure the network analyzer’s lower locking feet to the test set’s upper locking feet by 
inserting the shorter two screws between the two pairs of locking feet, one on each side of 
the instrument as shown below. 

If the screw holes between the network analyzer’s lower locking feet are not aligned with 
the screw holes in the test set’s upper locking feet, loosen the screws securing the feet to 
the instruments slightly to align. 

8. Tighten all screws.
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Installing your Physical Layer Test System
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
Step 5. Install the Test System on a Bench Top or in an 
Equipment Rack
The test system can be installed on a bench top or in an equipment rack. 

In all installations, consider the following ventilation requirements when deciding where to 
set up your test system.

CAUTION Ventilation Requirements: 
When installing the product in a cabinet, the convection into and out of the 
product must not be restricted. The ambient temperature (outside the cabinet) 
must be less than the maximum operating temperature of the instrument by 
4 °C for every 100 watts dissipated in the cabinet. If the total power dissipated 
in the cabinet is greater than 800 watts, then forced convection must be used.

Refer to the section that applies to your installation.

• For bench top installation, continue on page 16.

• For equipment rack installation, continue on page 17.
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Installing your Physical Layer Test System
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
To Install on a Bench Top

1. Place the test set and the network analyzer on a bench top. In the example illustration 
shown below, the system is placed on a riser as an alternative to the bench top. Make sure 
that there is at least four inches of clearance on the sides and back of the system for 
adequate ventilation.

The front panel test cables are shown only as a reminder to make sure they can easily 
reach the test surface of the bench.

CAUTION Consider the ventilation requirement described on page 15 when selecting the 
location of your system.

2. Continue with “Step 6. Make the Interconnections between the S-Parameter Test Set and 
the Network Analyzer” on page 20.
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Step 5. Install the Test System on a Bench Top or in an Equipment Rack
To Install in an Equipment Rack

When you install the test set in an equipment rack, you will install rails in the rack to support 
the weight of the test set, attach the handles and the rack mount flanges to the test set, and 
secure the test set to the equipment rack.

1. Ensure that the front handle kit, the rack mount flange kit, and the rack mount rail set 
are complete.

NOTE If any items are damaged or missing from a kit, contact us (refer to “Contacting 
Agilent” on page 350) to order a replacement kit. Items within these kits are 
not individually available.

2. Install the rails into the equipment rack using the instructions provided. Consider that the 
test set is two rack units high (3.5 inches). Mount the test set immediately below the 
network analyzer.

NOTE For the N4421A test set, connect the E8364A/B network analyzer to the test set 
before placing in the rack as a single unit on one set of rails.

Handle Kit Contents Flange Kit Contents

• 4 Screws
• 2 Side Trim Strip
• 2 Handles
• Installation Instructions

• 4 Screws (Long)
• 4 Screws with Washers
• 4 Nuts with Metal Clips
• 2 Flanges
• Installation Instructions
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Installing your Physical Layer Test System
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
3. Attach the cabinet mount flanges and the handles to the sides of the front panel, using two 
long screws per side. (Attach the flanges to the outside of the handles.)

WARNING If an instrument handle is damaged, you should replace it 
immediately. Damaged handles can break while you are moving or 
lifting the instrument and cause personal injury or damage to the 
instrument.

4. Remove the feet before cabinet mounting the analyzer using the directions imprinted on 
the feet.
Chapter 118



Installing your Physical Layer Test System
Step 5. Install the Test System on a Bench Top or in an Equipment Rack
5. Ensure there is adequate clearance between the system cabinet and the sides and back of 
the test system for adequate ventilation.

CAUTION Consider the ventilation requirements described in “Step 5. Install the Test 
System on a Bench Top or in an Equipment Rack” on page 15 when selecting 
the location of your system.

6. Lift the test set and slide it onto the rails that you installed earlier from the front of the 
equipment rack. Secure the test set to the equipment rack using the screws with washers 
and metal-clipped nuts provided in the flange kit.

7. Continue with “Step 6. Make the Interconnections between the S-Parameter Test Set and 
the Network Analyzer” on page 20.
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Installing your Physical Layer Test System
Step 6. Make the Interconnections between the S-Parameter Test Set and the Network Analyzer
Step 6. Make the Interconnections between the 
S-Parameter Test Set and the Network Analyzer

1. Locate your system or test set and network analyzer listed below. Refer to the page 
indicated for information describing the interconnections between the test set and the 
network analyzer.

2. Using the illustration and table located on the page referenced above in step 1, connect the 
interconnect cables between the test set and the network analyzer. Torque the semirigid 
cable connectors to 8 inch-pounds.

TIP If the test set and the network analyzer are rack mounted, the screws securing 
the rack mount flanges to the instrument rack may be loosened slightly to allow 
for minor repositioning of the instruments. Don’t forget to retighten the screws 
when you are done.

Test System 
Model Number

Test Set 
Model Number

Network Analyzer 
Model Number

Refer
to:

N1947A
N1948A
N1951A
N1953A
N1957A

N/A
N/A

N4417A
N4417A
N4418A
N4419A
N4421A
N4416A
N4415A

E8801A, E8802A, E8803A
E8356A, E8357A, E8358A
8720ES, 8722ES
E8362A/B
E8364A/B
E8356A, E8357A, E8358A
8753ES

page 44
page 46
page 48
page 50
page 52
page 54
page 56
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Step 7. Set Up the General Purpose Interface Bus (GPIB)
Step 7. Set Up the General Purpose Interface Bus (GPIB)
The PC uses the General Purpose Interface Bus to communicate with the test system devices, 
the test set and the network analyzer. Each test system device has a unique GPIB address. 
GPIB addresses are five-bit binary numbers set with the switches labeled “16” through “1”, 
with “1” being the least significant digit. The five address switches allow for 32 GPIB 
addresses, numbered from 0 to 31. The test set has a default address of “18” that is set at the 
factory. While this address is a unique address in most cases, the address may be changed (if 
required) to avoid conflicts with other equipment on the same bus.

There are three other switches labeled “T”, “L”, and “S” which correspond to Talk, Listen, and 
Status. The factory default for these switches is off.

1. Make sure the GPIB address switch on the rear panel of the test set is set to the correct 
address. The illustration below shows the factory default setting of “18”, which is set by 
turning on switches “16” and “2”. Make sure the “T”, “L”, and “S” switches are set as shown 
(off).

2. Make sure that the network analyzer GPIB address is set to a unique address. The factory 
default address of the network analyzer is “16”. Refer to the network analyzer 
documentation for information about how to check and set the GPIB address of the 
analyzer.
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Installing your Physical Layer Test System
Step 7. Set Up the General Purpose Interface Bus (GPIB)
3. Connect a GPIB cable from the rear panel GPIB connector on the network analyzer to the 
rear panel GPIB connector on the test set.

4. Connect a second GPIB cable from the PC GPIB card’s connector to the GPIB connector on 
either end of the first cable that was connected (in step 3 above).

NOTE After changing any GPIB address setting, cycle the ac power on all system 
equipment (PC, network analyzer, and test set) to establish the new GPIB 
address.
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Step 8. Power up the S-Parameter Test Set
Step 8. Power up the S-Parameter Test Set

1. Ensure the available ac power supply meets the Power Source Requirements and the 
operating environment meets the Operating Environment Requirements listed below.

Refer to Chapter 11, “Specifications and Characteristics,” for the complete specifications.

2. Verify that the ac power cable is not damaged, and that the power-source outlet provides a 
protective earth contact.

CAUTION Always use the three-prong ac power cord supplied with this product. Failure to 
ensure adequate earth grounding by not using this cord may cause product 
damage.

3. Turn off the PC and the network analyzer.

4. Connect the ac power cable from the power-source outlet to the ac input on the rear panel 
of the test set.

5. Turn on the PC, the network analyzer, and the test set by pressing the ON/OFF button on 
the front panel of each device.

6. If your network analyzer is an N8362A/B or N8364A/B PNA, you will need to perform the 
Phase-Lock IF Gain Adjustment on the analyzer after it has been connected to the test set 
as a system. This routine adjusts the R Channel receivers ALC gain to ensure phase lock 
over the entire frequency range. Refer to Phase-Lock IF Gain Adjustment in the 
network analyzer’s online help system for details. Use the following steps to perform this 
adjustment:

Power Source Requirements
Input Voltage Range 100 − 120 Vac - or - 220 − 250 Vac
Frequency Range 47 − 62 Hz / 400 Hz

Power 40 VA maximum.
Operating Environment Requirements

Operating Environment Indoor use
Altitude Operating:

Storage: 
0 to 2.0 km (6,560 ft.)
0 to 15.24 km (50,000 ft.)

Temperature 0 °C to 40 °C
Maximum Relative Humidity 80% for temperatures up to 31 °C; decreasing 

linearly to 50% for a temperature of 40 °C
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Installing your Physical Layer Test System
Step 8. Power up the S-Parameter Test Set
a. On the network analyzer, from the System menu, click Service, then Adjustments, 
then IF Gain Adjustment.

If you are unable to find these selections on your N836XA PNA, your analyzer firmware 
is a revision prior to 3.0. Follow the instructions in “IF Gain Adjustment” on page 382 
to complete this adjustment.

b. Select any special test set options installed, otherwise leave the selection at None.

c. No connections to the test ports are required.

d. Click Begin Adj. The adjustment takes about a minute to complete.

The advanced screen is for factory personnel only.

NOTE This adjustment must be performed before using the network analyzer each 
time the system is assembled or disassembled.
Chapter 124



Installing your Physical Layer Test System
Step 9. Install the Physical Layer Test System Software
Step 9. Install the Physical Layer Test System Software 

1. Insert the physical layer test system software CD-ROM in your PC. The software should 
begin the installation process automatically. Follow the prompts to complete the software 
installation.

2. In Windows, select Start > Run…

3. Click OK and follow the onscreen instructions.
Chapter 1 25



Installing your Physical Layer Test System
Step 10. Licence the Physical Layer Test System Software
Step 10. Licence the Physical Layer Test System Software 
This procedure instructs you how to license your Physical Layer Test System Software which 
is required before it can be used. The software is node-locked which means that license entitles 
you to use the software on only one personal computer (PC) and the software enforces that 
restriction. 

CAUTION The software is node-locked which means that license entitles you to use the 
software on only one personal computer and the software enforces that 
restriction. Make sure that you license the software to the correct PC.

During this procedure, you will identify the Host ID of that PC. The host ID is a unique 
identifier for that computer. Then, you will use the host ID to license the software to that 
unique identifier of your PC. Therefore, it is very important to affirm that you have loaded 
and are licensing the software to the correct PC.

1. In Windows, select Start > Programs and locate the Command Prompt selection on 
your PC. Open the Command Prompt window by clicking the Command Prompt 
selection. 

2. In the Command Prompt window, change the directory to the license subdirectory in 
the PLTS subdirectory using the following command: 

The default directory that the software is loaded on is: C:\Program Files\Agilent 
Technologies. Therefore, enter the following command to change to the default directory:

 cd c:\Program Files\Agilent Technologies\PLTS\license 

Refer to the illustration in step 4 on page 27.

3. Run the lmhostid executable file that will display the host ID for the PC that you have 
installed the software on by entering the following command as shown in the figure below:

lmhostid

cd x:\dddd\ssss\PLTS\license
where, x is the letter of the drive the software was installed on.

dddd is the directory name the software was installed on.
ssss is any subdirectories the software was installed on.
Chapter 126



Installing your Physical Layer Test System
Step 10. Licence the Physical Layer Test System Software
4. The host ID of the computer is displayed in window opened by the lmhostid.exe file. 
Write the host ID for your computer in the space provided below. You will need the host ID 
to license the software. 

5. Locate the Software Entitlement Certificate that was shipped with your software.

The certificate lists the Order Number and the Certificate Number for your software. 
These two numbers will also be used to license your software. 

The certificate also lists the web site where you must register your software.

6. Go to the Agilent web site listed on the Software Entitlement Certificate. Follow the 
instructions at the web site to receive your license file for the software. You will need to 
provide the following information:

• Order Number 
• Certificate Number
• Host ID for your computer that will run the PLTS Software

The web site will also ask you provide your e-mail address. The license file will be e-mailed 
to you promptly. 

7. Once you receive the E-mail with the attached licence file, save the file to the “license” 
directory (the same directory that you used earlier to identify the host ID).

8. Make a back up of the license file and store in a safe location.

This back up file is very important! You may need this back up file if encounter 
problems with your computer or if the licence file is lost or erased.

Record the host ID for your computer here:
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Step 11. Start the Physical Layer Test System Software 

1. After the license file has been saved, start the PLTS software by double-clicking the 
Physical Layer Test System icon on the desktop.

You may also run the program by selecting Start, Programs, Agilent Technologies, 
Physical Layer Test System, Physical Layer Test System.

2. The first time you start the software, you will be asked to identify the license for the 
software. When the following dialog box is displayed, select Specify the License File and 
then click the Next > button.
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Step 11. Start the Physical Layer Test System Software
3. When the FLEXlm License Finder dialog box is displayed asking you to choose the license 
filename, click the Browse button and select the license file in the directory that you 
copied the file to in “Step 10. Licence the Physical Layer Test System Software” on page 26.

4. Once the directory and the license file is identified, the directory path is displayed in the 
FLEXlm License Finder dialog box. Select the Next> button.
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Step 11. Start the Physical Layer Test System Software
5. When the license is found and identified, select the Finish button to continue with 
starting the software.

NOTE Steps 2 through 5 in this procedure should only need be performed the first 
time the software is started. If the software requires these steps again, it is 
because the licence file may have been moved or deleted. 

Make a back-up copy of the license file if you haven’t already done so.

6. Continue with starting the software.

7. Familiarize yourself with the Physical Layer Test System by referring to Chapter 2, 
“Becoming Familiar with your Physical Layer Test System.”
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Becoming Familiar with your Physical Layer Test System
This chapter provides a graphical overview of the physical layer test system. It shows:

•  The Physical Layer Test System Software

 The main screen of the physical layer test system software user interface as well as 
important lower level screens. The important features of each displayed screen are 
identified and briefly described. 

Refer to “Physical Layer Test System Software Features” on page 33 for information.

•  The Physical Layer Test System Hardware

The physical layer test system equipment is also shown, identifying each hardware 
product within the system and their interconnections.

Refer to “Physical Layer Test System Hardware Features” on page 42 for information.
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Physical Layer Test System Software Features
Physical Layer Test System Software Features
This section describes the features of the Physical Layer Test System software. Refer to 
Figure 2-1, Main Window, for the locations of each of the software’s main features.

Figure 2-1 Main Window

1. Title Bar 5. Plot Windows 9. Scaling Bar

2. Menu Bar 6. Cursor Bar 10. Browser 

3. Format Bar 7. Status Bar 11. Toolbar

4. Information Bar 8. Parameter Bar 
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Physical Layer Test System Software Features
1. Title Bar

The title bar (Figure 2-2) displays the title of the software. It also provides buttons to quickly 
perform tasks at the program level. 

Figure 2-2 Title Bar

2. Menu Bar

The menu bar (Figure 2-3) lists each of the drop down menu names currently available. When 
you click a menu name, the menu is displayed. The menu names and menus change to reflect 
appropriate choices for the selected plot window (analysis type.) Refer to Chapter 10, “Menu 
Reference,” for detailed information about each of the menu bar selections. 

When the plot window is selected to completely fill its area, the menu bar also displays three 
buttons to control the plot window.

Figure 2-3 Menu Bar

Clicking: Performs:
Minimizes the program window to the Windows task bar.

Toggles the program window to full screen mode.

Toggles the program window to partial screen mode.

Closes the program.

Clicking: Performs:
Minimizes the plot window within the plot windows display area.

Toggles the plot window to partially fill the plot windows display area.

Closes the plot window.
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Physical Layer Test System Software Features
3. Format Bar

The format bars (Figure 2-4) allow you to format the parameters for the selected time domain 
or frequency domain plot window. The format bar is displayed by selecting Format Bar from 
the View menu. It is hidden with the same selection.

The format bar is only available when the selected plot window is a time domain or frequency 
domain selection. The time domain format bar differs from the frequency domain format bar. 
Each format bar matches its corresponding Format menu (selected in the Menu bar.) The 
format bar and the title of each button of both measurement methods is shown below. 

Figure 2-4 Format Bars

For detailed information about each of the 
selections, refer to “Selecting Time Domain 
Display Formats” on page 157.

For detailed information about each of the 
selections, refer to “Selecting Frequency 
Domain Display Formats” on page 128.

Impulse Log Mag

Step Linear Mag

Volts Phase

Real Group Delay

Log Mag Smith Chart

Impedance Polar Chart

ns Real

cm Imaginary
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4. Information Bar

The Information Bar (Figure 2-5) displays a listing of each plot window along with the 
associated parameters for each. If a plot window has multiple traces, all associated 
parameters are listed. In addition, any marker readout information is displayed in this area. 

A lot of information may be displayed for each window. To hide the plot windows information, 
simply click the minus sign in front of the plot window listing. All of the information is hidden 
and the minus sign changes to a plus sign. To show the information again, click the plus sign. 

Figure 2-5 Information Bar
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5. Plot Windows

The plot windows (Figure 2-6) displays the measurement results in the data analysis type 
selected. You select the data analysis type when you make a measurement, open existing data 
files, or make a selection in the browser. The Parameter Bar or the Data menu on the Menu 
bar allows you to display plots for all of the parameters or just the parameters you want to 
view. Multiple plot windows can be displayed in the plot window display area at the same 
time.

Figure 2-6 Plot Window
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6. Cursor Bar

The cursor bar (Figure 2-7) allows you to add and display up to two markers to the active plot. 
The X-Y values of each cursor and the delta (the value of their difference) is displayed in the 
information bar. 

Figure 2-7 Cursor Bar

7. Status Bar

The status bar (Figure 2-8) provides a visual indication of when conditions are happening 
within the software and the impedance associated with each system channel.

When any of the conditions listed below are active, an indicator adjacent to the condition title 
is displayed in a bright color. If the condition is not active, the color of the indicator is gray. 
The conditions are:

Figure 2-8 Status Bar

Measurement is bright when a measurement is being performed by the software.

Continuous sweep is bright when the measurement is being continuously swept.

De-Embedding is bright when the active plot has de-embedding data applied.

Ref-Z is bright when the active plot has reference impedance applied.

Hardware is bright when the hardware has been identified by the software.
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8. Parameter Bar

The parameter bar (Figure 2-9) allows you to open a new plot, or add a new trace to an 
existing plot. Figure 2-9 shows the parameter bar for the balanced time domain plots. Each 
analysis type has a unique parameter bar specific to that type of analysis. Refer to Figure 
10-22, “Parameter Bars for Each Data Analysis Type” on page 243 to see all parameter bars.

Select New Plot and then click a parameter to display a new plot.

- or - 

Select New Trace and then click a parameter to overlay a new trace to an existing plot. 
Clicking the parameter a second time removes the added trace from the plot.

Figure 2-9 Parameter Bar for Balanced Time Domain Plots

9. Scaling Bar

The scaling bar (see Figure 2-10) allows you to change the scale on both the horizontal and 
vertical axis.

Figure 2-10 Scaling Bars

For time domain, the horizontal axis entries are units/division and delay. The vertical axis 
units are units/division and reference level.

For frequency domain and RLCG, the horizontal axis entries are the start frequency and the 
stop frequency. The vertical axis units are the units/division and the reference level.
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10. Browser

The browser (Figure 2-11) provides access to each measurement and analysis type. Selecting a 
new Data Analysis type from the browser opens up a corresponding plot window. Each Data 
Analysis type may view multiple sets of data. 

Clicking a bold label opens a new window in the plots area with that data analysis type.

Clicking a non-bold label displays that plot and makes it the active plot in the plots area.

Clicking the minus sign hides the data selections for a given data analysis type.

Clicking the plus sign shows the data selections.

Figure 2-11 Browser
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11. Toolbar

The toolbar (Figure 2-12) provides buttons for beginning a new measurement, opening 
existing files, saving current data, copying current data, exporting data, removing plots, and 
printing.

Figure 2-12 Toolbar

Clicking: Performs:
New Starts the setup wizard so that a new measurement may be 

made.

Open Opens the Open dialog box so that an existing file may be 
opened.

Save Opens the Save As dialog box so that a file may be saved.

Copy Copies the active plot to the clipboard.

Export Bitmap Saves the active plot as a bitmap file (bmp).

Remove Plot Deletes the active plots.

Print Prints the active plots.

About Opens the About PLTS information.
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An illustration showing each physical layer test system and its interconnections is provided in 
this section. Other balanced-measurement systems supported by the physical layer test 
system software are also illustrated. Each illustration has a corresponding table that lists the 
sequence of each interconnection, the interconnect cable part number, and the connector label 
for the network analyzer and the S-parameter test set.

Along with each PLTS system model number, the individual test set and network analyzer 
model numbers comprising the system are listed. Refer to Table 1-1, “Physical Layer Test 
System Configurations,” on page 7 and Table 1-2, “Common Hardware Option Number 
Descriptions for Network Analyzers,” on page 10 for additional information about test set and 
network analyzer model and option requirements.

The following physical layer test systems are shown: 

• “N1947A Test System Interconnections
(or N4417A Option 103 Test Set with E8801A, E8802A, or E8803A Network Analyzer)” on 
page 44

• “N1948A Test System Interconnections
(or N4417A Option 104 Test Set with E8356A, E8357A, or E8358A Network Analyzer)” on 
page 46

• “N1951A Test System Interconnections
(or N4418A Test Set with 8720ES or 8722ES Network Analyzer)” on page 48

• “N1953A Test System Interconnections  
(or N4419A Test Set with E8362A/B Network Analyzer)” on page 50

• “N1957A Test System Interconnections
(or N4421A Test Set with E8364A/B Network Analyzer)” on page 52

The following other test set/network analyzer systems are shown:

• “N4416A Test Set with the E8356A, E8357A, or E8358A Network Analyzer” on page 54

• “N4415A Test Set with the 8753ES Network Analyzer” on page 56
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CAUTION When connecting the interconnect cables described in the remaining pages of 
this section, be careful to install the interconnect cables correctly. The longer 
end of the interconnect cable connects to the network analyzer front panel 
connector. Refer to Figure 2-13 for the correct orientation.

Figure 2-13 Interconnect Cable Orientation

Damage to the interconnect cable can result from improper connection of the 
cable.
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N1947A Test System Interconnections 

(or N4417A Option 103 Test Set with E8801A, E8802A, or E8803A Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 43 for detailed information regarding the correct cable 
orientation.
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Installation
Sequence

Cable
Part Number

From
E8801/E8802/E8803

To
N4417A

1 AD00747-2-2 R1 IN R1 IN

2 AD00747-2-2 A IN A IN
3 AD00747-2-2 COUPLER IN COUPLER IN

4 AD00747-2-2 COUPLER IN COUPLER IN
5 AD00747-2-2 B IN B IN

6 AD00747-2-1 R1 OUT R1 OUT
7 AD00747-2-1 A OUT A OUT

8 AD00747-2-1 SOURCE OUT SOURCE OUT
9 AD00747-2-1 SOURCE OUT SOURCE OUT

10 AD00747-2-1 B OUT B OUT
11 AD00747-2-3 REF 1 on rear panel of the test set
Chapter 2 45



Becoming Familiar with your Physical Layer Test System
Physical Layer Test System Hardware Features
N1948A Test System Interconnections 
(or N4417A Option 104 Test Set with E8356A, E8357A, or E8358A Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 43 for detailed information regarding the correct cable 
orientation.
Chapter 246



Becoming Familiar with your Physical Layer Test System
Physical Layer Test System Hardware Features
Installation
Sequence

Cable
Part Number

From
E8356/E8357/E8358

To
N4417A

1 AD00747-1-2 R1 IN R1 IN

2 AD00747-1-2 A IN A IN
3 AD00747-1-2 COUPLER IN COUPLER IN

4 AD00747-1-2 COUPLER IN COUPLER IN
5 AD00747-1-2 B IN B IN

6 AD00747-1-2 R2 IN R2 IN
7 AD00747-1-1 R1 OUT R1 OUT

8 AD00747-1-1 A OUT A OUT
9 AD00747-1-1 SOURCE OUT SOURCE OUT

10 AD00747-1-1 SOURCE OUT SOURCE OUT
11 AD00747-1-1 B OUT B OUT

12 AD00747-1-1 R2 OUT R2 OUT
13 AD00747-1-3 REF 1 on rear panel of the test set

14 AD00747-1-3 REF 2 on rear panel of the test set
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N1951A Test System Interconnections 
(or N4418A Test Set with 8720ES or 8722ES Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 43 for detailed information regarding the correct cable 
orientation.
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Call Out
Sequence

Cable Part 
Number

From
8720ES/8722ES

To
N4418A

1 AD00599-2 PORT 1 SWITCH PORT 1 SWITCH
2 AD00599-1 A IN A IN
3 AD00599-2 PORT 1 BIAS TEE PORT 1 COUPLER
4 AD00599-1 A OUT A OUT
5 AD00599-2 PORT 2 BIAS TEE PORT 2 COUPLER
6 AD00599-1 B OUT B OUT
7 AD00599-4 R CHANNEL OUT PORT 2 R OUT
8 AD00599-3 R CHANNEL IN B R IN
9 AD00599-2 PORT 2 SWITCH PORT 2 SWITCH
10 AD00599-1 B IN B IN
11 AD00599-5 REF 1 on rear panel of the test set
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N1953A Test System Interconnections 
(or N4419A Test Set with E8362A/B Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 43 for detailed information regarding the correct cable 
orientation.
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Call Out
Sequence

Cable Part 
Number

From
E8362A/B

To
N4418A

1 AD00756-1 REF 1 SOURCE OUT REF 1 SOURCE OUT
2 AD00756-1 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 AD00756-1 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 AD00756-1 REF 2 SOURCE OUT REF 2 SOURCE OUT
5 AD00756-2 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 AD00756-2 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 AD00756-2 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
8 AD00756-2 PORT 2 CPLR THRU PORT 2 CPLR THRU
9 AD00756-3 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 AD00756-3 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 AD00756-3 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 AD00756-3 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 AD00756-4 REF 1 on rear panel of the test set
14 AD00756-4 REF 2 on rear panel of the test set
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N1957A Test System Interconnections 
(or N4421A Test Set with E8364A/B Network Analyzer)

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 43 for detailed information regarding the correct cable 
orientation.
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Call Out
Sequence

Cable Part 
Number

From
E8364A/B

To
N4421A

1 Z5623-20215 REF 1 SOURCE OUT REF 1 SOURCE OUT
2 Z5623-20215 REF 1 RCVR R1 IN REF 1 RCVR R1 IN
3 Z5623-20215 REF 2 RCVR R2 IN REF 2 RCVR R2 IN
4 Z5623-20215 REF 2 SOURCE OUT REF 2 SOURCE OUT
5 Z5623-20216 PORT 1 SOURCE OUT PORT 1 SOURCE OUT
6 Z5623-20216 PORT 1 CPLR THRU PORT 1 CPLR THRU
7 Z5623-20216 PORT 2 SOURCE OUT PORT 2 SOURCE OUT
8 Z5623-20216 PORT 2 CPLR THRU PORT 2 CPLR THRU
9 Z5623-20217 PORT 1 CPLR ARM PORT 1 CPLR ARM
10 Z5623-20217 PORT 1 RCVR A IN PORT 1 RCVR A IN
11 Z5623-20217 PORT 2 RCVR B IN PORT 2 RCVR B IN
12 Z5623-20217 PORT 2 CPLR ARM PORT 2 CPLR ARM
13 E8364-20059 REF 1 on rear panel of the test set
14 E8364-20059 REF 2 on rear panel of the test set
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N4416A Test Set with the E8356A, E8357A, or E8358A Network Analyzer 

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 43 for detailed information regarding the correct cable 
orientation.
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Installation
Sequence

Cable
Part Number

From
E8356/E8357/E8358

To
N4416A

1 AD00653-2 R1 IN R1 IN
2 AD00653-2 A IN A IN
3 AD00653-2 COUPLER IN COUPLER IN
4 AD00653-2 COUPLER IN COUPLER IN
5 AD00653-2 B IN B IN
6 AD00653-2 R2 IN R2 IN
7 AD00653-1 R1 OUT R1 OUT
8 AD00653-1 A OUT A OUT
9 AD00653-1 SOURCE OUT SOURCE OUT
10 AD00653-1 SOURCE OUT SOURCE OUT
11 AD00653-1 B OUT B OUT
12 AD00653-1 R2 OUT R2 OUT
13 AD00653-3 REF 1 on rear panel of the test set
14 AD00653-3 REF 2 on rear panel of the test set
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N4415A Test Set with the 8753ES Network Analyzer

CAUTION Damage to the interconnect cable can result from improper orientation of the 
cable. Refer to page 43 for detailed information regarding the correct cable 
orientation.
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Installation
Sequence

Cable
Part Number

From
8753ES

To
N4415A

1 AD00632-2 Port 1 Switch Switch
2 AD00632-1 A OUT A OUT
3 AD00632-2 Port 1 Coupler Coupler
4 AD00632-1 A IN A IN
5 AD00632-2 Port 2 Coupler Coupler
6 AD00632-1 B IN B IN
7 AD00632-2 Port 2 Switch Switch
8 AD00632-1 B OUT B OUT
9 AD00632-3 R Channel In R IN
10 AD00632-3 R Channel Out R OUT
11 AD00632-4 REF 1 on rear panel of the test set
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Making a Measurement using the Sample Device
This chapter guides you through setting up the initial measurement definitions, performing 
the system calibration, making a measurement, and analyzing the measurement results. It 
uses a simple balanced transmission line that was supplied with the system as a sample 
device-under-test (DUT). See Figure 3-1.

Figure 3-1 Balanced Transmission Line Sample DUT

The Startup Wizard steps you through the initial setup, the calibration, and the first 
measurement. 

1. Initial setup includes:

• System Hardware Verification
• Calibration Level Selection
• Calibration and Measurement Parameter Selection

2. Calibration includes:

• Calibration Type Selection and Calibration Kit Selection
• SOLT Mechanical Calibration, SOLT Electronic Calibration, or TRL Calibration
• Adapter Characterization

3. Measurement includes:

• Analysis Type Selection
• Stimulus Verification
• Running Measurement

After the measurement has been made, the main Physical Layer Test System (PLTS) window 
gives you the flexibility to perform analysis on the measured data in a variety of ways.

• Frequency Domain. The Frequency Domain analysis may be analyzed in Balanced or 
Single-Ended mode. This chapter contains some basic information. Refer to Chapter 5, 
“Analyzing Data in the Frequency Domain,” on page 115 for more information.

• Time Domain. The Time Domain analysis may be analyzed in Balanced or Single-Ended 
mode. This chapter contains some basic information. Refer to Chapter 6, “Analyzing Data 
in the Time Domain,” on page 137 for more information.
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• Eye Diagram. The Eye Diagram analysis may be analyzed in Balanced or Single-Ended 
mode. This chapter contains some basic information. Refer to Chapter 7, “Analyzing Data 
using Eye Diagrams,” on page 165 for more information.

• Transmission Line (RLCG). The RLCG analysis may be analyzed in Differential, 
Common, W-Element, and Self/Mutual modes. This chapter contains some basic 
information. Refer to Chapter 8, “Extracting Transmission Line (RLCG) Parameters,” on 
page 181 for more information.
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Navigating the Startup Wizard
By default, when PLTS is first started, the Startup Wizard is displayed. It is also displayed 
anytime a new measurement is initiated, such as after selecting New from the File menu, or 
clicking on the new file icon on the toolbar. See Figure 3-2.

The Startup Wizard Welcome Screen gives you two choices, New Measurement or Load 
Measurement. Load Measurement loads the existing data. However, for the purpose of 
this exercise, select New Measurement.

Figure 3-2 Startup Wizard Welcome Screen
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NOTE It is recommended that you use the startup wizard, however, selecting the Do 
not show this wizard again at start up check box prevents the wizard from 
being displayed each time the software is started. The software goes directly to 
the main window at start up. Refer to “User Preferences” on page 273 to 
deactivate this selection.

When you select New Measurement, the Startup Wizard will guide you through:

• Initial Setup

• Calibration

• First Measurement

At the end, the wizard will ask you for the initial analysis format of interest (time domain, 
frequency domain, etc.), and perform the data transformations and display the measurement 
results.
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How to Perform the Initial Setup

The Initial Setup process includes:

1. Verifying that the software recognizes your PLTS system hardware.

This step uses the left portion of the Hardware Auto-Detection Summary dialog box to 
verify that the software recognizes the correct system hardware. This portion of the dialog 
box displays the model number, GPIB address, and serial number of the network analyzer 
and the test set. You may re-scan to look for changes automatically or you may manually 
make changes to the hardware settings.

2. Selecting the appropriate level of calibration for the upcoming measurement.

This step uses the right portion of the Hardware Auto-Detection Summary dialog box to 
select the appropriate level of calibration to be performed. You may perform a new 
calibration, reuse existing calibration data, or perform measurements without calibration.

3. Setting up calibration and measurement parameters.

This step uses the Calibrate Hardware for Measurement dialog box to display the default 
measurement parameters. These default parameters are based on the hardware 
capabilities of your PLTS. You may modify these defaults as required.

When you select the New Measurement button shown in Figure 3-2 on page 62, the 
Hardware Auto-Detection Summary dialog box is displayed. See Figure 3-3.
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Figure 3-3 Hardware Auto-Detection Summary Dialog Box

Verifying the Software Recognizes the PLTS Hardware

On the left portion of the Hardware Auto-Detection Summary dialog box, the model number, 
the GPIB address, and the serial number for the network analyzer and test set are displayed. 
These are the test equipment that the software finds connected to the GPIB bus. If this 
information seems incorrect, check your system hardware connections and power status, then 
select Re-Scan.

To force PLTS to recognize other instruments, or re-configure the GPIB interface manually, 
select Edit to display the Hardware Configuration dialog box. Refer to Figure 3-4. In this 
dialog box, you can select the model number and enter the GPIB address for your network 
analyzer and test set. You can also set up the GPIB Interface card by selecting the 
Configure… button.

Select the OK button when the dialog box contains the correct information.
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Figure 3-4 Hardware Configuration Dialog Box

Selecting the Appropriate Level of Calibration

On the right portion of the Hardware Auto-Detection Summary dialog box (Figure 3-3), select 
your calibration strategy:

• Perform a new calibration continues with the Startup Wizard performing a new 
calibration before making a measurement.

• Load existing calibration data allows you to select a previously saved calibration 
(*.cal) file to be used for the new measurement. See Chapter 4, “Calibrating for Measure-
ment Accuracy,” for guidance on calibration intervals, etc.

• None. Collect measurement data uncalibrated allows you skip the calibration, select 
measurement parameters (see Figure 3-6 on page 68), and then proceed directly to the 
measurement screen. This option is not recommended for qualitative data collection.

Select the Perform a new calibration choice for this example exercise.
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Setting Up the Calibrate and Measure Parameters

When you select Perform a new calibration, and then select Next >, the first of three 
Calibrate Hardware for Measurement dialog boxes is displayed as shown in Figure 3-5. 

Figure 3-5 Calibrate Hardware for Measurement

This dialog box initially displays the calculated Maximum Time Base, Minimum Rise 
Time, and Record Length which were calculated based on the equipment found on the 
system bus. You may accept or modify these values. Modifying these values directly will also 
modify other associated values interactively. For example, when changing the Minimum 
Rise Time, the Record Length will change appropriately. 

At any time, you can return to the original default values by selecting Reset Values.

For further options, select Advanced... to display the screen shown in Figure 3-6.

Modifying Time and Frequency Parameters  To enter calibration and measurement 
parameters in a frequency-domain-based interface, to see all parameter details, or just to see 
how the time-domain and frequency-domain parameters interact, select Advanced... from 
the previous display (Figure 3-5). Selecting Advanced... displays the Modify Time and 
Frequency Parameters dialog box shown in Figure 3-6.

The Modify Time and Frequency Parameters dialog box allows modification of the calculated 
parameters in both time domain and frequency domain terms. As with the previous dialog 
box, you may accept or modify these values. 

Modifying these values also modifies other associated values interactively. To modify a 
parameter, enter the value in associated value box and then select the Recalculate 
Parameters button to update each parameter. Refer to Table 3-1 for a description of each 
time-domain and frequency-domain parameter.
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Figure 3-6 Modify Time and Frequency Parameters

Table 3-1 Time and Frequency Parameter Descriptions

Parameter Description

Time Base Sets the maximum time base (in ns). Time base calculated as 

 where Fmin is the start frequency.

Rise Time sets the transition time (in picoseconds) of the stimulus signal 
rising from 10 to 90% of the maximum signal amplitude.

Number of Points sets the number of measured points per sweep.

Range Resolution describes how close in time two responses can be distinguished; 
depends on the width of the impulse response, which is inversely 
related to the measurement bandwidth.

Velocity Factor is the numerical value related to the speed of energy through 
transmission lines with different dielectrics.

Frequency Start sets the start frequency of the sweep.

Frequency Step sets the step size between points. This value is locked to (is the 
same as) the Frequency Start value.

Frequency Stop sets the stop frequency of the sweep.

1
2 Fmin×
--------------------
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To accept the parameters and return to the previous screen, select OK.

From the Calibrate Hardware for Measurement dialog box (shown in Figure 3-5), select 
Next > to continue to the calibration kit selection.

How to Perform a Calibration

For the details for performing a calibration, continue with “Selecting a Calibration Type” on 
page 83. “When Is Calibration Needed” on page 80 describes how often the calibration needs 
to be performed.

As mentioned earlier, the calibration procedure includes:

• Calibration Type Selection and Calibration Kit Selection
• SOLT Mechanical Calibration, SOLT Electronic Calibration, or TRL Calibration
• Adapter Characterization

This procedure will guide you through these calibration steps. When you are finished with the 
calibration, it refers you back to “How to Make a Measurement” on page 70.

IF Bandwidth allows you to change the IF bandwidth. Narrow IF bandwidths 
allow you to view low-level signal, however, require more data 
samples per point and thus slow the measurement time. 

Power sets the signal level at the source appropriate for measurement of 
the device. You can measure the signal level available at the test 
port directly using a power meter.

Stepped takes data while sweeping through defined frequency points. 

Swept takes data while sweeping linearly and continuously across the 
frequency range.

Table 3-1 Time and Frequency Parameter Descriptions

Parameter Description
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How to Make a Measurement

After saving the calibration data and selecting the Next > button, the final Startup Wizard 
window is displayed. See Figure 3-7. This window allows you to select the type of analysis that 
you want to display and initiates the measurement. 

Figure 3-7 Setup & Calibration Complete! Window

1. To make the measurement, connect the PLTS to the device under test. In this example, the 
supplied simple balanced transmission line is used. Figure 3-8 shows how the balanced 
transmission line is connected to the system hardware after a 4-port SOLT calibration.

Figure 3-8 Connecting the Balanced Transmission Line DUT
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NOTE If you were connecting the balanced transmission line after a TRL calibration, 
ports 2 and 3 would be interchanged as shown below.

Observe the change in ports 2 and 3 from Figure 3-8.

2. The Setup & Calibration Complete! window displays the ten available analysis formats:

For the purpose of this example, the Time Domain (Balanced) icon is selected.

3. If you wish to review or confirm the measurement parameters prior to performing the 
measurement, press the View Stimulus button. The Stimulus dialog box (see Figure 3-9) 
displays the selected parameters in both time and frequency formats. To modify any of 
these parameters, return to “Setting Up the Calibrate and Measure Parameters” on 
page 67.

• Time Domain (Balanced)

• Frequency Domain (Balanced)

• Eye Diagram (Balanced)

• RLCG (Differential)

• RLCG (W-Element)

• Time Domain (Single-Ended)

• Frequency Domain (Single-Ended)

• Eye Diagram (Single-Ended)

• RLCG (Common)

• RLCG (Self/Mutual)
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Figure 3-9 Stimulus Dialog Box

4. Select OK to leave the Stimulus dialog box and return to the final Startup Wizard window.

5. To start the measurement, select the Measure button on the Setup & Calibration 
Complete! window.

The measurement then begins and a progress message is displayed. See Figure 3-10.

Figure 3-10 Progress Message

Analyzing the Measurement Results

Now that you have measured the device under test, its results are displayed in Figure 3-11 
using Time Domain (Balanced) format, the same analysis format selected in step 2.
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Figure 3-11 Displayed Measurement in Time Domain Balanced Format

Refer to the four chapters listed below for information about each analysis format:

• Chapter 5, “Analyzing Data in the Frequency Domain,” on page 115

• Chapter 6, “Analyzing Data in the Time Domain,” on page 137

• Chapter 7, “Analyzing Data using Eye Diagrams,” on page 165

• Chapter 8, “Extracting Transmission Line (RLCG) Parameters,” on page 181
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Part II provides detailed information about optimizing and making measurements and 
analyzing the measured data using the physical layer test system.

Chapter 4, “Calibrating for 
Measurement Accuracy”

Provide information about performing test system 
calibrations.

Chapter 5, “Analyzing Data 
in the Frequency Domain”

Provides information about analyzing measured data in 
the frequency domain.

Chapter 6, “Analyzing Data 
in the Time Domain”

Provides information about analyzing measured data in 
the time domain.

Chapter 7, “Analyzing Data 
using Eye Diagrams”

Provides information about analyzing measured data 
using the Eye diagram.

Chapter 8, “Extracting 
Transmission Line 
(RLCG) Parameters”

Provides information about extracting transmission line 
R, L, C, G parameters from the measured data.

Chapter 9, “Enhancing the 
Measurement”

Provides information about using measurement 
enhancement features such as gating, phase skew, and 
de-embedding. 
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Calibrating for Measurement Accuracy
What Is Measurement Calibration
What Is Measurement Calibration
Measurement calibration is an accuracy enhancement procedure that effectively removes the 
systematic errors (repeatable measurement variations) that cause uncertainty in measuring a 
device under test (DUT). During measurement calibration, the physical layer test system 
measures actual, well-defined standards and mathematically compares the results with ideal 
“models” of these standards. Calibration measurements, which characterize the test system, 
are made with all cables and connections in place but without the DUT.

Systematic Errors are related to signal leakage, signal reflections, and frequency response 
of the test system. There are six types of systematic errors.

• Directivity and crosstalk related to signal leakage

• Source and load impedance mismatches related to signals being reflected

• Frequency response error caused by reflection and transmission tracking with the test 
receivers

Other factors that can impact the measurement accuracy of any measurement system are 
drift errors and random errors.

• Drift Errors are due to the instrument or test-system performance changing after a 
calibration has been done. Drift is primarily caused by temperature variation and it can be 
removed by recalibration. The timeframe over which a calibration remains accurate is 
dependent on the rate of drift that the test system undergoes in the test environment. A 
stable ambient temperature usually minimizes the rate of drift significantly. Allowing 
equipment to warm up and stabilize prior to calibration and properly ventilating 
equipment helps reduce drift errors.

• Random Errors are unpredictable since they vary with time in a random fashion. 
Therefore, they cannot be removed by calibration. The main contributors to random error 
are instrument noise such as, source phase noise, sampler noise, and IF noise. The 
accurate source and phase-locked receiver of the network analyzer greatly minimizes these 
random errors. There are also external contributors to random errors such as switching 
power supplies, EMI, etc.
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Why Is Calibration Needed
Components of the measurement setup such as imperfect connectors, cabling, and even the 
response of the test instruments can introduce errors into measurements. For both 
transmission and reflection measurements, impedance mismatches within the test setup 
cause measurement uncertainties that appear as ripples superimposed on the measured data. 
These errors can distort the signal and make it difficult to determine which reflections are 
from the DUT and which are from other sources. 

Calibration is required for accurate measurements. Even though calibration does take a few 
minutes to complete, it saves time and money compared to costs associated with erroneous 
measurement data. Even mechanical (non-electronic) calibration is reasonably quick once you 
become familiar with the process.

TIP Understanding How Changes Affect Measurements

No two measurements and environmental conditions are exactly the same. The 
best way to understand your conditions is to experiment and see how your test 
equipment behaves over a period of time. A good way of doing this is to measure 
the same device (i.e., a known standard) hourly throughout the day. Save or 
print the measurement results of each measurement. Compare these results to 
gain an understanding of how the ambient environment and drift affect the 
measurements. Watch for trends with regard to the device meeting 
specifications or measuring within guard band limits. 
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When Is Calibration Needed
We recommend that you perform a calibration on your physical layer test system when the 
following conditions occur:

• When connectors are cleaned, repaired, or replaced.

• If test cables have any changes, such as:
— When a test cable is replaced

— When any connection is changed except the connections to the DUT

— When test cables are flexed excessively (kinked or unkinked)

• If the frequency range is changed beyond the limits of the previous calibration

• If the number of measurement points is increased to more than the number of points of the 
previous calibration

• When ambient temperature changes more than ±3 °C

• Any other ambient environmental changes of significance

• If none of the previous conditions apply, calibrate according to the intervals shown below 
due to drift:

— Check the calibration daily at a minimum (twice daily is recommended). Refer to “How 
to Verify a Calibration” on page 81.

— Calibrate weekly (daily calibration recommended).
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How to Verify a Calibration
A good method of checking calibration is to establish a Golden Device, which is a device that 
meets all specifications and is saved for comparison of the measured results in the future. 

Establishing a Golden Device

Follow these steps to establish a golden device:

1. Calibrate the system. 

2. Perform the complete set of measurements on the golden device. 

3. Save and print all of the test results from these initial measurements.

Now you can measure the golden device when you suspect that your system may need to be 
calibrated. Compare the results of these measurements against the results that you saved 
and printed from the initial measurements.
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How to Perform a Calibration
You will first select a calibration kit and then you will perform a calibration (either 
mechanical or electronic, depending on your calibration kit). After you finish the calibration, 
you will be ready to make a measurement.

Use the following procedure to calibrate the Physical Layer Test System. 

1. If you are referring to this chapter from the example measurement in Chapter 3, skip to 
“Selecting a Calibration Type” on page 83.

2. Open the Physical Layer Test System Startup Wizard by doing any of the following:

• Start the Physical Layer Test System software. 
(The startup wizard will open at start up unless the “Do not show this wizard again 
at start up” option has been selected.)

• Select New from the File menu.

• Select Calibration from the Utilities menu. Then select Calibrate.

3. Press the Next > button until you reach the startup wizard’s Calibrate Hardware for 
Measurement dialog box displaying the default parameters, such as the maximum time 
base, minimum rise time, and number of point settings. See Figure 3-5 on page 67.

Use this dialog box to check these calibration parameter settings. These default settings 
are based on the equipment limitations of your Physical Layer Test System.

Selecting the Advanced… button to display all of the calibration parameters in the 
Modify Time and Frequency Parameter dialog box. Refer to Figure 3-6 on page 68.

You can change any of the time domain or frequency domain parameters, and then by 
selecting the Recalibrate Parameters button, the remaining parameters are 
recalibrated and displayed. Once all of the parameters are set to your satisfaction, select 
OK to return to the Calibrate Hardware for Measurement dialog box.

If you decide you want to reset all changed values to their default settings, select the 
Reset Values button.

4. Once the parameters are set, select the Next > button to display the calibration type 
selection dialog box shown in Figure 4-2.
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Selecting a Calibration Type

The dialog box shown in Figure 4-2 is the window that is used to select the calibration type 
and the calibration kit. It opens in the default SOLT (Short-Open-Load-Thru) calibration 
type, showing the 4-Channel SOLT calibration type along with the SOLT calibration kits that 
have been determined by the auto-detection to be appropriate for the system hardware. Some 
calibration kits listed here may not be displayed.

Figure 4-1 Select Calibration Type Dialog Box

The Select Calibration Type list allows you to choose the calibration type. 4-Channel 
SOLT is the default calibration type. Opening the list displays that the 4-Channel TRL 
(Thru- Reflect-Line) calibration type is also available. If you select 4-Channel TRL, no 
calibration kit choices are available. You will first need to define a calibration kit that covers 
your measurement parameter start and stop frequency range. 

Select the calibration type from the list and refer to the appropriate section listed below.

• If you selected 4-Channel SOLT calibration, refer to “Performing an SOLT Calibration” 
on page 84.

• If you selected 4-Channel TRL calibration, refer to “Performing a TRL Calibration” on 
page 96.
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Performing an SOLT Calibration

You have selected the 4-Channel SOLT calibration type. You will first select a calibration kit 
and then you will perform a calibration (either mechanical or electronic, depending on your 
calibration kit). After you finish the calibration, you will be ready to make a measurement.

Selecting a Calibration Kit

The dialog box shown in Figure 4-2 lists the calibration kits that have been determined by the 
auto-detection to be appropriate for the system hardware. 

Additional calibration kits, including user-defined kits, may be added by selecting 
Calibration then Edit Cal Kit from the Utilities menu. See “Edit Cal Kit” on page 248 for 
details.

Figure 4-2 Select Calibration Kit Dialog Box

NOTE Some calibration kits listed here may not be displayed. This dialog box displays 
each calibration kit that meets the requirements set by the calibration 
parameters set previously.

Selecting the More >> button displays the connector type for each of the four ports. 
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1. Select your calibration kit. Refer to Table 4-1 for the appropriate calibration kit.

2. Once the calibration kit is selected, click the Next > button to display the calibration 
window.

• If you selected a mechanical calibration kit, refer to “Performing a Mechanical SOLT 
Calibration” on page 85 for additional information.

• If you selected an electronic calibration kit, refer to “Performing an Electronic 
Calibration” on page 92 for additional information.

Performing a Mechanical SOLT Calibration 

NOTE For maximum accuracy and repeatability, the system (network analyzer and 
test set) should be stabilized at room temperature for a minimum of 24 hours 
before calibration.

The 4-port (channel) Short/Open/Load/Thru (SOLT) calibration type is one of the most 
comprehensive calibrations. This calibration effectively removes the directivity error, 
crosstalk, source match error, load match error, frequency response reflection tracking error, 
and frequency response transmission tracking error from the test setup in a transmission or 
reflection test using these ports. 

Table 4-1 Default Calibration Kit Parameters

Model Number Frequency Range

Mechanical Calibration Kits include:

85033E 30 kHz to 9 GHz

85052D 45 MHz to 26.5 GHz

85056A 45 MHz to 50 GHz

Electronic Calibration Kits include:

N4430Aa

a. Also applies to the ATN-4801 Multiport Calibration Module.

30 kHz to 6 GHz

N4430B 30 kHz to 9 GHz
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It has two unique components: the Thru component and the Short/Open/Load (SOL) 
component. 

• The Thru component consists of connecting a through (Thru) adapter between the ends of 
the test cables connected to the system ports. The Thru adapter is also part of the 
calibration kit.

• The SOL component consists of connecting a short standard, an open standard, and a 
50-ohm load standard to the end of the test cable connected to each system port. Each of 
these standards is part of the calibration kit.

Figure 4-3 is the mechanical calibration interface that steps you through the calibration. It 
displays calibration configuration information—such as the calibration kit selection, the test 
port connector types, the selected thru adapter, and the thru configuration—as well as a 
graphical representation of the test ports. This graphical representation includes a set of icons 
for each port, corresponding to a short, open, and load (see “The Short/Open/Load (SOL) 
Component” on page 89). In the center of the screen, the selected thru configuration is 
displayed (see “The Thru Component” on page 87).

Figure 4-3 The SOLT Calibration Interface
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Note that all of the icons and the thru configuration are displayed in red at the start of the 
calibration (except the first thru to be connected, which is shown in blue). As each calibration 
standard is connected and measured, the color of its corresponding icon will change to green. 
This is also true of the thru configuration.

The Thru Component  In addition to the SOL component of the calibration, a series of 
through (thru) measurements are required. For a 4-port calibration, it can be assumed that 
six thru-path calibrations are required (1-2, 1-3, 1-4, 2-3, 2-4, 3-4). However, some test setups, 
particularly probing setups, may make thru connections for all six paths physically 
impossible.

PLTS provides an alternative, and only requires four thru-paths measurements to perform an 
accurate four-port calibration.

Figure 4-4 “Thru Config” Options

The selection in the Thru Config area of the Calibrate Hardware for Measurement window 
(shown in Figure 4-3 on page 86) dictates the calibration pattern of the thru calibration. 
Figure 4-4 shows the Thru calibration pattern for each Thru Config selection. 
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There are minor trade-offs to consider when deciding between a four or six thru-path 
calibration. With a four thru-path calibration, the non-measured thru-paths are calculated 
(simulated) in the software. Although this calculation has been proven to be extremely 
accurate, the simulated paths have a fractional amount of ripple across the band that would 
not be present if the full six thru-path calibration were performed. This ripple is insignificant 
in all but extremely low-loss DUT specifications. 

TIP Comparing Thru Path Calibrations

For the sake of convenience, the four thru-path calibrations are recommended 
in most situations. If you are concerned about the difference, you may choose to 
perform two calibrations, one four thru-path and one six thru-path, and 
compare the results with your particular DUT specifications in mind.

Note that when a Thru Config choice is selected, the color of the first Thru measurement 
path changes from red to blue. When that Thru path calibration is complete, the path color 
changes from blue to green and the next Thru measurement path is displayed in blue.

To Perform the Thru Calibration Component  1.Connect the test cables and any 
adapters that you will use for your measurements to the Physical Layer Test System test 
ports. 

The calibration is made with all cables and connectors in place but without the DUT.

2. With the Calibrate Hardware for Measurement window (see Figure 4-3 on page 86) 
displayed, select the following Thru icon: 

3. Once the Thru icon is selected, a prompt is displayed telling you which connections must 
be made for the Thru calibration. An example is shown in Figure 4-5.

Figure 4-5 Example Prompt for Thru

4. Continue to select the Thru icon following the instructions as each prompt is displayed. 
The Thru component of the calibration is complete once the color of all of the Thru paths 
have changed to green.

5. Continue with “The Short/Open/Load (SOL) Component” to complete the calibration.
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The Short/Open/Load (SOL) Component  Performing the SOL portion of the calibration 
consists of connecting each of the standards to each of the ports for a reference measurement. 
Any sequence may be used, and multiple connections may be made simultaneously for 
convenience (for example: connect the short to port 1, load to port 2, and open to port 3, then 
continue). The icons will change color from red to green as each standard is completed.

Each of the four ports on the window has an associated set of icons as shown: 

Each of the three icons in the set represents a different part of the SOL calibration 
component.

 represents the short standard from the calibration kit

 represents the open standard from the calibration kit

 represents the 50-ohm load standard from the calibration kit

As each standard is connected to each port and characterized during the calibration, the color 
of the associated icon changes from red to green.

To Perform the Short/Open/Load (SOL) Calibration Component  1.With the Calibrate 
Hardware for Measurement window (see Figure 4-3 on page 86) displayed, ensure that the 
Show Prompts check box is checked.

TIP To perform the SOL calibration without using prompts:

Prompts are used to guide you through the steps for this calibration. It is not 
required that this calibration be performed using prompts, such as the one 
shown in Figure 4-6. These prompts may be disabled by clearing the Show 
Prompts checkbox. Until you become familiar with the calibration procedure, 
it is recommended that you use the prompts.

1. Ensure that the Show Prompts check box is cleared.

2. Select a short, open, or load standard from the calibration kit and connect it 
to one of the test ports. Note: You may save time by connecting more than one 
standard (for example: connect the short to port 1, load to port 2, and open to 
port 3, then continue).

3. Click the corresponding icon to perform the appropriate measurement.

4. The system will perform a reference measurement, and the color of the icon 
will change to green, indicating completion.
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5. Repeat for the remaining standards and ports until all of the icons have 
changed to green.

After you have finished the SOL calibration, select the Next > button to the 
save the calibration data. See “To Save the Calibration” on page 91.

2. Click on any one of the icons, at any one of the test ports.

3. A dialog box is displayed confirming the required standard and port. An example is shown 
in Figure 4-6.

Figure 4-6 Example Prompt for Shorts, Opens, and Loads

4. Make the requested connection and click OK.

5. The system will perform a reference measurement, and the color of the icon will change to 
green, indicating completion.

6. Repeat for the remaining standards and ports until all of the icons have changed to green.

7. After you have finished the SOL calibration, select the Next > button to the save the 
calibration data. See “To Save the Calibration” on page 91.
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To Save the Calibration  Once you have completed both components of the SOLT 
calibration, the Save Calibration Data dialog box is displayed as shown in Figure 4-7.

Figure 4-7 Save Calibration Data Dialog Box

1. Enter a file name for the calibration data set.

The calibration data file will be saved in the directory displayed in the Calibration Data 
File Path box. You may change the directory by entering the directory path in the box or 
selecting the Browse… button and navigating through your computer’s directory 
structure to the desired directory. The calibration data is automatically saved with a “.cal” 
file extension.

2. Save the calibration data by selecting the Next > button.

When the calibration data is saved, the calibration is complete.

3. If you started the calibration:

• As part of the example measurement of Chapter 3, return to “How to Make a 
Measurement” on page 70.

• By entering the startup wizard at startup or by selecting New from the File menu, the 
software sends you to the Startup Wizard’s Setup & Calibration Complete! window 
where you can make a measurement.

• By selecting Calibration from the Utilities menu and then selecting Calibrate, the 
software returns to the main software window.
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Performing an Electronic Calibration

You can perform a 4-port electronic calibration (ECal) using the Agilent N4430A 6 GHz 4-Port 
ECal Module1 or the N4430B 9 GHz 4-Port ECal Module.

With a one-time connection, the ECal procedure cycles through all of the impedance states 
and six thru paths required for a full, four-port, vector error-corrected SOLT calibration, and 
can transfer factory-calibration accuracy to the Physical Layer Test System. The software 
controls the electronic calibration. Refer to Figure 4-8 for a typical equipment setup.

Figure 4-8 Typical Equipment Setup for ECal

NOTE For maximum accuracy and repeatability, the system (network analyzer, test 
set, and ECal module) should be stabilized at room temperature for a minimum 
of 24 hours before calibration.

Using standard alignment precautions, the test set may have the ECal module connected and 
disconnected in any power state. After calibration, the ECal module may remain connected or 
may be disconnected from the test set Auxiliary connector with no effect on the calibration.

To perform the ECal with the physical layer test system:

1. Once you select an electronic calibration kit and then click the Next > button as instructed 
on the last step of the “Selecting a Calibration Kit” procedure on page 85, the Electronic 
Calibration is displayed. See Figure 4-9.

1. The ATN-4801 Multiport Calibration Module may also be used.
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Figure 4-9 Electronic Calibration Dialog Box

2. Connect the test cables and adapters that you will use for your measurements to the 
Physical Layer Test System test ports.

3. Connect the other end of the test cables and adapters to the ECal module so that the 
connections identified in Table 4-2 are made. If adapters are required to make the 
connections from the test cable/adapter setup to the ECal module, use the adapters in the 
ECal module kit.

Table 4-2 ECal Module Connections

ECal Module Connector PLTS Connector Cable Type Specified Torque

CONTROL AUXILIARY DB-15 N/A

PORT 1 PORT 1 Coax 8 in/lb

PORT 2 PORT 2 Coax 8 in/lb

PORT 3 PORT 3 Coax 8 in/lb

PORT 4 PORT 4 Coax 8 in/lb
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CAUTION Make sure that test port 2 of the system is connected to Port 2 of the ECal 
module and that test port 3 of the system is connected to Port 3 of the ECal 
module. Connecting to the wrong port will lead to incorrect calibration 
results. Refer to Figure 4-10 for test cable connections to the ECal module.

Figure 4-10 Connecting Test Cables to the ECal Module

4. Select the electronic calibration characterization file for your ECal module from the list. 
Refer to Figure 4-9. Verify that the file name matched the serial number of your ECal 
module.

If your characterization file was not located by the software, load the characterization file 
from the floppy disk provided with the ECal module. Load the file from the floppy disk by 
inserting the floppy disk in the PC, selecting the Have Disk … button, and locating the 
characterization file from the floppy disk directory using the Open dialog box. Each module 
characterization file is unique, so verify that the file name matches the ECal module serial 
number. The characterization file has an “.ecl” extension. The ECal module should be 
loaded into the C:\Program Files\Agilent Technologies\PLTS\ecal, where C is the hard 
drive where the PLTS is stored.
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NOTE Select the ECal Info… button to display the following ECal module 
information dialog box for the selected module. 

5. If your system’s test cable setup won’t connect directly to the ECal module, you may use an 
adapter that has already been characterized. To use the adapter, select the adapter’s 
characterization file from the Select Adapter Files list. Refer to “Characterizing 
Adapters” on page 107 for detailed information.

NOTE If you use one or more of the 3.5 mm male to male adapters in the ECal kit, you 
may select one of the 3.5m-m.txs files from the Select Adapter Files list.

• If you are connecting the adapter in the forward orientation (with the adapter’s 
characterized port 2 connected to the ECal module), just select the checkbox labeled A 
(representing Adapter) for the port to which it is being connected.

• If you are connecting the adapter in the reverse orientation (with the adapter’s 
characterized port 1 connected to the ECal module), select the checkbox labeled A 
(representing Adapter) and the checkbox labeled R (representing Reverse) for the port 
to which it is being connected. 

NOTE The Adapter (A) checkbox must be selected before the program accounts for the 
Reverse (R) checkbox being selected.

6. Once the system is connected to the ECal module, select Next > to start the electronic 
calibration. A small window showing the calibration progress is displayed.

Once the calibration is complete, it should be saved. See “To Save the Calibration” on 
page 91.
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Performing a TRL Calibration

You have selected the 4-Channel TRL calibration type. Unless you have defined a TRL 
calibration kit previously, you will need to define a TRL calibration kit before proceeding. 
Refer to “Defining a TRL Calibration Kit”. After you complete the definition, you may return 
to the startup wizard using the procedure that you have followed to get to this point.

NOTE TRL calibration on physical layer test systems with the 8753ES or the 872XES 
network analyzers is not supported.

If you already have a TRL calibration kit defined and displayed in the window, continue with 
“Selecting a TRL Calibration Kit” on page 100.

Additional calibration kits, including user-defined kits, may be added as shown in “Defining a 
TRL Calibration Kit”. 

Defining a TRL Calibration Kit

The dialog box shown in Figure 4-12 shows only the USER_DEF selection. This indicates 
that a TRL calibration kit must be defined before a TRL calibration may be performed.by 
selecting Calibration then Edit Cal Kit from the Utilities menu. See “Edit Cal Kit” on 
page 248 for details.

1. If you have no TRL calibration kit displayed, exit the startup wizard by clicking the close 
button in the upper right corner of the wizard: 

2. From the Utilities menu, select Calibration, Edit CalKit as shown in Figure 4-11.

Figure 4-11 Selecting Edit CalKit

3. In the Select Cal Kit dialog box, select 4-Channel TRL from the Select Calibration 
Type list, then select the USER_DEF selection and click Edit to start the definition 
process. See Figure 4-12.
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Figure 4-12 Select Cal Kit Dialog Box

4. The calibration kit definition is performed in the Edit TRL Calibration Kit dialog box. See 
Figure 4-13.

Figure 4-13 Blank Edit TRL Calibration Kit Dialog Box

5. Enter Cal Kit ID, Name, and Connector Type into the appropriate entry boxes in the 
header.

Referring to Figure 4-12, Cal Kit ID is listed in the Cal Kit column and Name is listed in 
the Description column of the calibration kit selection window.
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In this example, Cal Kit ID is defined as “85050C”, Name is defined as “7mm TRL Cal 
Kit”, and Connector Type is defined as “7mm”. Refer to Figure 4-16.

6. Complete of the Edit TRL Calibration Kit dialog box. Figure 4-14 shows the data that is 
used in this example.

For the Coefficients area, enter the values for the type of Reflective device that you are 
using. For example, if you are using an open as a reflective device, enter the device’s 
capacitive values from it’s calibration coefficients along with the offset value (in cm). This 
information can be located in the calibration kit from which the device was taken. If you 
are using a short as the reflective device, enter it’s inductive values along with the offset 
value. Use only one column when entering values for your Reflective device.

For the Enter Cal Standard Characterization Data area, enter a name for each Line 
along with each line’s start and stop frequency (in MHz) and delay (in ps). Information for 
up to three lines can be entered into this area. If the delay of a line is entered as 0 ps, the 
line is assumed to be a load (50Ω termination). Also enter the name and delay of the Thru 
device which is typically 0 ps.

Figure 4-14 Completed Edit TRL Calibration Kit Dialog Box
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7. Once the TRL calibration kit data has been entered into the dialog box, select OK to save 
the calibration kit data. Once the TRL calibration kit data has been saved, select Close to 
close the Select Cal Kit dialog box.

Figure 4-15 Close the Select Cal Kit Dialog Box

Return to the startup wizard to complete the TRL calibration procedure. You can select 
New from the File menu to restart the wizard. If you need help completing the startup 
wizard, return to Chapter 3 on page 59. If you do not need assistance, continue with 
“Selecting a TRL Calibration Kit”.
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Selecting a TRL Calibration Kit

Figure 4-16 shows the dialog box listing the TRL calibration kits that are defined for the 
measurement parameters. If a TRL calibration kit does not match or exceed the frequency 
range of the measurement parameters, it is not listed is this dialog box. 

Figure 4-16 Select TRL Calibration Kit Dialog Box

Selecting the More >> button displays the connector type for each of the four ports. 

1. Select your calibration kit.

2. Once the calibration kit is selected, click the Next > button to display the calibration 
window. Continue with “Performing a TRL Calibration”.

Performing a TRL Calibration 

NOTE For maximum accuracy and repeatability, the system (network analyzer and 
test set) should be stabilized at room temperature for a minimum of 24 hours 
before calibration.
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As indicated by its name, the Thru-Reflection-Line (TRL) calibration consists of three 
portions. First, the reflection portion is performed by connecting a short to each system port. 
The Line portion is performed by connecting the three lines and a thru between system ports 
1 and 3 and then by connecting the same lines and thru between ports 2 and 4. Finally, the 
Thru portion is performed by connecting the thru between system ports 1 and 4 and then by 
repeating the connection between ports 2 and 3. 

Figure 4-17 Initial TRL Calibration Display

1. Select the following icon to start the Reflection portion of the calibration: 

Figure 4-18 Displaying the Port 1 Reflection Prompt
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2. As described in the prompt shown in Figure 4-18, connect the short from your calibration 
kit to Port 1 and click OK.

As the portion of the calibration is complete, the Port 1 icon color changes from red to 
green.

3. Repeat steps 1 and 2 for each of the remaining ports.

The order that the ports are calibrated does not matter. 

Once all four of the ports are calibrated using the short, the color of the line between port 1 
and port 3 changes from red to blue indicating that this path is the next to be measured. 
The color of the Terminations (Line 1 in the calibration kit definition) indicator on the 
right edge of the display changes from red to blue indicating that this measurement is the 
next to be made. See Figure 4-19.

Figure 4-19 Reflection Portion of Calibration Complete

4. Select the following icon to start the Line portion of the calibration: 

A prompt is displayed advising you to connect Line 1 between Port 1 and Port 3.
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5. Click OK after the line is connected between ports 1 and 3.

After the measurement is made on Line 1, the color of the Line 1 indicator (Terminations) 
at the right edge changes from blue to green to indicate that this measurement is 
complete. The color of the Line 2 indicator (0.5-3.0GHz) changes from red to blue 
indicating that this measurement is the next to be made.

6. Repeat steps 4 and 5 for Lines 2 (0.5-3.0GHz), Line 3 (2-18GHz), and the Thru (ZeroDelay).

Once these measurements are taken, the calibration between ports 1 and 3 are complete. 
On the display, the color of the line between ports 1 and 3 changes from blue to green 
indicating that this path is complete. The color of the line between ports 2 and 4 changes 
from red to blue indicating that this path is the next to be measured. See Figure 4-20.

Figure 4-20 Port 1 - Port 3 Line Portion of Calibration Complete

The color of the Line 1 (Terminations) indicator on the right edge of the display changes to 
blue indicating that this measurement is the next to be made. The remaining indicators 
are changed to red indicating they are not yet done for Port 2 - Port 4.
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7. Repeat steps 4 through 6 for the Port 2 to Port 4 path.

Figure 4-21 Line Portion of Calibration Complete

8. Select the following icon to start the Thru portion of the calibration: 

A prompt is displayed advising you to connect the Thru between Port 1 and Port 4.

9. Click OK after the Thru is connected between ports 1 and 4.

10.After the Port 1 to Port 4 Thru calibration is made, repeat steps 8 and 9 to complete the 
Thru calibration between Port 2 and Port 3.
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11.Once the Port 2 to Port 3 Thru calibration is made, the TRL calibration measurements are 
complete. Refer to Figure 4-22. 

Continue at “To Save the TRL Calibration” on page 106.

Figure 4-22 TRL Calibration Complete
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To Save the TRL Calibration  Once you have completed the TRL calibration, the Save 
Calibration Data dialog box is displayed as shown in Figure 4-23.

Figure 4-23 Save Calibration Data Dialog Box

1. Enter a file name for the calibration data set.

The calibration data file will be saved in the directory displayed in the Calibration Data 
File Path box. You may change the directory by entering the directory path in the box or 
selecting the Browse… button and navigating through your computer’s directory 
structure to the desired directory. The calibration data is saved with a “.cal” file extension.

2. Save the calibration data by selecting the Next > button.

When the calibration data is saved, the calibration is complete. A window is displayed 
showing how to make the connections to measure your DUT following the TRL calibration.

3. If you started the calibration:

• As part of the example measurement of Chapter 3, return to “How to Make a 
Measurement” on page 70.

• By entering the startup wizard at startup or by selecting New from the File menu, the 
software sends you to the Startup Wizard’s Setup & Calibration Complete! window 
where you can make a measurement.

• By selecting Calibration from the Utilities menu and then selecting Calibrate, the 
software returns to the main software window.
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Characterizing Adapters

For non-insertable1 calibrations, the thru adapter to be used must be characterized by itself so 
that its effects can later be removed from the calibration measurement results. 

Several standard thru adapter characterization files have been provided with PLTS (see the 
..\PLTS\adapters directory) and are automatically selected based on the calibration kit to be 
used. These files may be used with very good results, but for the very highest accuracy, it is 
recommended that you characterize your own adapters using the following procedure.

To perform the characterization, first, a short/open/load calibration is performed directly at 
the front panel of the system. Either one or two test ports will be used depending on the 
adapter category selected during the process. Then the adapter is inserted and the 
short/open/load calibration is repeated. The resulting adapter S-parameters are saved in 
Citifile format, which can later be de-embedded from the device measurement. 

For adapters that will be used for broadband measurements, characterize the adapter over 
the entire frequency range of the instrument with as many points as possible. This allows for 
interpolation of adapter data if the frequency points used in a later DUT measurement are 
not exactly the same as the adapter frequency points.

Adapter characterization is performed directly at the instruments front panel (either Port 1 or 
Ports 1 and 4). If an additional adapter is needed between the front panel and the adapter to 
be characterized (for type or gender change), install the additional adapter first (metrology 
grade recommended), and perform all calibrations with it installed.

For purposes of characterization, your adapters must have an orientation. Mark the 
connectors on the adapter as ports 1 and 2, and treat them as such during the 
characterization procedure. Forward orientation has the lower-numbered adapter port 
connected to the test-set port.

Follow these steps to characterize your adapters:

1. Select Characterize Adapter from the Utilities menu to start the Custom Adapter 
Characterization Wizard.

1. Non-insertable calibrations are those in which the test port connectors are of the 
same gender (male-to-male or female-to-female).
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Figure 4-24 Characterize Adapter Selection

2. In the Custom Adapter Characterization Wizard dialog box, select the appropriate adapter 
category and the calibration kit to be used. See Figure 4-25. Press Next > to continue to 
the next window.

The two adapter characterization categories are:

• “In-Series, Same-Sex” uses a single port (Port 1) and applies only to adapters having 
the same type and gender on both ends (3.5 mm male-to-male, for example). Select the 
calibration kit to be used on Port 1 from the pull-down menu.

• “All Others” uses two ports (Ports 1 and 2) and allows the adapter types to be specified 
independently. Select the calibration kits to be used on Port 1 and on Port 2 from the 
pull-down menus.

Figure 4-25 Custom Adapter Characterization Wizard
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3. Make the connections listed on the Custom Adapter Characterization Wizard Setup 
Instructions window (Figure 4-26) and then click the Setup Stimulus button. 

Figure 4-26 Custom Adapter Characterization Wizard Setup Instructions

4. Make any required changes to the stimulus to match your actual measurement conditions. 
When you make any change, click the Recalculate Parameters button to update all 
parameters. Refer to Figure 4-27. When you are satisfied with the parameters, click OK.

Figure 4-27 Stimulus Parameter Dialog Box

Refer to “Time and Frequency Parameter Descriptions” on page 68 for definitions of each 
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parameter.

5. Following the order shown on your Forward Orientation Adapter Calibration dialog box, 
install the calibration standards as listed and click the Measure button. 

Depending on your previous selections, your window may differ slightly from the window 
shown in Figure 4-28.

Figure 4-28 Forward Orientation Adapter Calibration Window

NOTE The Next > button remains inactive until all data choices are measured.
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6. As you make each measurement, a check mark is displayed in the check box to the left of 
the measurement. See Figure 4-29. Once all measurements are made, click Next > to 
continue. 

Figure 4-29 Completed Forward Orientation Adapter Calibration Window
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7. Following the order shown on your Reverse Orientation Adapter Calibration window, 
install the calibration standards as listed and click the Measure button. Depending on 
your previous selections, your window may differ slightly from the window shown in 
Figure 4-30.

As you make each measurement, a check mark is displayed in the check box to the left of 
the measurement. Once all measurements are made, click Next > to continue. 

NOTE The Next > button remains inactive until all data choices are measured.

Figure 4-30 Reverse Orientation Adapter Calibration Window
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8. When the characterization is complete, save the adapter file using the dialog box shown in 
Figure 4-31. Enter a file name for the adapter data and click Finish. The file is 
automatically saved as a “.txs” file. The default directory for saving adapter 
characterization information is C:\Program Files\Agilent Technologies\PLTS\Adapters, 
where C is the hard drive where the PLTS is stored.

Figure 4-31 Save Adapter Characterization File Dialog Box

Since the characterization file is in Citifile format, you can import the data and make a 
visual check of the quality of the characterization. Select Import from the File menu and 
then select Citifile. You may open and inspect the adapter characterization file.
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Analyzing Data in the Frequency Domain
Physical layer test systems combine a vector network analyzer and a test set to make 
measurements by sweeping a signal in the frequency domain. The test system software can 
then mathematically transform these frequency domain measurements into other analysis 
types such as time domain, eye diagrams, and transmission line (RLCG). However, there is 
information to be gained from frequency domain measurements that these other analysis 
types do not provide.

Frequency measurements can help you verify and validate your modeling and simulation 
procedures by providing:

• vector error-corrected data which allows you to de-embed fixtures and signal launches.

• more accurate simulation for frequency dependent effects, such as bandwidth and 
impedance.

• insight into common analog problems, such as crosstalk, reflections, and loss.

• better information more efficiently when you are analyzing the effects of transmission 
lines, studying power/ground distribution, and investigating EMI effects as a function of 
frequency.

• S-parameter data which can be used over the widest range of applications and frequency 
bandwidths.
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About S-Parameters
At high frequencies, S-parameters (scattering parameters) are commonly used to describe the 
performance of microwave and RF devices. These parameters can be used to completely 
describe the electrical behavior of the device (or network). For those not familiar with 
S-parameters, they are simply the energy that is reflected off of, or transmitted through, a 
device under test. While S-parameter data is formatted differently than TDR/TDT data, the 
underlying information is the same. 

S-parameters relate to familiar measurements such as reflection coefficient (input/output 
match), and transmission coefficient (gain or loss, and isolation). They are the shared 
language between simulation and measurement and are easily imported into 
electronic-design automation (EDA) tools like HSPICE, ADS, and other simulators.

Conventional single-ended parameters describe the performance of a single-ended device 
when it is stimulated on a single port, and the corresponding responses are observed on all of 
the ports. For a detailed explanation, refer to “Single-Ended (Unbalanced) S-Parameters” on 
page 118. Mixed-mode (or balanced) S-parameters describe the performance of devices with 
balanced ports. For a detailed explanation, refer to “Mixed Mode (Balanced) S-Parameters” on 
page 120.

Common Frequency Measurements with S-Parameters

Reflection Measurements Transmission Measurements

Return Loss Insertion loss

Standing Wave Ratio (SWR) Gain/loss

Reflection coefficient Transmission coefficient

Impedance Electrical delay

Sxx (x = stimulus port and response port) Syz (z = stimulus port, y = response port)
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How to Interpret S-Parameters
A multi-terminal device can be viewed in different ways, depending on how it is meant to be 
operated. For a device that is designed to be a single-ended four-port device, its conventional 
(single-ended) four-port S-parameters can be measured and displayed. In a balanced device, 
two terminals constitute a single balanced port. Each balanced port will support both a 
common-mode and a differential-mode signal. This performance is described using 
mixed-mode (balanced) S-parameters.

Single-Ended (Unbalanced) S-Parameters

Conventional single-ended S-parameters are defined as the ratio of two normalized power 
waves (response/stimulus), defined in terms of the voltages and current at each port of a 
device (see Figure 5-2).

S-parameter notation identifies these quantities using the following convention:

SAB

where:

The first number (represented by A) refers to the test-device port where the signal is 
received. This received signal is referred to as the response.
- and -
The second number (represented by B) refers to the test-device port where the signal is 
sourced. This signal is referred to as the stimulus.

Figure 5-1 S-Parameter Notation
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Figure 5-2 Single-Ended S-Parameter Review

Figure 5-3 shows the naming convention for a single-ended 4-port S-matrix, showing the ratio 
of all possible combinations of response/stimulus.

Figure 5-3 Single-Ended S-Matrix

Normalized Power Waves

Stimulus

Response

S = b/a

an
1

2 Re Zn( )⋅
------------------------------ Vn In+ Zn⋅( )=

bn
1

2 Re Zn( )⋅
------------------------------ Vn In– Zn⋅( )=
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Mixed Mode (Balanced) S-Parameters

Mixed-mode S-parameters are used to describe the performance of balanced circuits by 
independently considering each mode of operation. The mixed-mode S-parameter concept is 
similar to conventional S-parameter definitions, except that instead of stimulating a single 
terminal of the DUT, we consider pairs of terminals to be stimulated in either a differential 
(anti-phase) or a common (in-phase) mode. 

For a balanced device, we are not necessarily interested in voltages and current referenced to 
ground. Instead, we can define differential and common mode voltages and currents on each 
balanced port. Likewise, we can also define differential-mode and common-mode impedances.

We can define normalized power waves on the ports of a balanced device having the exact 
same form as the single-ended case. Only the definitions of “voltage” and “current” are 
changed. Both are defined as ratios of normalized power waves.

Figure 5-4 Mixed Mode S-Parameter Basics

Normalized Power Waves

Differential-Mode Common-Mode

Stimulus

Response

S = b/a
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Chapter 5120



Analyzing Data in the Frequency Domain
How to Interpret S-Parameters
The naming convention for mixed-mode S-parameters includes mode information as well as 
port information. Unlike the single-ended example, though, in the mixed-mode S-matrix, we 
are not only considering the port, but we are also considering the mode of the signal at each 
port. Therefore, the first two subscripts describe the mode of the response and stimulus, 
respectively, and the next two subscripts describe the ports of the response and stimulus.

Again we can take the ratio of all possible combinations of response over stimulus for the 
differential and common mode normalized power waves to calculate the mixed-mode 
S-parameters. The mixed-mode matrix fully describes the linear performance of a balanced 
two-port measurement. Figure 5-5 shows the naming convention for a mixed mode S-matrix, 
showing the ratio of all possible combinations of response/stimulus.

Figure 5-5 Mixed-Mode (Balanced) S-Matrix
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Viewing Data in the Frequency Domain
This section guides you with opening measured data in the frequency domain and viewing the 
data in the way that best suits your requirements. As discussed earlier, there are 16 4-port 
S-parameters for both single-ended and balanced devices. See Figure 5-3 and Figure 5-5. You 
may elect to view any number of these S-parameters.

Opening a Frequency Domain Plot Window

The frequency domain may be viewed in either balanced or single-ended mode. You may open 
the frequency domain plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 5-6

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 5-6

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 5-6

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the Frequency Domain choices - see (B) of Figure 5-6

NOTE Using the Browser method to open a window requires that you select the 
parameters that you want to view from the Parameter Bar or the Data menu 
when the blank plot window is displayed.
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Figure 5-6 Opening the Frequency Domain Plot Window

Viewing All 16 S-Parameters

In all cases, except when you open the plot window using the Browser, all 16 frequency 
domain parameter plots are displayed. The parameter plots are displayed in the same 
orientation as shown in Figure 5-3 and Figure 5-5. Each of the plots are numbered. The 
Information Bar immediately to the right of the plots lists each plot by number and displays 
the associated parameter. See Figure 5-7.

As mentioned previously, when you open the plot window from the Browser, an empty plot 
window is displayed. View all 16 plots by selecting All from the Parameter Bar or from the 
Data menu with New Plot selected.
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Figure 5-7 Balanced Frequency Domain Plots with Information Bar
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Viewing a Single S-Parameter

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
16 plots (or with multiple plots if you have a custom plot window displayed), double-click on 
the plot that you would like to view. See Figure 5-8. 

Figure 5-8 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
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View Multiple Traces on a Single Plot

This single plot may have just one parameter or if you choose, it could contain more. For 
example, you could show how SDD21 compares with SCC21. To do this double-click on the 
first plot so that is now displaying a single plot similar to Figure 5-8. For this example, Plot 05 
(SDD21) was double-clicked and is displayed as a single plot. With New Trace selected in the 
Parameter Bar (or the Data menu), click the remaining parameters (SCC21 in this 
example). 

Figure 5-9 A Single Plot with Multiple Traces

It could contain as many as all 16 of the parameters. However, this would be impractical 
because having 16 parameters on a single plot would be very hard to distinguish between the 
parameters and the vertical scale would have to be large to show all parameters.
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Creating a Custom S-Parameter Plot Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the four SCCxx plots. To create this custom window, open the 
measured data file in any analysis type. Then, in the Browser, select the data type that you 
want to display the plots. In this example, select Frequency Domain (Balanced). A blank 
plots window is displayed. With New Plot selected in the Parameter Bar (or the Data 
menu), click the desired parameters (SCC11, SCC12, SCC21, and SCC22 in this example). As 
each parameter is selected, a new plot is added to the plots window. See Figure 5-10.

Figure 5-10 Custom S-Parameter Plots Window with Four Plots
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Selecting Frequency Domain Display Formats
A data format is the way the physical layer test system presents the measurement 
graphically. Select a data format appropriate to the information you want to learn about the 
device. You may use either the Format Bar or the Format menu to select the format.

Figure 5-11 Format Menu and Format Bar for Frequency Domain

Frequency Domain Format Bar

Log Mag displays Cartesian logarithmic magnitude (no phase) in dB. 
Typical measurements are return loss and gain. This is the 
default format.

Linear Mag displays positive values only. Typical measurements are 
transmission, reflection coefficients, time domain transfer.

Phase displays phase (no magnitude).

Group Delay displays signal transmission (propagation) time through a 
device. 
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Smith Chart displays an impedance plane that is mapped onto the polar 
plane. Every point on the Smith Chart represents a complex 
impedance made up of a real resistance (r) and an imaginary 
reactance (r + jX). The dotted circles represent constant 
resistance. The horizontal line through the middle is purely 
resistive (no reactive component).

To the far right, the value is zero ohms (short). To the far left, 
the value is infinite ohms (open).

The dotted arcs represent constant reactance.

• The reactance arcs in the upper (positive) half of the circle 
represent inductive reactance.

• The reactance arcs in the lower (negative) half of the circle 
represent capacitive reactance.

• Typical measurements: Impedance profile

When in this format, the cursor bar allows you to choose the 
cursor value in either Mag + Phase or Inductance style. Refer to 
Using Cursors on page 135 for additional information.

Polar Chart plots the measurement result in a vector representation. 

The magnitude at any point is determined by its displacement 
from the center (or zero value). Magnitude is scaled linearly, 
with the value of the outer circle set to a ratio value of 1.

The radial lines scale the phase angle from 0 degrees to +180 
degrees (counterclockwise) or −180 degrees (clockwise).

When in this format, the cursor bar allows you to choose the 
cursor value in either Mag + Phase or Inductance style. Refer to 
Using Cursors on page 135 for additional information.

Real displays only the real (resistive) portion of the measured 
complex data. Can show both positive and negative values. 
Typical measurement: time domain

Imaginary displays only the imaginary (reactive) portion of the measured 
complex data. Typical measurements are impedance for 
designing matching circuits.

Frequency Domain Format Bar
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Table 5-1 Frequency Domain Formats

Log Mag Linear Mag

Phase Group Delay
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Smith Chart Polar Chart

Real Imaginary

Table 5-1 Frequency Domain Formats
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Setting the Scale
The PLTS software allows you to change the horizontal and vertical scale of the plots using 
the Scaling Bar. 

Figure 5-12 Scaling Bar

Change the Scaling Bar values by:

• Clicking and dragging within a scaling bar entry box to highlight the current value and 
then typing the new value. See (A) of Figure 5-13.

• Selecting the up/down arrow buttons to the right of each entry. See (B) of Figure 5-13.

• Selecting the calculator icon to the right of each entry to display a keypad. Click the 
keypad’s numeric buttons to enter a new value and click the Enter button to save the new 
value. See (C) of Figure 5-13.

Figure 5-13 Entering a Scale Value
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The horizontal scale is changed by changing the start and stop frequencies in megahertz 
(MHz). Note that you can not extend the start and stop frequencies beyond the start and stop 
frequencies used in the measurement. The horizontal scale may not be changed in Smith 
Chart and Polar formats.

The vertical scale units vary depending on the format. 

Table 5-2

Format Vertical Scale Units

Log Mag decibels (dB)

Linear Mag mU

Phase degrees

Group Delay nanoseconds (nS)

Smith Chart Not Applicable

Polar Not Applicable

Real mU

Imaginary mU
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Using Cursors
Cursors may be used to find specific locations along the plot. When a cursor is activated, it’s 
marker can be moved to any location along the plot trace. The horizontal and vertical values 
are displayed on the Information Bar. Two cursors are available. 

To display a cursor, click the cursor label (either Cursor 1 or Cursor 2) in the Cursor Bar 
and then click and drag its slide control. While dragging the control slide, watch the marker 
move along the trace in the active plot. Notice that the cursor values are displayed in the 
Information Bar. 

Figure 5-14 Activating a Cursor

You can also change the cursor position, one point at a time, by pressing the left/right arrow 
keys on the keyboard.

Activate the second cursor as you did the first cursor. Notice that both cursor values along 
with the difference, the Delta (∆), between the cursors are displayed in the Information Bar. 

Delta = Value of Cursor 2 − Value of Cursor 1
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Figure 5-15 Activating a Second Cursor

NOTE When the selected format is either Smith Chart or Polar Chart, the cursor 
bar also displays a list box containing two selections: Mag + Angle (magnitude 
and angle) and Impedance. 

Figure 5-16 Cursor Bar for Smith Chart and Polar Chart Formats

Select the desired parameter to view the cursor values of that style in 
Information Bar. Selecting Impedance displays the real and imaginary 
components of the Smith Chart and Polar Chart cursor values.
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Analyzing Data in the Time Domain
The Agilent physical layer test system or (PLTS) combined with Agilent’s vector network 
analyzers and their companion multiport test sets perform measurements in the frequency 
domain by sweeping a RF signal and measuring the RF responses of a device under test or 
(DUT). The Agilent PLTS software can also mathematically transform these frequency 
domain data S parameters into their time domain counterparts and display them in either 
their step, impedance or their impulse/response modes.

In a linear network, the Fourier Transform describes the relationship between a frequency 
domain measurement and its corresponding time domain response in detail. Therefore, given 
the measured frequency domain response of a DUT, it is possible to determine its time domain 
response mathematically by performing an inverse Fourier Transform. And the PLTS 
software accomplishes it’s frequency domain transformation to time domain by utilizing this 
inverse chirp Z Fourier transform1.

The type of information that can be observed in time domain mode is quite different than the 
information that can be observed in frequency domain mode. If the network is thought of in 
terms of its equivalent circuit model, then the frequency domain response describes the 
composite behavior of all of the circuit elements at any given operating frequency. 

By contrast, the time-domain response shows the contribution of each individual circuit 
element. Since there is a direct relationship between time and distance, this mode allows each 
element to be separated spatially. With an understanding of the unique signature 
characteristics of different circuit elements, this view of the DUT can provide considerable 
insight into the device.

An alternative method of obtaining time-domain characterization of a device is to make the 
measurement directly in the time domain by synthesizing a step waveform, applying it to the 
device, and observing the response on an oscilloscope. The advantages of using the PLTS 
measurement approach for TDR data are listed below.

While the traditional TDR measurement technique provides fast measurement speed, the 
measurement technique used by the physical layer test system provides:

• Superior accuracy
• Significantly better dynamic range (important for crosstalk and mode-conversion terms)
• Ability to de-embed fixtures and signal launchers
• Access to both frequency and time domain information (as vector quantities)
• Single setup for forward and reverse transmission and reflection, single-ended, 

differential-, and common-mode, and mode-conversion terms
• No need for DUT to have DC return path
• No large voltage steps applied to DUT

1. The advantage of the chirp z-transform is that it enables calculation of the sample of the 
z-transform equally spaced over an arc or a spiral contour with an arbitrary starting point 
and arbitrary frequency range. In contrast, the frequency range of the discrete Fourier 
Transform is strictly related to the sampling frequency.
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TDR/TDT Mode
The time domain mode shows the contribution of each individual circuit element. Using time 
domain reflectance (TDR), you can measure the location, electrical length, nature of 
discontinuities (resistive, capacitive, inductive), and amount of reflection from discontinuities. 
Time domain transmission (TDT) response parameters typically measured are gain, 
propagation delay, and crosstalk between traces.

The physical layer test system can measure and display any of the single-ended (unbalanced) 
or mixed-mode S-parameters in the time domain and display the response of a device as if it 
were stimulated with either a step or an impulse waveform. For those not familiar with 
S-parameters, they are simply the energy that is reflected off of, or transmitted through, a 
device under test. S-parameters are defined as the ratio of two normalized power waves 
(response/stimulus), defined in terms of the voltages and current at each port of a device. For 
more information, see “How to Interpret S-Parameters” on page 118.

• In TDR/TDT mode, the horizontal axis displays:

— Reflection parameters showing the characteristics of the DUT at a certain time delay 
into the device. 

— Transmission parameters showing the propagation delay through the device.

• The vertical axis displays:

— An impulse response that is a reflection or transmission coefficient on either a linear or 
logarithmic scale. This parameter can be displayed as an absolute number, or relative 
to a minimum or maximum value of the response. 

— A step response on either a linear or a logarithmic scale. Alternatively, a reflection 
parameter can be displayed as impedance versus time rather than as a reflection 
coefficient.

The following table shows the relationship between frequency domain parameters to their 
time domain equivalents.

Table 6-1 Relationship of Frequency Domain Parameters to Time Domain Equivalents

Mode Direction Type Parameter

Single-ended N/A TDR S11

Single-ended Reverse TDT S12

Single-ended Reverse TDT S13
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Single-ended Reverse TDT S14

Single-ended Forward TDT S21

Single-ended N/A TDR S22

Single-ended Reverse TDT S23

Single-ended Reverse TDT S24

Single-ended Forward TDT S31

Single-ended Forward TDT S32

Single-ended N/A TDR S33

Single-ended Reverse TDT S34

Single-ended Forward TDT S41

Single-ended Forward TDT S42

Single-ended Forward TDT S43

Single-ended N/A TDR S44

Differential Forward TDR SDD11

Differential Reverse TDT SDD12

Differential Forward TDT SDD21

Differential Reverse TDR SDD22

Common Forward TDR SCC11

Common Reverse TDT SCC12

Common Forward TDT SCC21

Common Reverse TDR SCC22

Differential-to-Common Forward TDR SCD11

Differential-to-Common Reverse TDT SCD12

Table 6-1 Relationship of Frequency Domain Parameters to Time Domain Equivalents

Mode Direction Type Parameter
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Analyzing Time-Domain Signatures
The time-domain response of a device, its signature, provides specific circuit detail. The shape 
of the response indicates the element type and configuration (series or shunt). Its value and 
location can be determined from the size of the reflection and its time delay. In general, a 
wider measurement bandwidth will provide finer response resolution. Table 6-2 shows 
various circuit elements and associated time-domain signatures.

Differential-to-Common Forward TDT SCD21

Differential-to-Common Reverse TDR SCD22

Common-to-Differential Forward TDR SDC11

Common-to-Differential Reverse TDT SDC12

Common-to-Differential Forward TDT SDC21

Common-to-Differential Reverse TDR SDC22

Differential-to-Single-ended Reverse TDT SSD12

Differential-to-Single-ended Reverse TDT SSD13

Single-ended-to-Differential Forward TDT SDS21

Single-ended-to-Differential Forward TDT SDS31

Common-to-Single-ended Reverse TDT SSC12

Common-to-Single-ended Reverse TDT SSC13

Single-ended-to-Common Forward TDT SCS21

Single-ended-to-Common Forward TDT SCS31

Table 6-1 Relationship of Frequency Domain Parameters to Time Domain Equivalents

Mode Direction Type Parameter
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Table 6-2 Time Domain Signatures

Transmission Line: ZC < Z0

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Transmission Line: ZC > Z0

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Series Inductor

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Shunt Capacitor

Impulse
Reflection

Step
Reflection

Impulse
Transmission

Step 
Transmission
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Practical Considerations
In general, better accuracy of the measured frequency domain data will provide for better 
accuracy of the time domain data. Using the step mode rather than the sweep mode provides 
additional frequency stability of the source which can greatly improve the time domain data. 
The following are several other important considerations.

Masking

Time domain responses are most accurate closest to the location of the source. A discontinuity 
in the DUT will reflect some power back to the source, meaning less power is transmitted to 
the rest of the DUT. This loss of power going away from the source is referred to as masking, 
and allows the true impedance of the next discontinuity to be misrepresented.

Figure 6-1 Masking Effects

Masking effects can be seen in Figure 6-1. The plot on the left shows the differential-mode 
input reflection of a device (SDD11). The first large discontinuity is the input connector; the 
second is the output connector. Because these connectors are physically identical, the 
apparent impedance difference between the two can be attributed to masking. The power level 
at the output connector has been decreased (masked) by the input connector. The plot on the 
right, output reflection (SDD22), proves this. Looking backwards into the device, the output 
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connector now exhibits the greater apparent impedance. Were it not for masking, these two 
plots, and the measured impedance of the input and output connectors, would be identical.

The high dynamic range of the PLTS system extends the ability of the instrument to 
accurately characterize devices that have several discontinuities or high loss.

Time Domain Windowing

The PLTS software has a feature called Time Domain Windowing that is designed to enhance 
Time Domain measurements. The need for windowing is due to the abrupt transitions in the 
Frequency Domain measurement at the Start and Stop frequencies. This band limiting of the 
frequency domain response causes overshoot and ringing in the Time Domain response. It 
causes the un-Windowed Impulse stimulus to have a sin(kt)/kt shape (k=π/frequency span), 
which has two effects that limit the usefulness of the Time Domain measurement:

• Finite Impulse Width limits the ability to resolve between two closely-spaced responses. 
The effects of the finite impulse width cannot be improved with increasing the frequency 
span of the measurement.

• Impulse Sidelobes limit the dynamic range of the Time Domain measurement by hiding 
low level response within the sidelobes of the higher level responses. The effects of 
sidelobes can be improved by windowing.

Windowing improves the dynamic range of the Time Domain measurement by modifying 
(filtering) the Frequency Domain data prior to conversion to the Time Domain to produce an 
impulse stimulus with lower sidelobes. This greatly enhances the effectiveness in viewing 
Time Domain responses that are very different in magnitude. The sidelobe reduction is 
achieved, however, as the tradeoff with increased impulse width. The effect of Windowing on 
the STEP stimulus is a reduction of overshoot and ringing a the tradeoff with increased rise 
time.

Three windows are available: Minimum, Normal, and Maximum. The sidelobe levels of the 
Time Domain stimulus depend only on the Window that is selected. See Figure 6-3.

The purpose of windowing is to make the Time Domain response more useful in isolating and 
identifying individual responses. The window does not affect the displayed Frequency Domain 
response. It is turned on only when the Time Domain response is viewed. Figure 6-2 shows 
typical effects of windowing on the Time Domain response of the reflection measurement of a 
short circuit.
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Figure 6-2 Effect of Windowing on Time Domain Responses of a Short 
Circuit

The physical layer test system uses a default filter coefficient value of 0.375, and provides 
equivalent rise times of T=0.72/F (where T is the effective step rise time or impulse width in 
picoseconds, and F is the frequency span in gigahertz). For example, a 20 GHz measurement 
on the N4418A provides an equivalent time of 36 pS and a dynamic range of 110 dB.

By increasing or decreasing the filter value above or below the default, a trade-off can be 
made between pulse width (rise time) and side-lobe level (dynamic range). The key is to pay 
attention to the calculated frequency-domain response versus the original data when 
changing the filter value.

When Time Domain Window… is selected from the Tool menu, the Time Domain Window 
dialog box is displayed allowing a choice of the three Time Domain Window settings. 

Figure 6-3 Time Domain Window Dialog Box

• Maximum gives the minimum sidelobes and this provides the greatest dynamic range. 
The filter coefficient value is 0.375. This is the default setting.

• Normal gives reduced sidelobes and is normally the most useful. The filter coefficient 
value is 0.475. 
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• Minimum is essentially no window and therefore give the highest sidelobes. The filter 
coefficient value is 0.500. 

NOTE When you open measurement data in time domain format, the previously 
selected windowing is used. To change the windowing selection, select Time 
Domain Window… is selected from the Tool menu to display the Time 
Domain Window dialog box. Make your windowing selection from the dialog 
box, and click OK. Then, delete the current plot window and reopen a new plot 
window using the same data. The new windowing choice is then applied to the 
data.

Response Resolution

The response resolution describes how close in time two responses can be distinguished. This 
depends on the width of the impulse response, which is inversely related to the measurement 
bandwidth. The relationship between the three is approximately R = T = 1.25/BW; where R is 
the response resolution in picoseconds, T is the effective impulse width in picoseconds, and 
BW is the frequency span in GHz.

Range Resolution

As described previously in “Analyzing Time-Domain Signatures” on page 141, the TDR 
signature provides specific circuit detail. Range resolution (TD span/Number of points, or 
Stop-Start/Number of points) will define how accurately the signature of a response can be 
identified. In general, a wider measurement bandwidth will provide finer spatial resolution.

To improve range resolution, zoom in on the section of interest and adjust the start- and 
stop-points to be as narrow as possible without compromising the agreement in the frequency 
domain.
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Checking the Validity of a Time-Domain Calculation
There are a number of practical considerations in examining time domain data, as described 
previously. Therefore, it is very important to have a method of validating the data. This can be 
accomplished by comparing the original frequency domain data to the data after it is inverse 
Fourier transformed into the time domain, and then Fourier transformed back into the 
frequency domain, as shown in Figure 6-4. Ideally, these data should be identical. Changing 
the time domain start- and stop-points, the filter value, and the value of the DC parameter 
may improve the agreement.

Figure 6-4 Time Domain Data Validation Model
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Viewing Data in the Time Domain
This section guides you with opening measured data in the time domain and viewing the data 
in the way that best suits your requirements. There are 16 parameter plots for both 
single-ended and balanced devices. You may elect to view any number of these plots.

Opening a Time Domain Plot Window

The time domain may be viewed in either balanced or single-ended mode. You may open the 
time domain plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 6-5

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 6-5

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 6-5

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the Time Domain choices - see (B) of Figure 6-5

NOTE Using the Browser method to open a window requires that you select the 
parameters that you want to view from the Parameter Bar or the Data menu 
when the blank plot window is displayed.
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Figure 6-5 Opening the Time Domain Plot Window

Viewing All 16 Parameters

In all cases, except when you open the plot window using the Browser, all 16 time domain 
parameter plots are displayed. Each of the plots are numbered. The Information Bar 
immediately to the right of the plots lists each plot by number and displays the associated 
parameter. See Figure 6-6.

As mentioned previously, when you open the plot window from the Browser, an empty plot 
window is displayed. View all 16 plots by selecting All from the Parameter Bar or from the 
Data menu with New Plot selected.
Chapter 6152



Analyzing Data in the Time Domain
Viewing Data in the Time Domain
Figure 6-6 Balanced Time Domain Plots with Information Bar
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Viewing a Single Parameter

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
16 plots (or with multiple plots if you have a custom plot window displayed), double-click on 
the plot that you would like to view. See Figure 6-7. 

Figure 6-7 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
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View Multiple Traces on a Single Plot

This single plot may have just one parameter or if you choose, it could contain more. For 
example, you could show how TDD21 compares with TCC21. To do this double-click on the 
first plot so that is now displaying a single plot similar to Figure 6-7. For this example, Plot 05 
(TDD21) was double-clicked and is displayed as a single plot. With New Trace selected in the 
Parameter Bar (or the Data menu), click the remaining parameters (TCC21 in this 
example). 

Figure 6-8 A Single Plot with Multiple Traces

It could contain as many as all 16 of the parameters. However, this would be impractical 
because having 16 parameters on a single plot would be very hard to distinguish between the 
parameters and the vertical scale would have to be large to show all parameters.
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Creating a Custom Time Domain Plots Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the four TCCxx plots. To create this custom window, open the 
measured data file in any analysis type. Then, in the Browser, select the data type that you 
want to display the plots. In this example, select Time Domain (Balanced). A blank plots 
window is displayed. With New Plot selected in the Parameter Bar (or the Data menu), 
click the desired parameters (TCC11, TCC12, TCC21, and TCC22 in this example). As each 
parameter is selected, a new plot is added to the plots window. See Figure 6-9.

Figure 6-9 Custom Time Domain Plots Window with Four Plots
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Selecting Time Domain Display Formats
A data format is the way the physical layer test system presents the measurement 
graphically. Select a data format appropriate to the information you want to learn about the 
device. You may use either the Format Bar or the Format menu to select the format.

Figure 6-10 Format Menu and Format Bar for Time Domain

Time Domain Format Bar

Stimulus - Type of the input to the DUT
Impulse inputs an impulse waveform as the stimulus. This is the default 

format.
Step inputs a step waveform as the stimulus. 

Vertical Format - Units used on the vertical axis
Volts selects volts as the vertical unit of measure.

Real displays only the real (resistive) portion of the measured 
complex data. Real can show both positive and negative values. 
This is the default format.

Log Mag displays Cartesian logarithmic magnitude (no phase) in dB. 
Typical measurements are return loss and gain. 

Impedance selects ohms as the vertical unit of measure. This choice is active 
only for reflection plots with a Step stimulus. 
Chapter 6 157



Analyzing Data in the Time Domain
Selecting Time Domain Display Formats
Horizontal Format - Units used on the horizontal axis
ns selects time units (in nanoseconds) for the horizontal format. 

This is the default format.
cm selects distance units (in centimeters) for the horizontal format.

Time Domain Format Bar
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Setting the Scale
The PLTS software allows you to change the horizontal and vertical scale of the plots using 
the Scaling Bar. 

Figure 6-11 Time Domain Scaling Bar

Change the Scaling Bar values by:

• Clicking and dragging within a scaling bar entry box to highlight the current value and 
then typing the new value. See (A) of Figure 6-12.

• Selecting the up/down arrow buttons to the right of each entry. See (B) of Figure 6-12.

• Selecting the calculator icon to the right of each entry to display a keypad. Click the 
keypad’s numeric buttons to enter a new value and click the Enter button to save the new 
value. See (C) of Figure 6-12. The scaling calculator icon varies slightly between scaling 
entries meet the requirements of the specific entry.

Figure 6-12 Entering a Scale Value
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The horizontal scale is changed by changing the start and stop frequencies in megahertz 
(MHz). Note that you can not extend the start and stop frequencies beyond the start and stop 
frequencies used in the measurement. 

The horizontal scale units are either nanoseconds (ns) or centimeters (cm) depending on the 
Format Bar or Format menu selection. 

The vertical scale is either volts, units, ohms, or decibels depending on the Format Bar or 
Format menu selection. The vertical scale selections are:

Volts selects volts as the vertical unit of measure.
Real displays only the real (resistive) portion of the measured complex data. Real 

can show both positive and negative values. This is the default format.
Log Mag displays Cartesian logarithmic magnitude (no phase) in dB. Typical 

measurements are return loss and gain. 
Impedance selects ohms as the vertical unit of measure. This choice is active only for 

reflection plots with a Step stimulus.
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Using Cursors
Cursors may be used to find specific locations along the plot. When a cursor is activated, it’s 
marker can be moved to any location along the plot trace. The horizontal and vertical values 
are displayed on the Information Bar. Two cursors are available. 

To display a cursor, click the cursor label (either Cursor 1 or Cursor 2) in the Cursor Bar 
and then click and drag its slide control. While dragging the control slide, watch the marker 
move along the trace in the active plot. Notice that the cursor values are displayed in the 
Information Bar.

Figure 6-13 Activating a Cursor

You can also change the cursor position, one point at a time, by using the left/right arrow keys 
on the keyboard.
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Activate the second cursor as you did the first cursor. Notice that both cursor values along 
with the difference, the Delta (∆), between the cursors are displayed in the Information Bar.

Delta = Value of Cursor 2 − Value of Cursor 2

Figure 6-14 Activating a Second Cursor
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Gating
Gating provides the ability to remove the effect of a particular circuit element 
mathematically from time-domain plots. The gated section removes a section of the plot that 
you define, replacing it with an ideal transmission line having the same electrical delay as the 
removed section. By observing the original frequency domain response and the transformed 
frequency domain response, the effect of the gating operation on the S-parameter data can be 
seen. For detailed information on gating, refer to “Gating” on page 211.
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Analyzing Data using Eye Diagrams
The physical layer test system software generates eye patterns or diagrams by convolving the 
time domain impulse response with a user-specified bit sequence. The eye diagram is derived 
from the passive parts of the circuit, not from the active parts.

With eye diagrams you can see signal quality with one display, you can diagnose and locate 
any problems, such as attenuation, noise, jitter, and dispersion that arise or characterize 
specific parts of the system.

The software allows you to specify a bit sequence of between 8 and 32 bits to be used in 
generating the eye diagram. You may select a pre-defined bit pattern, a bit pattern that you 
have defined, or an arbitrary bit stream.
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The Eye Diagram
The eye diagram shown in Figure 7-1 identifies key eye diagram definitions. These definitions 
are listed below this illustration. The eye diagram shown in Figure 7-1 was created using the 
BTL.dut file located in the PLTS data folder. The bit pattern used is the K28.5 with 80 ps 
rise/fall time, 2.5 Gb/s data rate, and a 32-bit pattern length.

Figure 7-1 The Eye Diagram

1 Zero Level Zero Level is a measure of the mean value of the logical 0 of an 
eye diagram. 

2 One Level One Level is a measure of the mean value of the logical 1 of an 
eye diagram. 

3 Rise Time Rise time is a measure of the transition time of the data from 
the 10% level to the 90% level on the upward slope of an eye 
diagram. 
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4 Fall Time Fall time is a measure of the transition time of the data from 
the 90% level to the 10% level on the downward slope of an eye 
diagram. 

5 Eye Height Eye height is a measure of the vertical opening of an eye 
diagram. An ideal eye opening would be measured from the 
one level to the zero level. However, noise on the eye will cause 
the eye to close. The eye height measurement determines eye 
closure due to noise.

6 Eye Width Eye width is a measure of the horizontal opening of an eye 
diagram. Ideally, the eye width would be measured between 
the crossing points of the eye. However, jitter may appear on 
the waveform and influence the eye opening. 

7 Deterministic 
Jitter

Deterministic jitter is the deviation of a transition from its 
ideal time caused by reflections relative to other transitions.

8 Eye Amplitude Eye amplitude is the difference between the logic 1 level and 
the logic 0 level histogram mean values of an eye diagram. 

9 Bit Rate Bit rate (data rate) is the inverse of bit period (1 / bit period). 
The bit period is a measure of the horizontal opening of an eye 
diagram at the crossing points of the eye. 
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Designing a Bit Pattern for Eye Diagrams
The Bit Pattern feature in the Tools menu allows you to design a digital bit pattern and to 
apply a bit pattern that has been saved to eye diagram plots. Only the industry standard 
K 28.5 bit pattern has been created and included in the software. However, the PLTS software 
allows you to create bit patterns, from 8 to 32 bits very easily.

Figure 7-2 Tools Menu with Bit Pattern Expanded

1. Select Bit Pattern then Design… from the Tools menu to open the Digital Pattern 
Generator dialog box shown in Figure 7-3.

Figure 7-3 Digital Pattern Generator

2. Click on the “0” key as shown in Figure 7-4.
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Figure 7-4 Selecting the “0” Piano Key

3. Select the remaining even-numbered piano keys so that you have a series of alternating 
bits as shown in Figure 7-5.

Figure 7-5 Digital Pattern Generator with a 32-Bit Pattern

Note the alternating bits going high (turning on) and the alternating 1’s and 0’s in the 
Numeric Representation area.

1. Selecting the “0” key (piano key) in the Bit Representation area:

A. Causes Bit 0 to go high (turn on)

B. Generates a “0” in the first digit of the binary numeric representation
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4. Enter values in the Rise/Fall Time and the Data Rate boxes. Rise/Fall Time is entered 
in picoseconds (ps) and Data Rate is entered in Gigabits per second (Gb/s). See Figure 7-6 
and Figure 7-7.

Figure 7-6 Rise/Fall Time and Data Rate

5. Check the value in the Pattern Length (bits) box. The default value is 32. The allowable 
range is between 8 and 32 bits. You may change this if your pattern contains fewer bits. If 
this value is changed to a value less than 32, any remaining bits are ignored. For example 
if you enter 10 as the pattern length value, then bits 0 through 9 are used and bits 10 
through 31 are ignored.

6. Enter a name for the digital pattern in the Save Pattern box. In this example, 
Alternating Bits is entered. Click the OK button to save the pattern to be used later. 
See Figure 7-7.

Figure 7-7 Save the Digital Pattern
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Viewing Data using Eye Diagrams
This section guides you with opening measured data in the eye diagram plot mode and 
viewing the data in the way that best suits your requirements. There are 8 output plots for 
balanced mode and 12 output plots for single-ended mode. Only transmission paths are 
displayed; no reflection paths are displayed.

Opening a Eye Diagram Plot Window

The eye diagram may be viewed in either balanced or single-ended mode. You may open the 
eye diagram plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 7-8

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 7-8

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 7-8

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the Eye Diagram choices - see (B) of Figure 7-8

Figure 7-8 Opening the Eye Diagram Plot Window
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NOTE When using the Browser method to open a window, first select the bit pattern 
to use with the data (described in the rest of this section), then select the 
parameters that you want to view from the Parameter Bar or the Data menu 
once the blank plot window is displayed.

The Choose a Digital Pattern for Eye Generation dialog box is then displayed (see Figure 7-9). 
You may select a digital pattern to apply from the list of digital patterns. The software is 
shipped with the K 28.5 selection (an industry standard) and the Arbitrary Bitstream 
selection (a random-like bit stream). Any bit patterns that you have created and saved using 
the process described in Designing a Bit Pattern for Eye Diagrams beginning on page  169 are 
also displayed in the Choose a Digital Pattern for Eye Generation dialog box. 

Figure 7-9 Choose a Digital Pattern Dialog Box

NOTE If the bit pattern has already been selected for the data, the Choose a Digital 
Pattern for Eye Generation dialog box is not displayed and the data will is 
displayed using that bit pattern information. To change the bit pattern, select 
Bit Pattern then Apply… from the Tools menu to display the dialog box 
shown in Figure 7-9. Then, select the desired bit pattern from the list on the 
left, enter the desired information (Rise/Fall Time, Data Rate, Pattern Length, 
and Number of Patterns) as described below, and click OK. Then, delete the 
current plot window and reopen a new plot window using the same data. The 
new bit pattern is then applied.
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After clicking a digital pattern in the Choose a Digital Pattern for Eye Generation dialog box 
list, review the digital pattern parameter entries on the right side of the dialog box and enter 
the desired parameter values.

• Rise/Fall Time (pS) is the time that it takes a signal to transition from a low to a high 
(10% to 90%) condition (or the time that it takes a signal to transition from a high to a low 
(90% to 10%) condition).

• Data Rate (Gb/S) is the speed that data is transferred over a circuit or a communications 
line. 

• Pattern Length (bits) is the number of bits in the digital pattern used to create the eye 
diagram. This value is the limiting factor in creating unique digital patterns. The number 
of bits allowed is between 8 and 32. Where B is the number of bits entered, the number of 
unique bit patterns is: 2B − 2. If B = 32 (the maximum number of allowable bits), the then 
4.29×109 unique bit patterns are generated.

• Number of samples (active only when Arbitrary Bitstream is selected) is used to 
indicate the number of unique bit patterns to use in creating the eye diagram. This value 
must be equal or less than the number of unique bit patterns determined by the number of 
bits entry.

Then, click OK to view the eye diagram in the plot window. Cancel closes the dialog box 
without making any changes.

IMPORTANT Arbitrary Bitstream

Arbitrary Bitstream (ABS) is random-like bit stream used to generate eye 
diagrams. The number of bits and the number of samples is used to create the 
ABS. As explained earlier, the number of bits is used to identify how many 
unique bit patterns are available. The number of samples is used to identify 
how many of the available bit patterns will be used to create the eye diagram.

Using both of these values, a random number generator selects unique bit 
patterns until the appropriate number of samples are identified. Each of these 
unique bit patterns are then used to create the eye diagram, one bit pattern at 
a time. Using this procedure, the arbitrary bit stream is reproduced when the 
number of bits and the number of samples are the same values. As the number 
of samples becomes larger, the time to complete this process also increases.
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Viewing All Parameters

In all cases, except when you open the plot window using the Browser, all eye diagram 
parameter plots are displayed. There are eight parameter plots for balanced devices and 12 
parameter plots for single-ended devices. Each of the plots are numbered. The Information 
Bar immediately to the right of the plots lists each plot by number and displays the 
associated parameter. See Figure 7-10.

As noted above, when you open the plot window from the Browser, an empty plot window is 
displayed. View all plots by selecting All from the Parameter Bar or from the Data menu.

Figure 7-10 Balanced Eye Diagram Plots with Information Bar
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Viewing a Single Eye Diagram

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
plots (or with multiple plots if you have a custom plot window displayed), double-click on the 
plot that you would like to view. See Figure 7-11. 

Figure 7-11 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
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Creating a Custom Eye Diagram Plot Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the two TDDxx plots and the two TCCxx plots. To create this 
custom window, open the measured data file in any analysis type. Then, in the Browser, 
select the data type that you want to display the plots. In this example, select Eye Diagram 
(Balanced). A blank plots window is displayed. From the Parameter Bar, click the desired 
parameters (TDD12, TDD21, TCC12, and TCC21 in this example). As each parameter is 
selected, a new plot is added to the plots window. See Figure 7-12.

Figure 7-12 Custom Eye Diagram Plots Window with Four Plots
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Using Cursors
Cursors are used to find specific locations on an eye diagram. Eye diagram plot windows have 
two cursors. Each cursor has both a horizontal (X) and a vertical (Y) indicators which are 
controlled separately. The horizontal indicator displays a thin line in the X-axis from one side 
of the plot to the other. The vertical indicator displays a thin line in the Y-axis from the top of 
the display to the bottom. The horizontal and vertical indicator values are displayed on the 
Information Bar. 

Follow the steps listed below and in Figure 7-13 to display a cursor:

Figure 7-13 Steps to Display the Cursor

1. Select the cursor label (either Cursor 1 or Cursor 2) in the Cursor Bar.
2. Click and drag the X-axis slide control.
3. While dragging the X-axis control slide, watch the X-axis indicator line move across the 

active plot from left to right.
4. Click and drag the Y-axis control slide.
5. While dragging the Y-axis control slide, watch the Y-axis indicator line move up the active 

plot from the bottom toward the top.
6. Note the positions of the X-axis and Y-axis indicators on the Information Bar.
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Display the second cursor as you did the first cursor.

Note the following in Figure 7-14:

1. The second pair of indicator lines in the plot window.
2. The positions of the X-axis and Y-axis indicators for Cursor 2.
3. The difference, the Delta (∆), between the cursors for both the X-axis and Y-axis 

indicators.
Delta = Value of Cursor 2 − Value of Cursor 1

Figure 7-14 Activating a Second Cursor
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Extracting Transmission Line (RLCG) Parameters
The physical layer test system makes 4-port scattering parameter measurements. This data is 
transformed into frequency domain mixed-mode S-parameters in order to view the 
transmission lines as balanced pairs. From the mixed-mode frequency domain data, the 
physical layer test system software extracts the parameters R, L, G, and C and calculates the 
complex propagation constant and complex characteristic impedance. These generated 
transmission line parameters provide the standard transmission line model parameters of 
your device under test for importing into a simulator, such as HSPICE or ADS.

Characteristic impedance and time delay, or series inductance and shunt capacitance, 
completely specify the electrical properties of a lossless transmission line. Propagation 
velocity and length are also required in order to completely specify a physical cable or PC 
board trace. There are times when it is beneficial to think of a transmission line in terms of Zo 
and td and likewise, there are times when thinking in terms of Ctotal and Ltotal is best. While 
the transmission line model used in HSPICE and many other time domain simulators is 
defined by characteristic impedance and time delay, the best way to model a transmission line 
is by using an RLCG type of mode. This method is what the PLTS system offers.

The physical layer test system currently only generates models for two-coupled transmission 
lines (differential transmission lines). When measuring transmission lines, it is important to 
measure just the differential transmission line. This measurement should not include 
discontinuities, such as variations in the width or the thickness, vias, bends in the line, etc. 
Any single-ended launch effects, such as connectors or single ended launches (transmission 
lines), need to be removed (de-embedded) before computing RLCG model parameters. This is a 
more difficult task. Refer to Figure 8-1.

Figure 8-1 Transmission Line Measurement Point
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It is easier to probe the transmission line to be characterized, thus minimizing the “launch” 
effects, assuming that calibration is performed at the probe tips. Ground-Signal- 
Ground-Signal-Ground (GSGSG) probes have given the best results so far. The middle ground 
probe helps to isolate coupling between the two signal probe tips. Refer to Figure 8-2 for an 
example of probing coupled transmission lines using GSGSG probes. 

Figure 8-2 Probing Coupled Transmission Lines Using G-S-G-S-G Probes

The remaining parasitic effects are small and can be ignored (except at higher frequencies). 
Typically, capacitance from each line to the ground block and a small inductance for the vias 
in the ground block as shown in Figure 8-3. 

Figure 8-3 Transmission Line Parasitic Capacitances and Inductances
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Propagation on a Transmission Line
RLCG type models are commonly used in the industry to describe the electrical behavior of 
passive transmission lines. This model is a distributed network of a series resistance and 
inductance with parallel capacitance and conductance (see Figure 8-4). The classical 
transmission line is assumed to consist of a continuous structure of resistors (R), inductors 
(L), capacitors (C), and conductances (G). By studying this equivalent circuit, several 
characteristics of the transmission line can be determined.

Figure 8-4 Lumped Equivalent Model of a Distributed Transmission Line

The different terms included in the model describe the following physical phenomena where 
x is distance and t is time:

R Conductor resistive loss (skin effect + DC loss)

L Inductive part of the circuit resulting from the layout of the conductors and the 
physical properties of the materials.

C Capacitive part of the circuit resulting from the layout of the conductors and 
the physical properties of the materials.

G Dielectric loss
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Propagation on a Transmission Line
If the line is infinitely long and R, L, G, and C are defined per unit length, then

where Zo is the characteristic impedance of the line. A voltage introduced at the generator will 
require a finite time to travel down the line to a point x. The phase of the voltage moving down 
the line will lag behind the voltage introduced at the generator by an amount β per unit 
length. Furthermore, the voltage will be attenuated by an amount α per unit length by the 
series resistance and shunt capacitance of the line. The phase shift and attenuation are 
defined by the propagation constant γ, 

where

α = attenuation in nepers per unit length
β = phase shift in radians per unit length

The velocity at which the voltage travels down the line can be defined in terms of β where:

The velocity of propagation approaches the speed of light, vc, for transmission lines with air 
dielectric. For the general case where εr is the dielectric constant.

The propagation constant γ can be used to define the voltage and the current at any distance x 
down an infinitely long line by the relations:

Since the voltage and the current are related at any point by the characteristic impedance of 
the line:
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Propagation on a Transmission Line
When the transmission line is finite in length and is terminated in a load whose impedance 
matches the characteristic impedance of the line, the voltage and current relationships are 
satisfied by the preceding equations.

RLCG models are frequency-based models (refer to Figure 8-5). Equation set 1 describes the 
most adopted frequency dependencies of RLCG parameters.

Figure 8-5 Loss as a Function of Frequency

These parameters are called fitted parameters.

In the case of a pair of coupled transmission lines, each RLCG parameter is actually a 2×2 
matrix. For symmetrical uniform coupled transmission lines, the matrices are real and 
symmetrical. 

Equation set 1

R RDC RSKIN f+=
L Cons ttan=
G GDC GAC f⋅+=

C Cons ttan=
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Understanding How RLCG Parameters Are Extracted

Coupled-Transmission Line (CPTL) Models

Start with an ideal lossless symmetrical CPTL as shown in Figure 8-6.

Figure 8-6 Lossless Symmetrical Coupled Transmission Line

The Telegraphers set of equations are described in equation sets 2 and 3.

Equation set 2
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Understanding How RLCG Parameters Are Extracted
These equations represent the closest form to the physical behavior of CPTL, since they 
describe each line by its own self parameters (L,C) and the mutual couplings (Lm and Cm). 
Refer to Figure 8-6. Obviously, these equations can be extended for the lossy case, where the 
conductor and dielectric losses would be taken into account.

These parameters will be called self-parameters

By rearranging equation sets 2 and 3, we can define a second set of parameters:

Equation set 3

Equation set 4

Equation set 5
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Understanding How RLCG Parameters Are Extracted
In the general case, RLCG parameters are grouped in 2x2 real matrices, each term being 
frequency-dependent. In the case of symmetrical coupled-lines, these matrices are 
symmetrical:

These parameters are called SPICE-parameters.

Most SPICE-type simulators use this type of model description with different variations in 
the implementation. This aspect is described in more detail in “Exporting Transmission Line 
Data” on page 205.

The third model representation is called Differential-Common Modes Equivalent Model. The 
main reason this model was created is because the current RLCG extraction algorithm deals 
only with single-ended transmission lines (SETL). This model treats each quadrant from the 
mixed-mode S-parameters, in particular the Diff-Diff and Com-Com, as two separate SETL, 
with predefined normalized impedance.

The new set of RLCG parameters extracted for the differential and common modes, can be 
represented in a frequency-dependent matrix format, as shown in Equation set 7.

These parameters are called Diff/Com parameters.

Equation set 6

Equation set 7
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CPTL RLCG Extraction Procedure

The algorithm starts by extracting the RLCG parameters for each of these two modes: 
Diff-Diff and Com-Com. In the case of symmetrical CPTL, mode-conversion should be 
negligible. The Odd Mode and Even Mode, although not displayed, are calculated as interim 
step in extracting the three parameters sets from the Differential and Common modes. Refer 
to Figure 8-7.

Figure 8-7 Extraction Procedure

The following describes the formulas for the different transformations. Equation sets 8 and 9, 
relate the Odd and Even modes to the Differential and Common modes of propagation.

Equation set 8

Equation set 9
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Understanding How RLCG Parameters Are Extracted
Using the propagation constant and the characteristic impedance for the Odd/Even modes, 
the SPICE-parameters can be derived as shown in equation sets 10 through 13.

Equation set 10

Equation set 11

Equation set 12

Equation set 13
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Understanding How RLCG Parameters Are Extracted
RLCG Output Plots

The following individual plots show the extracted RLCG parameters. See Figure 8-8.

Figure 8-8 Extracted RLCG Parameters
Chapter 8192



Extracting Transmission Line (RLCG) Parameters
Understanding How RLCG Parameters Are Extracted
Figure 8-9 illustrates the propagation constant and Figure 8-10 illustrates the characteristic 
impedance in real-imaginary format.

Figure 8-9 Propagation Constant (Unwrapped)

Figure 8-10 Complex Characteristic Impedance
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Viewing Transmission Line Data
This section guides you with opening measured data and viewing the data using transmission 
line (RLCG) parameter extraction. There are eight transmission line parameters for each 
transmission line format. You may elect to view any number of these parameters.

Opening a Transmission Line Plot Window

The transmission line parameters may be viewed in any of four formats (differential, common, 
W-Element, and self/mutual). 

You may open the transmission line plot window in one of four ways.

• From the Startup Wizard immediately before selecting the Measure button where you 
must select the analysis type - see (A) of Figure 8-11

• From the Startup Wizard Welcome Screen by selecting Load Measurement where you 
must select the analysis type - see (A) of Figure 8-11

• From the Open selection in the File menu or the Open icon in the Toolbar where you 
must select the analysis type - see (A) of Figure 8-11

• From the Browser when data is already being viewed in another analysis type by 
selecting one of the RLCG choices - see (B) of Figure 8-11

NOTE Using the Browser method to open a window requires that you select the 
parameters that you want to view from the Parameter Bar or the RLCG 
menu once the blank plot window is displayed after the T-Line parameters are 
defined in the next step.
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Figure 8-11 Opening the Transmission Line Plot Window

The T-Line Characteristics dialog box (Figure 8-12) is then displayed. Enter the length of the 
transmission line (in meters) and the highest measured frequency (in megahertz) and then 
click OK. 

Figure 8-12 T-Line Characteristics Dialog Box

Length (M) can be used to scale extracted values in units/meter.

Highest Extracted Frequency (MHz) defaults to the stop frequency. However, this can be 
set at a lower frequency to better fit your parameters.
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Viewing Transmission Line Data
The individual parameter selections are based on the specific RLCG data analysis type. The 
following lists each data analysis type and its associated parameters. 

RLCG (Differential): Rd, Ld, Cd, Gd, Zor, Zoi, Ad, Bd

RLCG (Common): Rc, Lc, Cc, Gc, Zor, Zoi, Ac, Bc

RLCG (W-Element): R11, L11, C11, G11, R12, L12, C12, G12

RLCG (Self/Mutual): Rs, Ls, Cs, Gs, Rm, Lm, Cm, Gm

where, A represents the Attenuation Constant (α) B represents the Phase Constant (β)

C represents Capacitance G represents Conductance

L represents Inductance R represents Resistance

Z represents Impedance
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Viewing All Parameters

In all cases, except when you open the plot window using the Browser, all eight of the RLCG 
parameter plots are displayed. Each of the plots are numbered. The Information Bar 
immediately to the right of the plots lists each plot by number and displays the associated 
parameter. See Figure 8-13.

As mentioned previously, when you open the plot window from the Browser, an empty plot 
window is displayed. View all eight plots by selecting All from the Parameter Bar or from 
the RLCG menu with New Plot selected.

Figure 8-13 Balanced Frequency Domain Plots with Information Bar
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Viewing a Single RLCG Parameter

Viewing a single plot gives better resolution. To display a single plot, from the window with all 
eight plots (or with multiple plots if you have a custom plot window displayed), double-click on 
the plot that you would like to view. See Figure 8-14. 

Figure 8-14 Opening a Single Plot

Double-click on the single plot to return to the original view with multiple plots.
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Viewing Transmission Line Data
View Multiple Traces on a Single Plot

This single plot may have just one parameter or if you choose, it could contain more. For 
example, you could show how Zord compares with Zoid. To do this double-click on the first plot 
so that is now displaying a single plot similar to Figure 8-14. For this example, Plot 05 (Zord) 
was double-clicked and is displayed as a single plot. With New Trace selected in the 
Parameter Bar (or the RLCG menu), click the remaining parameters (Zoid in this 
example). 

Figure 8-15 A Single Plot with Multiple Traces

It could contain as many as all eight of the parameters. However, this would be impractical 
because having eight parameters on a single plot would be very hard to distinguish between 
the parameters and the vertical scale would have to be large to show all parameters.
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Viewing Transmission Line Data
Creating a Custom RLCG Plot Window

You can also create a plot window with just the plots you desire. For example, you may want 
your plot window to show just the four RLCG plots of RLCG (Differential). To create this 
custom window, open the measured data file in any analysis type. Then, in the Browser, 
select the data type that you want to display the plots. In this example, select RLCG 
(Differential). A blank plots window is displayed. With New Plot selected in the 
Parameter Bar (or the RLCG menu), click the desired parameters (R, L, C, and G in this 
example). As each parameter is selected, a new plot is added to the plots window. See Figure 
8-16.

Figure 8-16 Custom S-Parameter Plots Window with Four Plots
Chapter 8200



Extracting Transmission Line (RLCG) Parameters
Setting the Scale
Setting the Scale
The PLTS software allows you to change the horizontal and vertical scale of the plots using 
the Scaling Bar. 

Figure 8-17 Scaling Bar

Change the Scaling Bar values by:

• Clicking and dragging within a scaling bar entry box to highlight the current value and 
then typing the new value. See (A) of Figure 8-18.

• Selecting the up/down arrow buttons to the right of each entry. See (B) of Figure 8-18.

• Selecting the calculator icon to the right of each entry to display a keypad. Click the 
keypad’s numeric buttons to enter a new value and click the Enter button to save the new 
value. See (C) of Figure 8-18. The scaling calculator icon varies slightly between scaling 
entries meet the requirements of the specific entry.

Figure 8-18 Entering a Scale Value
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Setting the Scale
The horizontal scale is changed by changing the start and stop frequencies in megahertz 
(MHz). Note that you can not extend the start and stop frequencies beyond the start and stop 
frequencies used in the measurement. 

The vertical scale units are changed using the same method as used for the horizontal units. 
The units vary to be appropriate for each plot. For example, when the plot is inductance, the 
units are in Henrys while when a resistive plots is displayed, the units are ohms. 
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Using Cursors
Cursors may be used to find specific locations along the plot. When a cursor is activated, it’s 
marker can be moved to any location along the plot trace. The horizontal and vertical values 
are displayed on the Information Bar. Two cursors are available. 

To display a cursor, click the cursor label (either Cursor 1 or Cursor 2) in the Cursor Bar 
and then click and drag its slide control. While dragging the control slide, watch the marker 
move along the trace in the active plot. Notice that the cursor values are displayed in the 
Information Bar. 

Figure 8-19 Activating a Cursor

You can also change the cursor position, one point at a time, by using the left/right arrow keys 
on the keyboard.
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Using Cursors
Activate the second cursor as you did the first cursor. Notice that both cursor values along 
with the difference, the Delta (∆), between the cursors are displayed in the Information Bar.

Delta = Value of Cursor 2 − Value of Cursor 1

Figure 8-20 Activating a Second Cursor
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Exporting Transmission Line Data
The PLTS can export the transmission line data to the main electronic design automation 
(EDA) software tools used by R&D engineers in the field of signal integrity. These EDA 
simulators are:

• HSPICE
• ADS (Advanced Design System - Integrated Design Software and Test Instrumentation 

solution from Agilent Technologies)

Selecting the Export in the File menu to access the three RLCG export menu selections. A 
brief description and the syntax of each selection is listed in this section. 

Figure 8-21 RLCG Export Menu
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hSpice

The hSpice selection in Figure 8-21 exports the transmission line data to HSPICE as fitted 
parameters in an ASCII file to be used with the W-element Transmission Line model, a 
format available in HSPICE. The syntax is listed below:

File name: Ext_Model.rlc

* RLGC parameters for a 2-conductor lossy
* frequency-dependent lines
* N (number of signal conductors
*********************************
2
* L
*********************************
2.311e-6
4.14e-7   2.311e-6
* C
*********************************
2.392e-11
-5.41e-12   2.392e-11
* R_DC
*********************************
42.5
0    42.5
* G_DC
*********************************
0.000609
-0.0001419    0.000609
* R_AC
*********************************
0.001303
0        0.001303
* G_AC
*********************************
5.242e-13

-1.221e-13   5.242e-13
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ADS Actual Measured Parameters

The second format, Actual Measured Parameters, exports extracted parameters versus 
frequency in an ASCII file for ADS. The format of this file is the ADS discrete file format. The 
syntax is listed below: 

BEGIN DSCRDATA
%INDEX Freqs  Rdd  Ldd  Cdd  Gdd
1, 5, 5.074784114, 5.42871376384E-7, 6.28220297914E-11,2.36737159369E-6
2, 10, 5.64906645339, 5.40149885542E-7, 6.25070940881E-11,3.73474318738E-6
3, 15, 6.07688409858, 5.39555482061E-7, 6.24383086726E-11,5.10211478107E-6

END

ADS ML2CTL Model

The last format, ML2CTL Model, exports fitted parameters in an ASCII file (also the 
discrete file format) to be used with the MultiLayer 2 Coupled Transmission Lines (ML2CTL) 
model. The syntax is listed below:

BEGIN DSCR(RLGC)
! C[i][j]/eps0  L[i][j]/mu0  Rdc[i][j]  Rhf[i][j]/sqrt(f_GHz) 
G[i][j]/omega*eps0
% C(real)  L(real)  Rdc(real)  Rhf(real) G(real)
10.1504 0.330146 0 0 0
-1.97204 0.0928309 0 0 0
-1.97204 0.0928309 0 0 0
10.1504 0.330146 0 0 0
END

Where, eps0 (epsilon) equals the dielectric constant of air, 
mu0 equals the permittivity constant of air,
omega equals 2π × frequency, 
C equals the capacitance,
L equals the inductance,
Rdc equals the DC resistance,
Rhf equals the high frequency resistance, and
G equals the conductance

NOTE You can also use exported measurements in ADS using either CitiFile or 
Touchstone formats.
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Removing Unwanted Effects from the Measurement
To reduce your measurement, analysis, and redesign cycles, the physical layer test system 
offers three techniques to help you define/redefine your device under test (DUT).

Figure 9-1 Ease Versus Accuracy of Removing Unwanted Effects

• Gating provides the ability to remove the effect of a particular circuit element 
mathematically from time-domain plots. The gated section removes a section of the plot 
that you define, replacing it with an ideal transmission line having the same electrical 
delay as the removed section. By observing the original frequency domain response and 
the transformed frequency domain response, the effect of the gating operation on the 
S-parameter data can be seen.

• Port Reference Plane Adjustment (or port reference plane rotation) mathematically 
extends the measurement plane to the DUT, but assumes the fixture looks like a perfect 
transmission line: a flat magnitude response, a linear phase response, and constant 
impedance. Port reference plane adjustments are usually done after a coaxial calibration 
has been performed at the end of the test cables. If the fixture is very well designed, this 
technique may be sufficient.

• De-embedding affords a very accurate technique that removes the effect of added loss, 
phase shift, and mismatch due to adding adapters, probes, and fixtures to your DUT. It 
combines the errors determined from a coaxial calibration with the errors in the fixture to 
obtain a single error coefficient array that corrects for everything up to the measurement 
plane of the DUT. Deembedding uses an accurate linear model of the fixture, or measured 
S-parameter data of the fixture. This modeled or measured data is then mathematically 
removed from the DUT measurement data in post-processing.
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Gating
The controls for gating the time domain response provide the ability to remove the effect of a 
particular circuit element mathematically. You define the start- and stop-points of the gate. 
An ’Ideal’ gate replaces the gated section with an ideal transmission line having the same 
electrical delay as the section that it replaced. 

Up to 10 gates can be added. The gates are numbered sequentially from the left edge of the 
plot to the right edge. For example, the first gate (Gate 1) was added. Then a second gate is 
added to the left of the Gate 1. The gates are then renumbered such that the gate on the left 
(the second gate that was added) becomes Gate 1, and the original gate is changed to Gate 2. 
Either deleting or moving a gate can cause the gates to be renumbered.

By observing the original frequency domain response and the transformed frequency domain 
response, the effect of the gating operation on the S-parameter data can be seen. 

To Add a Gate

1. Click Gating from the Utilities menu. Then click either Gating (Single Ended) or 
Gating (Balanced) depending on whether your Time Domain plot is single-ended or 
balanced.

Figure 9-2 Utilities Menu with Gating Expanded

The Gating Bar (shown in Figure 9-3) and an empty plot window are displayed when 
gating is selected from the Utilities menu.

Figure 9-3 Gating Bar
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Gating
2. From the Parameter Bar (or from the Data menu), select the parameter that will have 
gates added to them. 

When you select the parameter, two plots are displayed in the plots window. Plot 01 is the 
parameter you selected displayed in Time Domain mode. Plot 02 is that same parameter 
displayed in Frequency Domain Mode. See Figure 9-4. When adding a gate to the trace in 
Plot 01, you will also be able to see how adding the gate affects the parameter in the 
Frequency Domain by watching Plot 02.

Figure 9-4 Gating Display: Plot 01 Time Domain, Plot 02 Frequency Domain

3. Click the Start button. 

4. While watching the start gating marker on your time domain plot (Plot 01), move the slide 
control to the right to set the start position of the gate. As the slide control is positioned, 
the time (or distance) of the start gating marker is displayed in the Start box. See Figure 
9-5.
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Gating
Figure 9-5 Setting the Gating Start Position

5. Click Stop button.

6. While watching the gating indicator on your time domain plot (Plot 01), move the slide 
control to the right to set the stop position of the gate.
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Figure 9-6 Setting the Gating Stop Position

7. Click the Add button to add the gate. 

When Add is selected:

• A gate identifier is added to the Gate box to identify the number of the gate that was 
just added. See Figure 9-7.

• In the Time Domain plot (Plot 01), a straight blue line is added between the start and 
stop points to reflect that the measured data is being replaced mathematically with an 
ideal transmission line.

• In the Frequency Domain plot (Plot 02), the red trace shows how the original 
S-parameter looks. The green trace shows how the S-parameter looks when the effects 
of the gate are taken into account.
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Figure 9-7 The Effects of Adding a Gate

8. Repeat Steps 3 through 7 to add additional gates.

The maximum number of gates that can be added is 10.

To Move a Gate

A gate can be moved by selecting the gate from the Gate list and clicking the Move button, 
and moving the slide control left or right to the desired location. Then select the Apply button 
to have the move take affect. The range between the start and stop values of the gate remains 
the same, just the start and stop values are changed. 

To Delete a Gate

A gate can be deleted by selecting the gate from the Gate list and clicking the Delete button. 
The gate numbers are moved down in number when a gate is deleted. For example, when Gate 
4 is deleted, Gate 5 becomes Gate 4, and Gate 6 becomes Gate 5, and so on. 
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To Change the Displayed Gating Plot

The automatically calculated start and stop time values and the DC level (normally 
approximated from the measured data) can be changed. Enter the value change in the Start 
and Stop fields for a change in the start and stop time or in the DC field for a change in the 
DC level and click Apply. The gating plot is then displayed using these changes. To return the 
plot back to it’s original values, click Default.

Figure 9-8 Position Bar for Gating Plots
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Port Reference Plane Adjustment
Adding adapters, fixtures, and probes introduces additional loss, phase shift, and mismatch 
that can add error to the measurement of your DUT. The port reference plane adjustment 
feature allows you to move the calibrated reference plane from the end of the test cable 
toward the DUT in an attempt to eliminate the effects of phase shift introduced by the 
addition of adapters, fixtures, and probes. Port reference plane adjustment does not correct for 
additional loss and mismatch introduced by these items.

Port reference plane adjustment can be adjusted using either of the two methods described in 
this section. Refer to To Adjust Port Reference Plane located below or “To Rotate the 
Reference Plane Using the De-Embedding Dialog Box” on page 218. 

To Adjust Port Reference Plane

The easiest way to adjust the port reference plane is by using the following method:

1. Select Adjust Port Reference Plane from the Utilities menu to open the Adjust Port 
Reference Plane dialog box where you can change the reference plane rotation settings and 
recalculate the displayed data.

Figure 9-9 Adjust Phase Skew Dialog Box

2. Enter the new reference plane values for the desired ports by using the arrows or entering 
the values in the port box directly. 

A positive value rotates the phase towards the DUT (effectively removing a length of 50Ω 
line) and a negative number rotates the phase away from the DUT (effectively adding a 
length of 50Ω line).
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3. Click Apply Rotation to recalculate the data and display the new plots. 

Note that when reference plane rotation is applied, the De-Embedding indicator color 
changes to a bright color. See Figure 9-11 on page 219.

Reset returns the values to zero, recalculates the data, and displays original plots.

To Rotate the Reference Plane Using the De-Embedding Dialog Box

1. Select De-Embedding from the Utilities menu to open the De-Embedding dialog box. 

Use the De-Embedding dialog box to configure DUT reference planes by de-embedding 
probes, fixtures, or adapters from the measured data.

Figure 9-10 De-Embedding Dialog Box

2.  In the Reference Plane area, click Rotate Reference Plane.
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3. Enter a reference plane rotation value (in centimeters-in-air). 

You can use the spinner or click in the cm box and enter a value directly. 

A positive value rotates the phase towards the DUT (effectively removing a length of 50Ω 
line) and a negative number rotates the phase away from the DUT (effectively adding a 
length of 50Ω line).

4. Select the port to assign the rotation value to a port by selecting from the port numbers.

As you select a port, that rotation value is shown below in the information area for that 
port.

5. Repeat steps 3 and 4 until you have assigned rotation values to all appropriate ports.

6. Turn the port reference plane adjustment on by clicking the ON/OFF button (shown in 
Figure 9-10) until the label reads: De-embedding is currently ON for this file

7. Click OK to accept the configuration and exit the dialog box.

 Cancel ignores any changes and exits the dialog box.

The De-Embedding indicator on status bar means that De-embedding is being applied. See 
Figure 9-11.

Figure 9-11 De-Embedding Indicator on the Status Bar
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De-Embedding
Adapters, test fixtures, or other non-DUT structures introduce unwanted effects and error 
into measurement results. These unwanted effects typically include additional loss, phase 
shift, mismatch, discontinuities, and time delay. De-embedding is the process of 
mathematically removing previously characterized performance of the non-DUT structure 
from the measurement in post-processing.

NOTE De-embedding is a powerful utility, but requires advanced S-parameter 
characterization of the non-DUT structure through measurement or modeling. 
While measuring the structure can provide the most accurate characterization, 
it may be difficult or impossible to perform the measurement due to 
connectivity issues. In these cases, S-parameter models may offer the best 
alternative.

After an S-parameter file of the non-DUT structure is created in CitiFile format, it is 
user-modified and saved as an adapter characterization file (with a “.txs” filename extension). 
See “Converting a CitiFile to a PLTS Adapter File” on page 380. At that point, it is ready to be 
used by following the instructions below.

1. Select De-Embedding from the Utilities menu to open the De-Embedding dialog box. 
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Figure 9-12 De-Embedding Dialog Box

2. Click Select Device to De-Embed.

3. Select a de-embedding file (.txs) that you want to use from the de-embedding file list.

4. Select the check box associated with the port to which the file applies. 

5. Click the associated << button to add the file to the port. (Clicking the ✕ button will 
remove the file from the port.)

6. Repeat steps 3 through 5 until you have assigned de-embedding files to all appropriate 
ports.

7. Select all ports that use reverse adapter orientation.

Reverse orientation is noted by check marks for each port specified in the Use Reverse 
Orientation check boxes. Reverse orientation refers to when port 1 of the adapter is 
connected to the DUT. Refer to “Characterizing Adapters” on page 107 for further 
information and instructions on performing adapter characterization.

8. Turn the de-embedding on by clicking the ON/OFF button (shown in Figure 9-12) until the 
label reads: De-embedding is currently ON for this file
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9. Click OK to accept the configuration and exit the dialog box.

 Cancel ignores any changes and exits the dialog box.

The De-Embedding indicator on status bar means that de-embedding is being applied. See 
Figure 9-13.

Figure 9-13 De-Embedding Indicator on the Status Bar
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Part III provides reference information related to operating the physical layer test system.

Chapter 10, “Menu 
Reference”

Provides you with descriptions of each menu bar 
selection in the test system software.

Chapter 11, “Specifications
and Characteristics”

Provides you with the specifications and 
characteristics of the physical layer test system.

Chapter 12, “Test Set 
Front Panel and Rear Panel”

Provides you with specific information regarding each 
test set front panel and rear panel connector, switch, 
fuse, and LED indicator.

Chapter 13, “Troubleshooting 
and Maintenance”

Provides you with information about troubleshooting 
the test system, contacting Agilent for assistance, care 
of test cables and coaxial connectors, and electrostatic 
discharge.

Chapter 14, “Safety and 
Regulatory Information”

Provides you with information that will allow you to 
operate the test system safely. This chapter also lists 
the appropriate information required by regulatory 
agencies.
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Menu Reference
The following menus and each of their selections are described in detail in this chapter. Many 
of these menus are displayed only under specific measurement conditions. Refer to each 
specific menu on the pages listed for selections and conditions.

• File menu on page 227

• Measure menu on page 238

• View menu on page 240

• Utilities menu on page 247

• Tools menu on page 259

• Data menu on page 266

• Format menu on page 269

• RLCG menu on page 271

• Options menu on page 273

• Window menu on page 275

• Help menu on page 276
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File Menu
The File menu provides access to many standard software functions such as creating, 
opening, and saving data, importing and exporting files, printing, and exiting the software.

Figure 10-1 File Menu
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New

Select New from the File menu to start a new measurement process and open the Startup 
Wizard window. 

Figure 10-2 Startup Wizard Window

Open

Select Open from the File menu to load a previously saved file.

Figure 10-3 Open Dialog Box
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Save

Select Save from the File menu to save the current measurement or calibration data. New 
data or imported data may be saved.

Until measurement data is saved, the plot window title bar is labeled PLTS along with the 
analysis type of the plot window and the sequential plow window number. Once the data is 
saved, the PLTS label is replaced with the name of the saved file. Figure 10-4 shows the plot 
window title bar before the data was saved and how it changes to match the file name 
(10M 6G 600PT.dut) after it is saved.

Figure 10-4 Plot Window Title Bar Changes After Data is Saved

Only one unsaved plot window may be open at a time. If you have one unsaved plot window, 
you must either save the data or delete the window before you can open another plot window 
with unsaved data.

Save As…

Select Save As… from the File menu to save new measurement or calibration data or 
existing data as a new file. 

Figure 10-5 Save As Dialog Box
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Import

Select Import from the File menu to import a single-ended measurement data file. Then 
select either CitiFile to import a file in CitiFile format or Touchstone to import a file in 
Touchstone format. Then select from one of the port selections (either Balanced 1324 or 
Balanced 1234) based on the calibration type used with the original measurement.

Figure 10-6 File Menu with Import and CitiFile Expanded

Figure 10-7 Balanced Transform Port Configuration Diagram

CitiFile

CitiFile imports data previously saved in CitiFile (*.cit) format. CitiFiles imported in this 
fashion can be used for comparison with other data sets using trace memory and math 
functions. Refer to Figure 10-7 and choose from one of the following port selections.

Balanced 1324 is used to import single-ended measurement data that has taken with the 
system calibrated using the SOLT calibration.
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Balanced 1234 is used to import single-ended measurement data that has taken with the 
system calibrated using the TRL calibration.

Touchstone

Touchstone imports data previously saved in Touchstone (*.S4P) format. Refer to Figure 10-7 
and choose from one of the following port selections.

Balanced 1324 is used to import single-ended measurement data that has taken with the 
system calibrated using the SOLT calibration.

Balanced 1234 is used to import single-ended measurement data that has taken with the 
system calibrated using the TRL calibration.

Export

Select Export from the File menu to export a file. Then select from the following choices to 
select a specific format: Plots to Clipboard, Plots to Image File, CitiFile, Time Domain, 
Touchstone, RLCG, and Frequency Domain.

Figure 10-8 File Menu with Export Expanded

Plots to Clipboard exports the contents of the current plot window to the Windows 
clipboard.

Plots to Image File exports the contents of the current plot window as an image file. When 
you export it, you may choose from Windows Bitmap (*.BMP), JPEG Bitmap (*.JPG), Targa 
Bitmap (*.TGA), or PaintBrush (*.PCX) formats.
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CitiFile exports the current data in CitiFile format (*.cit).

Time Domain exports the current time domain data in text format (*.txt). It saves a name, 
the parameter and format information in a header. In the body, each X and Y measurement 
coordinate is displayed separated by a comma. These coordinates are bounded by a BEGIN 
and END message.

Touchstone exports the current data in the S4P format which also has the following data 
format choices in which the data may be saved: 

• Magnitude, angle 

• dB, angle (power, angle)

• Real, imaginary

Figure 10-9 File Menu with Export and Touchstone Expanded

RLCG exports the current data in one of two RLCG formats: 

• hSpice exports the RLCG data in a format compatible with HSPICE (a Simulation 
Program with Integrated Circuit Emphasis) software. Refer to “hSpice” on page 206.

• ADS exports the RLCG data in a format compatible with the Agilent Advanced Design 
System (ADS) software format which also has the two following data format choices in 
which the data may be saved:

❏ Actual Measured Parameters exports extracted parameters versus frequency in an 
ASCII file for ADS. Refer to “ADS Actual Measured Parameters” on page 207. 
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❏ ML2CTL exports fitted parameters in an ASCII file to be used with the ADS 
MultiLayer 2 Coupled Transmission Lines (ML2CTL) model. Refer to “ADS ML2CTL 
Model” on page 207.

Figure 10-10 File Menu with Export, RLCG, and ADS Expanded

Frequency Domain exports the data of a single S-parameter (either single-ended or 
balanced) in one of four frequency domain formats: Real/Imaginary, Log Magnitude, Linear 
Magnitude, or Phase. All four formats are exported in tabular format as a text file, each with 
a header. The measured data is bounded by a BEGIN and an END message. The 
Real/Imaginary data of each measured point is exported as comma-separated values. 

Use the Frequency Domain Export dialog box shown in to select the S-parameter (all 
single-ended and balanced S-parameters are listed). Then select the desired format and click 
OK to export the data.
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Figure 10-11 Frequency Domain Export Dialog Box
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Print Setup…

Click the File menu and then click Print Setup to review the printer settings. The Print 
Setup dialog box is displayed. The Print Setup dialog box allows you to select the destination 
printer and its properties, the paper size and printer paper source, additional network 
printers, and choose the orientation of the paper when printed.

Figure 10-12 Print Setup Dialog Box

If you are connected to other networks, click Network… to find additional printers.

Click OK to print the selected plots and return to the program.

Click Cancel to close the dialog box and return to the program without printing.
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Print

Click Print from the File menu to print the selected plots and display the Print dialog box. 
The Print dialog box allows you to select the destination printer and its properties, the range 
of pages to be printed, and the number of copies you wish to print.

Figure 10-13 Print Dialog Box

Click OK to print the selected plots and return to the program.

Click Cancel to close the dialog box and return to the program without printing.
Chapter 10236



Menu Reference
File Menu
Recent Files 

Open any of the four most recently accessed files by clicking the name of the file from this list. 
Only the four most recently accessed files are displayed. 

Figure 10-14 Opening Recently Accessed Files

Exit

Click Exit from the File menu to quit this program.
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The Measure menu allows you to start a measurement, start and stop a continuous sweep 
measurement, and change the stimulus. 

Figure 10-15 Measure Menu

Continuous Sweep

Continuous Sweep sets the system to make measurements as the selected frequency span is 
swept continuously. After each measurement, the displayed data is updated.

To perform a continuous sweep measurement, select Continuous Sweep so that it has a 
check mark on its left side on the Measure menu. With Continuous Sweep active, the Start 
and Stop menu selections control continuous sweep. Select Start to begin a continuous 
measurement and select Stop to stop the measurement.

The Continuous sweep indicator on status bar means that system is currently in the 
continuous sweep mode. See Figure 10-16.

Figure 10-16 Continuous Sweep Indicator on the Status Bar

Start

Start begins a measurement when it is selected. When Continuous Sweep has a check 
mark, Start begins a continuous sweep measurement; otherwise it begins a single sweep 
measurement.

Stop

Stop stops a continuous sweep measurement.
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Stimulus…

Stimulus… opens the Modify Time and Frequency Parameters dialog box so that you can 
change the parameters. Refer to the stimulus information on “Setting Up the Calibrate and 
Measure Parameters” on page 67 for detailed information regarding changing the stimulus 
parameters.
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View Menu
The View menu opens and closes the various tool bars. 

Figure 10-17 View Menu

Toolbar

The Toolbar provides quick access to several File menu features as well as two others. The 
features that are available on the Toolbar are New, Open, Save, Copy, Export Bitmap, 
Remove Plot, Print, and About.

Figure 10-18 Toolbar
Chapter 10240



Menu Reference
View Menu
Status Bar

The Status Bar provides a graphic display of when several features are active. Each feature 
has a label on the left and an indicator just to the right side of the label. When a feature is 
active, the indicator is changed to a bright color. When the feature in not active, the indicator 
is gray.

In addition, the impedance of each test system channel is displayed at the right side of this 
bar.

Figure 10-19 Status Bar

Measurement is bright when a measurement is being performed. 
Continuous sweep is bright when a continuous sweep measurement is being performed.
De-Embedding is bright when de-embedding is applied to the data.
Ref-Z is bright when channel reference impedance is applied to the data.
Hardware is bright when the software recognizes the GPIB-connected hardware.

Browser

The Browser allows selection of data analysis type and the selection of plots to view. 
Selecting a data analysis type (a bold selection) opens a blank plot window for that analysis 
type. Selecting an existing plot (a non-bold selection) makes that plot active and displays it in 
the front of the plot window. 

Data analysis types that have a plot opened have either a “+” or a “-” to the left of the label. 

Select the + to display all plots of that type.
Select the − to collapse and hide all plots of that type.
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Figure 10-20 Browser

Cursors

The Cursors bar allows you to add up to 2 cursors to a plot. Simply select the plot, select the 
cursor button, and click and drag the horizontal scroll bar in the window to move the cursor in 
the plot. The cursor values are displayed on the information bar. See “Information Bar” on 
page 246. The frequency domain Smith Chart and Polar Chart formats allow you to choose 
between magnitude/phase and impedance styles (see “Using Cursors” on page 134). This is 
not available when time domain Gating is enabled.

Figure 10-21 Cursors Bar

Parameter Bar

The Parameter Bar displays each individual parameter for each specific data analysis type 
as well as the capability to display all of the parameters. The time domain, frequency domain, 
and RLCG data analysis types also have the option to allow you to display multiple plots on 
the same plot or separate plots. For Time Domain, Frequency Domain, and Eye Diagram, 
refer to “Data Menu” on page 266 for detailed information. For RLCG, refer to “RLCG Menu” 
on page 271 for detailed information. 
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Figure 10-22 Parameter Bars for Each Data Analysis Type

Gating Bar

The Gating Bar allows you to add up to 10 gates to a time domain plot. Select Gating from 
the Utilities menu to display this bar. After the time domain plot is displayed, slide the 
horizontal control to set the gate’s stop and start position and then press Add to add the gate 
to the plot. Gates may also be deleted and moved from this window. See “Gating” on page 211. 
This is only available when time domain Gating is enabled.

Figure 10-23 Gating Bar

Position Bar

The Position Bar allows you to change the calculated start and stop time values and the DC 
level. Enter the value change in the Start and Stop fields for a change in the start and stop 
time or in the DC field for a change in the DC level and click Apply. The gating plot is then 
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displayed using these changes. To return the plot back to it’s original values, click Default. 
See “To Change the Displayed Gating Plot” on page 216. This is only available when time 
domain Gating is enabled.

Figure 10-24 Position Bar

Format Bar

The Format Bar displays the plot using the format selected from the bar. Format Bar is 
only available for Time Domain and Frequency Domain plots. As shown below, the Time 
Domain Format Bar differs from the Frequency Domain Format Bar. Refer to “Format Menu” 
on page 269 for a detailed description of each format item.

Time Domain Format Bar Frequency Domain Format Bar

For detailed information about each of the 
selections, refer to “Selecting Time Domain 
Display Formats” on page 157.

For detailed information about each of the 
selections, refer to “Selecting Frequency 
Domain Display Formats” on page 128.

Impulse Log Mag

Step Linear Mag

Volts Phase

Real Group Delay

Log Mag Smith Chart

Impedance Polar Chart

ns (nanoseconds) Real

cm (centimeters) Imaginary
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Scaling Bar

Scaling Bar allows you to change the scale of the active plot. There are two different scaling 
bars available. The analysis type determines the scaling bar that is displayed. Eye Diagrams 
do not have an associated scaling bar

Figure 10-25 Scaling Bar
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Information Bar

Information Bar displays a listing of each plot window along with the associated 
parameters for each. If a plot window has multiple traces, all associated parameters are 
listed. In addition, any cursor information is displayed in this area. 

Figure 10-26 Information Bar

Each plot window has either a “+” or a “−” to the left of the label. A long list of information 
may be displayed for each window.

Select the + to display all plot information.
Select the − to collapse and hide all plot information.
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Utilities Menu
The Utilities menu provides access to calibration resources and several enhancement tools 
that you can use to provide a realistic analysis result.

Figure 10-27 Utilities Menu

Calibration

The Calibration selection allows you to either start a calibration or edit the definition of 
mechanical calibration kits. 

Figure 10-28 Utilities Menu with Calibration Expanded

Calibrate

Selecting Calibrate opens the wizard so that you may begin your calibration. Refer to 
Chapter 4, “Calibrating for Measurement Accuracy,” for detailed calibration information.
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Figure 10-29 Calibration Wizard

Edit Cal Kit

The Edit Cal Kit feature gives you flexibility to make changes to your calibration kit 
definition or to add new calibration kits. First, select the calibration type from the Select 
Calibration Type list. Then, from the Cal Kit column, select your calibration kit model 
number to edit an existing kit or select USER_DEF to define a new calibration kit.

Figure 10-30 Select Cal Kit Dialog Box
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The Edit Calibration Kit dialog box allows you to change the calibration kit parameters. The 
USER_DEF selection provides a blank dialog box that you can enter new parameter values. 
Refer to Figure 10-31, “Edit SOLT Calibration Kit Dialog Box” and Figure 10-32, “Edit TRL 
Calibration Kit Dialog Box.”

Figure 10-31 Edit SOLT Calibration Kit Dialog Box
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Refer to “Defining a TRL Calibration Kit” on page 96 for information on defining a TRL 
calibration kit.

Figure 10-32 Edit TRL Calibration Kit Dialog Box
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De-Embedding

Select De-Embedding from the Utilities menu to open the De-Embedding dialog box. Use 
the De-Embedding dialog box to configure DUT reference planes by de-embedding probes, 
fixtures, or adapters from the measured data.

Figure 10-33 De-Embedding Dialog Box

Select the reference plane rotation using one of the following methods: 

• Reference Plane

You can use the Adjust Port Reference Plane selection in the Utilities menu (see 
“Adjust Port Reference Plane” on page 253) or you can use this method of adjusting the 
reference plane.

1. Click Rotate Reference Plane.

2. Enter a reference plane rotation value (in centimeters-in-air). 

A positive value rotates the phase towards the DUT (effectively removing a length of 
50Ω line) and a negative number rotates the phase away from the DUT (effectively 
adding a length of 50Ω line).

3. Select the port to assign the rotation value.
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4. Repeat steps 2 and 3 until you have assigned rotation values to all appropriate ports.

5. Make sure that De-embedding is on. If the OFF button is displayed, click it to turn 
de-embedding on.

• Remove Device or Component Effects

1. Click Select Device to De-Embed.

2. Select a de-embedding file (.txs) that you want to use from the drop-down box.

3. Select the check box associated with the port to which the file applies. 

4. Click the associated << button to add the file to the port. (Clicking the ✕ button will 
remove the file from the port.)

5. Repeat steps 2 through 4 until you have assigned de-embedding files to all appropriate 
ports.

6. Select all ports that use reverse orientation.

Reverse orientation is noted by check marks for each port specified in the Use Reverse 
Orientation check boxes.

7. Make sure that de-embedding is on. If the OFF button is displayed, click it to turn 
de-embedding on.

Click OK to accept the configuration and exit the dialog box or Cancel to ignore any changes 
and exit the dialog box.

De-embedding files hold information about the ports on the fixture that you are 
de-embedding, and match the connectors during de-embed setup. If you try to specify a fixture 
connection that cannot be made, the software warns you.

NOTE Port connectors are defined by the cal kits assigned to them in the Calibration 
Kit Selection dialog box.

The De-Embedding indicator on status bar means that is being applied. See Figure 10-34.

Figure 10-34 De-Embedding Indicator on the Status Bar
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Adjust Port Reference Plane

Select Adjust Port Reference Plane from the Utilities menu to open the Adjust Port 
Reference Plane dialog box where you can change the reference plane rotation settings and 
recalculate the displayed data.

Enter the new reference plane rotation values for the desired ports by using the arrows or 
entering the values in the port box directly. A positive value rotates the phase towards the 
DUT (effectively removing a length of 50Ω line) and a negative number rotates the phase 
away from the DUT (effectively adding a length of 50Ω line).

Click Apply Rotation to recalculate the data and display the new plots. Reset returns the 
values to zero, recalculates the data, and displays original plots.

Figure 10-35 Adjust Port Reference Plane Dialog Box

Note that when reference plane is applied, the De-Embedding indicator color changes to a 
bright color. See Figure 10-34.

Channel Reference Impedance

Select Channel Reference Impedance from the Utilities menu to open the Channel 
Reference Impedance dialog box. By default, all four ports are set to a resistive 50Ω 
impedance. Enter new reference impedances in the port boxes as desired. 
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Figure 10-36 Channel Reference Impedance Dialog Box

This feature does not affect the impedance presented to the DUT by the system hardware. 
Rather, it mathematically transforms the measured data to show how the performance of a 
linear device would change in a non-50Ω measurement system. Impedance transforms can be 
specified either before or after measurement. Only the current data set is affected.

The reference impedance can only be specified as a resistive circuit.

Differential reference impedances are additive. For example, specifying a reference 
impedance of 125Ω on port 1 and 125Ω on port 3 corresponds to a differential-mode reference 
impedance of 250Ω on balanced port one. Likewise, the common-mode reference impedances 
are the parallel equivalent impedance.

Click Set All Ports to 50 ohms (Resistive) to return to the default configuration.

Click OK to accept the configuration and exit the dialog box or Cancel to ignore any changes 
and exit the dialog box.

The Ref-Z indicator on status bar means that the current data has been modified for a 
non-50Ω reference impedance for at least one port. See Figure 10-37.

Figure 10-37 Channel Reference Impedance (Ref-Z) Indicator on the Status Bar

Characterize Adapter

Adapters used in measurements and calibration must be characterized to ensure accurate 
results. The Physical Layer Test System software has a wizard that steps you through this 
adapter characterization process. Select Characterize Adapter from the Utilities menu to 
start the Custom Adapter Characterization Wizard.
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Figure 10-38 Custom Adapter Characterization Wizard

A short/open/load calibration is performed directly at the network analyzer front panel test 
port with out any cables. Then the calibration is repeated with the adapter inserted. The 
resulting adapter S-parameters are saved in Citifile format, which can later be de-embedded 
from the device measurement. 

To allow for best interpolation of adapters used in broadband measurements, characterize the 
adapter over the entire frequency range of the system with as many points as possible.

Your adapters must have an orientation, forward and reverse directions. Mark the connectors 
on the adapter as ports 1 and 2. Forward orientation has the lower-numbered adapter port 
connected to the test-set port.

Refer to “Characterizing Adapters” on page 107 for detailed instructions on performing 
adapter characterization.
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Gating

Gating the time domain response provides the ability to mathematically remove the effect of a 
particular circuit element. By observing the original frequency domain response and the 
transformed frequency domain response, the effect of the gating operation on the S-parameter 
data can be seen. Refer to “Gating” on page 211 for additional information.

Click Gating from the Utilities menu. Then click either Gating (Single Ended) or Gating 
(Balanced) depending on whether your Time Domain plot is single-ended or balanced.

Figure 10-39 Utilities Menu with Gating Expanded

Gating (Single Ended)

Select Gating (Single Ended) when you are planning to gate a single-ended Time Domain 
plot.

Gating (Balanced)

Select Gating (Balanced) when you are planning to gate a balanced Time Domain plot.
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Data Sharing

Data Sharing is used to overlay the plot of one measurement over the plot of another so that 
differences and similarities between the two plots can easily be viewed.

The plots must have the same number of points to be shared.

The plot in Figure 10-40 shows a TDD21 plot in the time domain mode. The same plot with 
de-embedding and channel reference impedance applied will be data shared with this plot.

Figure 10-40 A Plot Before Data Sharing is Used

Figure 10-41 shows the file with de-embedding and channel reference impedance applied 
being selected from the list of open files. The TDD21 parameter is also selected from the 
Parameter list.
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Figure 10-41 Data Sharing

When the Show button on the Data Sharing bar is clicked, the new files TDD21 plot is 
overlaid on the original plot where it is very easy to see differences.

Figure 10-42 Two Plots Compared with Data Sharing
Chapter 10258



Menu Reference
Tools Menu
Tools Menu
The Tools menu allows access to the Math, Bit Pattern, and T-Line Characteristics features. 
It also allows you to launch the startup wizard.

Figure 10-43 Tools Menu

Math

The Math feature allows you to design and save a mathematical formula and to apply that 
formula to compare measured parameters. For example, you could use the math feature to 
determine noise immunity on a balanced line by calculating the common mode rejection ratio 
(CMRR) using the following equation:

You could also characterize the loss of a single-ended frequency domain measurement using 
the following equation:

Figure 10-44 Tools Menu with Math Expanded

CMRR SDD21( ) SCC21( )⁄=

Loss
1

2
------- S21 jS31+( )=
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Design

To create a formula for use with the measured data, select Design from the Math choice of 
the Tools menu. Select either SE (single-ended) or Bal (balanced) in the Data area. Click the 
Formula box to begin entering the equation. Then using the buttons in the Functions, 
Data, and Key Pad areas, enter your equation from left to right. When you have finished 
entering the equation, enter a name in the Variable Name box and click the Save button. 
When you have finished inputting equations, click the OK button.

The Functions area contains mathematical functions, terms, and operators. The Data area 
contains the applicable parameters for the analysis type. The Key Pad area contains 
numerals and simple operators (numbers 0-9 and symbols for decimal, equals, addition, 
subtraction, multiplication, and division). 

Figure 10-45 Create Formulas Dialog Box

Apply

To apply a formula to the active data, display the Choose Variable Traces to Display dialog box 
by selecting Apply from the Math choice of the Tools menu. Then select the formula name 
from those displayed in the list. Click the Apply button to apply the formula to the active 
data and display a trace showing the data with the formula applied. 

Remove removes the selected formula from the active data and removes the trace shown 
when Apply was clicked. Delete removes the selected variable from the list in the dialog box. 
Exit closes the dialog box. 
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Figure 10-46 Choose Variable Traces to Display Dialog Box

Bit Pattern

The Bit Pattern feature allows you to design a digital pattern and save the pattern. Then you 
can apply the digital pattern to eye diagram plots.

Figure 10-47 Tools Menu with Bit Pattern Expanded

Design

Select Design from the Bit Pattern choice in the Tools menu to design a digital pattern 
using the Digital Pattern Generator. The Digital Pattern Generator allows you to create a 
pattern of between 8 and 32 bits. You may create the pattern in one of two ways, either 
clicking the numbered keys (0 to 31) or by typing the numeric value in either Binary (base 2), 
Octal (base 8), or Hexadecimal (base 16) formats. As you enter the pattern inputs, the pattern 
is displayed in the upper portion of the Bit Representation area.
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Figure 10-48 Digital Pattern Generator

After the pattern has been created and is displayed correctly, save the pattern by entering a 
pattern name in the Save Pattern box and values in the Rise/Fall Time (pS), Data Rate 
(Gb/s), and Pattern Length boxes. Then select OK to save the digital pattern.

Apply

Apply a digital pattern to an eye diagram using the Choose a Digital Pattern for Eye 
Generation dialog box. This dialog box also allows you to change the values for the rise/fall 
time, data rate, pattern length, and number of patterns (arbitrary bitstream only). A digital 
pattern must be applied to view data using the eye diagram data analysis type.

Figure 10-49 Choose a Digital Pattern for Eye Generation Dialog Box
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After clicking a digital pattern in the Choose a Digital Pattern for Eye Generation dialog box 
list, review the digital pattern parameter entries on the right side of the dialog box and enter 
the desired parameter values.

• Rise/Fall Time (pS) is the time that it takes a signal to transition from a low to a high 
condition (or the time that it takes a signal to transition from a high to a low condition). 
Refer to Figure 7-6 on page 171 for additional information regarding transition time.

• Data Rate (Gb/s) is the speed that data is transferred over a circuit or a communications 
line. Refer to Figure 7-6 on page 171 for additional information regarding data rate.

• Pattern Length (bits) is the number of bits in the digital pattern used to create the eye 
diagram. This value is the limiting factor in creating unique digital patterns. The number 
of bits allowed between 8 and 32. Where B is the number of bits entered, the number of 
unique bit patterns is: 2B − 2. If B = 32 (the maximum number of allowable bits), the then 
4.29×109 unique bit patterns are generated.

• Number of Patterns (active only when Arbitrary Bitstream is selected) is used to 
indicate the number of unique bit patterns to use in creating the eye diagram. This value 
must be equal or less than the number of unique bit patterns determined by the pattern 
length entry.

Then, click OK to view the eye diagram in the plot window. Cancel closes the dialog box 
without making any changes.

For additional information regarding Arbitrary Bitstream, refer to “Arbitrary Bitstream” on 
page 174.

NOTE You may change the digital pattern using the dialog box shown in Figure 10-49 
by selecting Bit Pattern then Apply… from the Tools menu.

T-Line Characteristics

T-Line Characteristics displays the RLCG data analysis T-Line Characteristics dialog box. 
This is the same dialog box that is displayed when any RLCG analysis is selected. Enter the 
length of the transmission line (in meters) and the highest frequency (in megahertz) in this 
dialog box to change the existing transmission line characteristics.
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Menu Reference
Tools Menu
Figure 10-50 T-Line Characteristics

Launch Startup Wizard

When Launch Startup Wizard is selected, this menu choice starts the Physical Layer 
Test System Startup Wizard. See Figure 10-51.

Figure 10-51 Startup Wizard
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Menu Reference
Tools Menu
Set Velocity Factor

When Set Velocity Factor is selected from the Tools menu, the dialog box shown in Figure 
10-52 is displayed. Enter the new velocity factor in the Current Velocity Factor box and 
click OK. The maximum allowable value is 1.000000.

Figure 10-52 Set Velocity Factor Dialog Box

Time Domain Window…

When Time Domain Window… is selected from the Tool menu, the Time Domain Window 
dialog box is displayed (see Figure 10-53). This dialog box allows you to set the Time Domain 
Window setting to one of three levels, Maximum (the default value), Normal, and 
Minimum. See “Time Domain Windowing” on page 147 for additional information.

Figure 10-53 Time Domain Window Dialog Box

• Maximum gives the minimum sidelobes and this provides the greatest dynamic range. 
This is the default setting.

• Normal gives reduced sidelobes and is normally the most useful.

• Minimum is essentially no window and therefore give the highest sidelobes.

OK closes the dialog box. Cancel closes the dialog box without making changes.
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Data Menu
Data Menu
The Data menu displays each individual parameter for each specific data analysis type as 
well as the capability to display all of the parameters. The time domain and frequency domain 
data analysis types also have the option to allow you to display multiple plots on the same plot 
or separate plots. Figure 10-54 shows each of the data menus and their selections. See also 
“Parameter Bar” on page 242.

Figure 10-54 Data Menu

Individual Parameter Selections

The individual parameter selections are based on the specific data analysis type. The 
following lists each data analysis type and its associated parameters:

• Time Domain (Balanced)

TDD11, TDD12, TDD21, TDD22, TDC11, TDC12, TDC21, TDC22, 
TCD11, TCD12, TCD21, TCD22, TCC11, TCC12, TCC21, TCC22 
Chapter 10266
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Data Menu
• Time Domain (Single Ended)

T11, T12, T13, T14, T21, T22, T23, T24, T31, T32, T33, T34, T41, T42, T43, T44

• Frequency Domain (Balanced)

SDD11, SDD12, SDD21, SDD22, SDC11, SDC12, SDC21, SDC22, 
SCD11, SCD12, SCD21, SCD22, SCC11, SCC12, SCC21, SCC22 

• Frequency Domain (Single Ended)

S11, S12, S13, S14, S21, S22, S23, S24, S31, S32, S33, S34, S41, S42, S43, S44

• Eye Diagram (Balanced)

TDD12, TDD21, TDC12, TDC21, TCD12, TCD21, TCC12, TCC21

• Eye Diagram (Single Ended)

T12, T13, T14, T21, T23, T24, T31, T32, T34, T41, T42, T43

All

Selecting All displays: 

• All 16 of the time domain parameters if the active plot window is a time domain window.

— If New Plot is chosen, selecting All displays all 16 of the parameters on individual 
plots in one window.

— If New Trace is chosen, selecting All displays all 16 of the parameters on a single plot.

• All 16 of the frequency domain parameters if the active plot window is a frequency domain 
window.

— If New Plot is chosen, selecting All displays all 16 of the parameters on individual 
plots in one window.

— If New Trace is chosen, selecting All displays all 16 of the parameters on a single plot.

• All 8 of the eye diagram parameters if the active plot window is a balanced eye diagram 
window.

• All 12 of the eye diagram parameters if the active plot window is a single-ended eye 
diagram window.
Chapter 10 267



Menu Reference
Data Menu
New Plot

When New Plot is chosen, selecting any of the time or frequency domain parameters will 
display a new plot with that parameter within the active plots window. If New Plot is chosen, 
selecting All displays all 16 of the time or frequency domain parameters on individual plots in 
one window. 

New Trace

When New Trace is chosen, selecting any of the time or frequency domain parameters will 
display a new trace within the active plot. If New Trace is chosen, selecting All displays all 
16 of the time or frequency domain parameters on a single plot.
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Format Menu
Format Menu
There are two versions of the Format menu, one for active displays in the time domain and 
another for active displays in the frequency mode. The Format menu is not displayed for 
displays in other modes. See also “Format Bar” on page 244.

Time Domain Format Menu

Figure 10-55 Format Menu for Time Domain Measurements

Impulse Sets the active time domain plot to show the response with an impulse 
stimulus. This is the default setting.

Step Sets the active time domain plot to show the response with a step-voltage 
stimulus.

Volts Sets the active time domain plot’s vertical axis to Volts mode.

Real Sets the active time domain plot’s vertical axis to Real mode. This is the 
default setting. 

Log Mag Sets the active time domain plot’s vertical axis to Log Mag mode.

Impedance Sets the active time domain plot’s vertical axis to impedance mode. Active 
only for reflection plots with a step stimulus.

ns Sets the active time domain plot’s horizontal axis to nanoseconds (ns). 
This is the default setting.

cm Sets the active time domain plot’s horizontal axis to centimeters (cm).
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Menu Reference
Format Menu
Refer to “Selecting Time Domain Display Formats” on page 157 for more information.

Frequency Domain Format Menu

Figure 10-56 Format Menu for Frequency Domain Measurements

Refer to “Selecting Frequency Domain Display Formats” on page 128 for more information.

Log Mag Displays the active frequency domain plot in Log Magnitude format. This 
is the default setting.

Linear Mag Displays the active frequency domain plot in Linear Magnitude format.

Phase Displays the active frequency domain plot in Phase format.

Group Delay Displays the active frequency domain plot in Group Delay format.

Smith Chart Displays the active frequency domain plot in Smith Chart format.

Polar Chart Displays the active frequency domain plot in Polar Chart format.

Real Displays the active frequency domain plot in Real format.

Imaginary Displays the active frequency domain plot in Imaginary format.
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RLCG Menu
RLCG Menu
When any of the RLCG data analysis types are selected, the RLCG menu is displayed. Each 
of the four RLCG data analysis types has its own menu. Refer to Figure 10-57.

Figure 10-57 RLCG Menus

Individual Parameter Selections

The individual parameter selections are based on the specific RLCG data analysis type. The 
following lists each data analysis type and its associated parameters. 

RLCG (Differential): Rd, Ld, Cd, Gd, Zor, Zoi, Ad, Bd

RLCG (Common): Rc, Lc, Cc, Gc, Zor, Zoi, Ac, Bc

RLCG (W-Element): R11, L11, C11, G11, R12, L12, C12, G12

RLCG (Self/Mutual): Rs, Ls, Cs, Gs, Rm, Lm, Cm, Gm

where, A represents the Attenuation Constant (α) B represents the Phase Constant (β)

C represents Capacitance G represents Conductance

L represents Inductance R represents Resistance

Z represents Impedance
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RLCG Menu
All

If New Plot is chosen, selecting All displays all eight parameters on individual plots in one 
window. If New Trace is chosen, selecting All displays all eight parameters on a single plot.

New Plot

When New Plot is chosen, selecting any of the RLCG parameters will display a new plot with 
that parameter within the active plots window. If New Plot is chosen, selecting All displays 
all eight parameters on individual plots in one window. 

New Trace

When New Trace is chosen, selecting any of the RLCG parameters will display a new trace 
within the active plot. If New Trace is chosen, selecting All displays all eight parameters on 
a single plot.
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Options Menu
Options Menu
The Options menu provides access to the User Preferences dialog box

Figure 10-58 Options Menu

User Preferences

The User Preferences dialog box allows you to customize your Physical Layer Test System 
software. This dialog box has the following three tabs to choose from: General, 
Measurement, and Load/Save.

Figure 10-59 User Preferences Dialog Box

General

The General tab (see Figure 10-59) has the following choices:

• Perform Setup - when selected, the PLTS software, when it is next started, will operate 
as if it has just been installed and go through a complete setup routine. At the conclusion 
of this routine, the Perform Setup option is automatically turned off.

• Display feedback during operations - controls the display of informational and 
progress windows for various operations, such as the file conversion summary window and 
the measurement post-processing progress window. When selected, these windows are 
displayed; otherwise, these windows are hidden. This option’s default setting is ON. 
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Options Menu
• Show Startup Wizard at startup - when selected, the startup wizard is displayed each 
time the software is started. This option’s default setting is ON.

Measurement

The Measurement tab (see Figure 10-59) has the following choices:

• Beep when measurement is complete - when checked, the PC emits a beep to indicate 
that the measurement is complete.

• Show warning before uncalibrated measurements - when checked, a message is 
displayed confirming that you are making an uncalibrated measurement.

Load/Save

The Load/Save tab (see Figure 10-59) has the following choices:

• Save data in BMS Format - when checked, data is saved in Balanced Measurement 
System format.
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Window Menu
Window Menu
The Window menu provides an efficient method of working with analysis windows. It gives 
you the ability to add new analysis windows, arrange open analysis windows for optimum 
viewing, arrange the minimized analysis window icons, and select/display individual analysis 
windows.

Figure 10-60 Window Menu

New Window

New Window adds a new analysis window to the display area. The new window will display 
the analysis type that is currently selected.

List of Open Analysis Windows

The Window menu also lists the open analysis windows below the standard Window menu 
selections. Each open analysis window is listed in the order they were opened with the most 
recent window listed at the bottom. The active analysis window is shown with a check mark 
displayed at its left side. Selecting a window from the list displays the window in the display 
area.

Figure 10-61 List of Open Data Analysis Windows
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Help Menu
Help Menu
The Help menu provides access to information about the software.

Figure 10-62 Help Menu

Help…

The Help… selection displays the user’s guide (this manual) in pdf format.

About PLTS…

The About PLTS… window displays the software version information.

Figure 10-63 About PLTS… Window
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Specifications and Characteristics
Definitions
Definitions
All specifications and characteristics apply over a 25 °C ±5 °C range (unless otherwise stated) 
and 90 minutes after the instrument has been turned on.

Specification (spec.) Warranted performance. Specifications include guard bands to 
account for the expected statistical performance distribution, 
measurement uncertainties, and changes in performance due to 
environmental conditions.

Characteristic (char.) A performance parameter that the product is expected to meet 
before it leaves the factory, but that is not verified in the field 
and is not covered by the product warranty. A characteristic 
includes the same guard bands as a specification.

Typical (typ.) Expected performance of an average unit which does not 
include guard bands. It is not covered by the product warranty.

Nominal (nom.) A general, descriptive term that does not imply a level of 
performance. It is not covered by the product warranty.

Calibration The process of measuring known standards to characterize the 
system's systematic (repeatable) errors.

Corrected (residual) Indicates performance after error correction (calibration). It is 
determined by the quality of calibration standards and how 
well “known” they are, plus system repeatability, stability, and 
noise.

Uncorrected (raw) Indicates instrument performance without error correction. The 
uncorrected performance affects the stability of a calibration.
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Specifications and Characteristics
N1947A and N1948A Electrical Specifications and Characteristics
N1947A and N1948A Electrical Specifications and 
Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and +10 dBm maximum output power. The dynamic range is the difference 
between the rms noise floor and the maximum output power.

Network Analyzer: Agilent E8803A Option 014 (N1947A System)

Agilent E8358A Option 015 (N1948A System)

Test Set: Agilent N4417A Option 103 (N1947A System)

Agilent N4417A Option 104 (N1948A System)

Calibration Kit: Agilent 85052C Precision 3.5 mm

Test Port Cables: Agilent N4417A Option B20

Calibration Technique: Four-Port SOLT

Table 11-1 System Dynamic Range

Frequency Range Specification

300 kHz to 1.3 GHz 120 dBa

a. May be limited to 100 dB at particular frequencies below 750 MHz due to spurious 
receiver residuals.

1.3 GHz to 3.0 GHz 120 dB

3.0 GHz to 6.0 GHz 108 dB

6.0 GHz to 9.0 GHz 103 dB
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Specifications and Characteristics
N1947A and N1948A Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 11-2 Measurement Port Characteristics

Description Characteristic

300 kHz
to

1.3 GHz

1.3 GHz
to

3.0 GHz

3.0 GHz
to

6.0 GHz

6.0 GHz
to

9.0 GHz

Directivity 50 dB 47 dB 42 dB 40 dB

Source Match 42 dB 42 dB 38 dB 35 dB

Load Match 50 dB 47 dB 42 dB 40 dB

Reflection Tracking ± 0.006 dB ± 0.007 dB ± 0.009 dB ± 0.015 dB

Transmission Tracking ± 0.012 dB ± 0.015 dB ± 0.040 dB ± 0.060 dB
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Specifications and Characteristics
N1947A and N1948A Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the N1947A and N1948A systems.

Figure 11-1 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure 11-2 3.5 mm Reflection Magnitude and Phase Uncertainty
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Specifications and Characteristics
N1947A and N1948A Electrical Specifications and Characteristics
Test Set Performance

Power Supply

The power supply requirements for the test sets are listed below. 

Table 11-3 Test Set Performance

Description Specification Supplemental 
Information

Frequency Range 300 kHz to 9.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler In 4.5 dB maximum

Port 2 to A In and Port 4 to B In 8.5 dB maximum

A In to A Out and B In to B Out 8.0 dB maximum

Isolation (port to port and A to B) ≥ 105 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typ.)

Test Port Connectors 50-ohm Type-N 
Connectors (nom.)

Table 11-4 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 120 Volts 
220 to 250 Volts

Frequency Range 47 to 62 Hertz

Power 40 VA
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Specifications and Characteristics
N1951A Electrical Specifications and Characteristics
N1951A Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and +5 dBm maximum output power. The dynamic range is the difference 
between the rms noise floor and the maximum output power.

Network Analyzer: Agilent 8720ES Option H32

Test Set: Agilent N4418A

Calibration Kit: Agilent 85052C Precision 3.5 mm

Test Port Cables: Agilent N4418A Option B20

Calibration Technique: Four-Port SOLT

Table 11-5 System Dynamic Range

Frequency Range Specification

50 MHz to 840 MHz 77 dB

840 MHz to 20.0 GHz 90 dB
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Specifications and Characteristics
N1951A Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 11-6 Measurement Port Characteristics

Description Characteristic

50 MHz
to

2.0 GHz

2.0 GHz
to

8.0 GHz

8.0 GHz
to

20.0 GHz

Directivity 48 dB 48 dB 43 dB

Source Match 41 dB 41 dB 38 dB

Load Match 48 dB 48 dB 43 dB

Reflection Tracking ± 0.005 dB ± 0.005 dB ± 0.008 dB

Transmission Tracking ± 0.014 dB ± 0.014 dB ± 0.035 dB
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Specifications and Characteristics
N1951A Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the N1951A system.

Figure 11-3 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure 11-4 3.5 mm Reflection Magnitude and Phase Uncertainty
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Specifications and Characteristics
N1951A Electrical Specifications and Characteristics
Test Set Performance

Power Supply

The power supply requirements for the test sets are listed below. 

Table 11-7 Test Set Performance

Description Specification Supplemental 
Information

Frequency Range 50 MHz to 20.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss 8 to 10 dB

Isolation (port to port) ≥ 85 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typ.)

DC Bias Range 
(Option UNK only)

40 VDC, 500 mA

Test Port Connectors 3.5 mm (m) Connectors

Table 11-8 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 120 Volts 
220 to 250 Volts

Frequency Range 47 to 62 Hertz

Power 40 VA
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Specifications and Characteristics
N1953A Electrical Specifications and Characteristics
N1953A Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −5 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

Network Analyzer: Agilent E8362A Option 014 UNL

Test Set: Agilent N4419A

Calibration Kit: Agilent 85052D 3.5 mm

Test Port Cables: Agilent N4419A Option B20

Calibration Technique: Four-Port SOLT

Table 11-9 System Dynamic Range

Frequency Range Specification

45 MHz to 500 MHz 70 dB

500 MHz to 2.0 GHz 100 dB

2.0 GHz to 10.0 GHz 100 dB

10.0 GHz to 20.0 GHz 85 dB
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N1953A Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 11-10 Measurement Port Characteristics

Description Characteristic

45 MHz
to

2.0 GHz

2.0 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

Directivity 56 dB 42 dB 40 dB

Source Match 42 dB 36 dB 33 dB

Load Match 56 dB 42 dB 40 dB

Reflection Tracking ± 0.0015 dB ± 0.009 dB ± 0.013 dB

Transmission Tracking ± 0.020 dB ± 0.032 dB ± 0.050 dB
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Specifications and Characteristics
N1953A Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the N1953A system.

Figure 11-5 3.5 mm Transmission Magnitude and Phase Uncertainty

Figure 11-6 3.5 mm Reflection Magnitude and Phase Uncertainty
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Specifications and Characteristics
N1953A Electrical Specifications and Characteristics
Test Set Performance
Table 11-11 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 45 MHz to 20.0 GHz 

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 5.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 20.0 GHz 18 to 25 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

8.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 20 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50-ohm 3.5 mm 
Connectors (nom.)
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Specifications and Characteristics
N1953A Electrical Specifications and Characteristics
Power Supply

The power supply requirements for the test sets are listed below. 

Table 11-12 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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Specifications and Characteristics
N1957A Electrical Specifications and Characteristics
N1957A Electrical Specifications and Characteristics

The following specifications are applicable for a system in the following configurations:

System Dynamic Range

The test port transmission measurements are valid at 10 Hz IF bandwidth with four-port 
error correction and −17 dBm default maximum output power. The dynamic range is the 
difference between rms noise floor and the output power.

Network Analyzer: Agilent E8364B Options 014 and 711

Test Set: Agilent N4421A

Calibration Kit: Agilent 85056A 2.4 mm

Test Cables: Agilent N4421A-B20

Calibration Technique: Four-Port SOLT

Table 11-13 System Dynamic Range

Frequency Range Specification

45 MHz to 500 MHz 55 dB

500 MHz to 10.0 GHz 70 dB

10.0 GHz to 20.0 GHz 70 dB

20.0 GHz to 50.0 GHz 55 dB
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Specifications and Characteristics
N1957A Electrical Specifications and Characteristics
Measurement Port

Residual uncertainties for corrected data using four-port error correction. These apply for 
25 °C with less than 1 °C variation from calibration.

Table 11-14 Measurement Port Characteristics

Description Characteristic

45 MHz
to

0.5 GHz

0.5 GHz
to

10.0 GHz

10.0 GHz
to

20.0 GHz

20.0 GHz
to

50.0 GHz

Directivity 43 dB 39.5 dB 39 dB 33 dB

Source Match 38 dB 34 dB 34 dB 27 dB

Load Match 43 dB 39.5 dB 39 dB 33 dB

Reflection Tracking ± 0.001 dB ± 0.002 dB ± 0.008 dB ± 0.026 dB

Transmission Tracking ± 0.015 dB ± 0.020 dB ± 0.040 dB ± 0.20 dB
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Specifications and Characteristics
N1957A Electrical Specifications and Characteristics
Measurement Uncertainties

The following graphics show the worst case transmission and reflection magnitude and phase 
uncertainty for the N1957A system.

Figure 11-7 2.4 mm Transmission Magnitude and Phase Uncertainty

Figure 11-8 2.4 mm Reflection Magnitude and Phase Uncertainty
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Specifications and Characteristics
N1957A Electrical Specifications and Characteristics
Test Set Performance
Table 11-15 Test Set Performance

Description Characteristics Supplemental 
Information

Frequency Range 45 MHz to 50.0 GHz 

Transition Time 
(10 to 90%, TR=.72/BW)

14 ps

Impedance 50 Ohms (nom.)

Insertion Loss

Source Out to Coupler Thru 12.0 dB maximum

Port 2 to Rcvr A In and 
Port 4 to Rcvr B In

45 MHz to 1.0 GHz 18 to 45 dB (typical)

1.0 GHz to 50.0 GHz 16 to 26 dB (typical)

Rcvr A In to Cplr Arm and 
Rcvr B In to Cplr Arm

15.0 dB maximum

Isolation (port to port)

45 MHz to 200 MHz ≥ 70 dB

200 MHz to 50 GHz ≥ 90 dB

Maximum Operating Level +20 dBm

Damage Level +30 dBm (typical)

Test Port Connectors 50-ohm 2.4 mm (m) 
Connectors (nom.)
Chapter 11 295



Specifications and Characteristics
N1957A Electrical Specifications and Characteristics
Power Supply

The power supply requirements for the test sets are listed below. 

Table 11-16 Test Set Power Supply Specifications

Description Specification

Input Voltage Range 100 to 240 Volts

Frequency Range 47 to 63 Hertz

Power 40 VA
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General Characteristics
General Characteristics
The test set environmental operating conditions and physical characteristics are displayed on 
the following pages.

Environmental Operating Conditions

The environmental operating conditions for the test set are listed below.

This product is designed for use in INSTALLATION CATEGORY II and POLLUTION 
DEGREE 2, per IED 61010-1 and 664, respectively.

Table 11-17 Test Set Environmental Operating Conditions

Description Conditions

Operating Environment Indoor use

Altitude

Operating: 0 to 2.0 km (6,560 ft)

Storage: 0 to 15.24 km (50,000 ft)

Temperature 0 °C to 40 °C

Maximum Relative Humidity 80% for temperatures up to 31 °C decreasing 
linearly to 50% for a temperature of 40 °C
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General Characteristics
Physical Characteristics

The weight and dimensions for the test sets are listed below.

Weight and Dimensions

Table 11-18 Test Set Weight and Dimensions

 Model Number Weight Dimensions

Height (A) Width (B) Depth (C)

N4415A, N4416A, 
N4417A, N4418A,
and N4419A

9.0 kilograms
(19.9 pounds)

3.0 in
(7.62 cm)

16.75 in
(42.55 cm)

19.25 in
(48.90 cm)

N4421A 9.0 kilograms
(19.9 pounds)

5.5 in
(13.97 cm)

16.75 in
(42.55 cm)

16.75 in
(42.55 cm)
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Test Set Front Panel and Rear Panel
This chapter provides a graphical overview of the test sets used as part of the physical layer 
test system. This chapter also illustrates the front and rear panels of the S-parameter test 
sets separately. The features of each front and rear panel (such as connectors, switches, LEDs, 
and fuses) are identified and briefly described.

The individual network analyzer features are described in the network analyzer 
documentation. They are not be described in this document!

The front and rear panel of each S-parameter test set model is illustrated and described. Refer 
to the page number listed below for your test set model number.

For Model Number: Refer to:

N4415A page 302

N4416A page 306

N4417A page 310

N4418A page 314

N4419A page 318

N4421A page 322
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Test Set Front Panel and Rear Panel
N4415A
N4415A

N4415A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 1 SWITCH connector using a semirigid cable.

2 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 1 COUPLER connector using a semirigid cable.

3 PORT 2 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 PORT 4 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)
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Test Set Front Panel and Rear Panel
N4415A
6 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 2 COUPLER connector using a semirigid cable.

7 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 2 SWITCH connector using a semirigid cable.

8 R IN SMA (f) connector that is connected to the network analyzer 
R Channel IN connector using a semirigid cable.

9 R OUT SMA (f) connector that is connected to the network analyzer 
R Channel OUT connector using a semirigid cable.

10 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

11 B OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

12 B IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

14 A IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

15 A OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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Test Set Front Panel and Rear Panel
N4415A
N4415A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 1 R OUT SMA (f) connector, used as an output reference signal

2 REF 2 R OUT Not Used

3 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

4 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

6 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor. 

7 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 21 for further information.

8 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

9 REF 2 R IN Not Used
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10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 1 R IN SMA (f) connector, used as an input reference signal

ID 
Number

Rear Panel 
Feature

Feature Description
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N4416A

N4416A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 IN SMA (f) connector that is connected to the network analyzer 
R1 IN connector using a semirigid cable.

2 A IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

3 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

4 PORT 2 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

5 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.
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6 PORT 4 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

7 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

8 B IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

9 R2 IN SMA (f) connector that is connected to the network analyzer 
R2 IN connector using a semirigid cable.

10 R2 OUT SMA (f) connector that is connected to the network analyzer 
R2 OUT connector using a semirigid cable.

11 B OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

12 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

13 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

14 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

15 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

16 A OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

17 R1 OUT SMA (f) connector that is connected to the network analyzer 
R1 OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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N4416A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 21 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal

9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.
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10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal

ID 
Number

Rear Panel 
Feature

Feature Description
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N4417A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 IN SMA (f) connector that is connected to the network analyzer 
R1 IN connector using a semirigid cable.

2 A IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

3 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

4 PORT 2 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

5 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.
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6 PORT 4 APC-7 connector that is connected to the DUT or fixture. 
(+17 dBm maximum operating level)

7 COUPLER IN SMA (f) connector that is connected to the network analyzer 
COUPLER IN connector using a semirigid cable.

8 B IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

9 R2 IN SMA (f) connector that is connected to the network analyzer 
R2 IN connector using a semirigid cable. This connector is 
installed on Option 104 only. It is not installed on Option 103.

10 R2 OUT SMA (f) connector that is connected to the network analyzer 
R2 OUT connector using a semirigid cable. This connector is 
installed on Option 104 only. It is not installed on Option 103.

11 B OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

12 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

13 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

14 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

15 SOURCE 
OUT

SMA (f) connector that is connected to the network analyzer 
SOURCE OUT connector using a semirigid cable.

16 A OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

17 R1 OUT SMA (f) connector that is connected to the network analyzer 
R1 OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal. This 
connector is installed on Option 104 only. It is not installed on 
Option 103.

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 21 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal
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9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal. This 
connector is installed on Option 104 only. It is not installed on 
Option 103.

ID 
Number

Rear Panel 
Feature

Feature Description
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N4418A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 1 SWITCH connector using a semirigid cable.

2 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 1 BIAS TEE connector using a semirigid cable.

3 PORT 2 APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.
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5 POWER ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

6 PORT 4 APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

7 COUPLER SMA (f) connector that is connected to the network analyzer 
PORT 2 BIAS TEE connector using a semirigid cable.

8 R OUT SMA (f) connector that is connected to the network analyzer 
R CHANNEL OUT connector using a semirigid cable.

9 SWITCH SMA (f) connector that is connected to the network analyzer 
PORT 2 SWITCH connector using a semirigid cable.

10 IN SMA (f) connector that is connected to the network analyzer 
B IN connector using a semirigid cable.

11 R IN SMA (f) connector that is connected to the network analyzer 
R CHANNEL IN connector using a semirigid cable.

12 OUT SMA (f) connector that is connected to the network analyzer 
B OUT connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the 
Agilent N4430A/B ECal module to provide ECal capability.

14 OUT SMA (f) connector that is connected to the network analyzer 
A OUT connector using a semirigid cable.

15 IN SMA (f) connector that is connected to the network analyzer 
A IN connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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N4418A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 1 R OUT SMA (f) connector, used as an output reference signal

2 REF 2 R OUT SMA (f) connector, used as an output reference signal

3 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

4 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

6 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

7 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 21 for further information.

8 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

9 REF 2 R IN SMA (f) connector, used as an input reference signal.
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10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 1 R IN SMA (f) connector, used as an input reference signal

ID 
Number

Rear Panel 
Feature

Feature Description
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N4419A
N4419A 

N4419A Front Panels

ID 
Number

Front Panel 
Feature

Feature Description 

1 REFERENCE 1 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer 
REFERENCE 1 SOURCE OUT connector using a semirigid cable.

2 REFERENCE 1 
RCVR R1 IN

SMA (f) connector that is connected to the network analyzer 
REFERENCE 1 RCVR R1 IN connector using a semirigid cable.

3 PORT 2 PORT 2 - APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)

4 GPIB STATUS Three LEDs (R, T, and L) that display the GPIB status of the test set 
when it is communicating with the network analyzer. R = Remote 
Operation, T = Talk mode, L = Listen mode.

5 POWER ON/OFF switch that disconnects the mains circuits from the mains 
supply before other parts of the test set. The front panel POWER 
switch disconnects the mains circuits from the mains supply after 
the EMC filters and before other parts of the instrument.

6 PORT 4 PORT 4 - APC-3.5 (m) connector with 20 mm nut that is connected to 
the DUT or fixture. (+17 dBm maximum operating level)
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7 REFERENCE 2 
RCVR R2 IN

SMA (f) connector that is connected to the network analyzer 
REFERENCE 2 RCVR R2 IN connector using a semirigid cable.

8 REFERENCE 2 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer 
REFERENCE 2 SOURCE OUT connector using a semirigid cable.

9 PORT 2 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer PORT 2 
SOURCE OUT connector using a semirigid cable.

10 PORT 2 CPLR 
ARM

SMA (f) connector that is connected to the network analyzer PORT 2 
CPLR ARM connector using a semirigid cable.

11 PORT 2 RCVR 
B IN

SMA (f) connector that is connected to the network analyzer PORT 2 
RCVR B IN connector using a semirigid cable.

12 PORT 2 CPLR 
THRU

SMA (f) connector that is connected to the network analyzer PORT 2 
CPLR THRU connector using a semirigid cable.

13 AUXILIARY 15-pin ribbon (f) connector that may be connected to the Agilent 
N4430A/B ECal module to provide ECal capability.

14 PORT 1 CPLR 
THRU

SMA (f) connector that is connected to the network analyzer PORT 1 
CPLR THRU connector using a semirigid cable.

15 PORT 1 RCVR 
A IN

SMA (f) connector that is connected to the network analyzer PORT 1 
RCVR A IN connector using a semirigid cable.

16 PORT 1 CPLR 
ARM

SMA (f) connector that is connected to the network analyzer PORT 1 
CPLR ARM connector using a semirigid cable.

17 PORT 1 
SOURCE OUT

SMA (f) connector that is connected to the network analyzer PORT 1 
SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description 
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N4419A Rear Panel

ID 
Number 

Rear Panel 
Feature

Feature Description

1 REF 2 R IN  SMA (f) connector, used as an input reference signal

2 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

3 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

4 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

5 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

6 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 21 for further information.

7 REF 1 R IN SMA (f) connector, used as an input reference signal

8 REF 1 R OUT SMA (f) connector, used as an output reference signal

9 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.
Chapter 12320



Test Set Front Panel and Rear Panel
N4419A
10 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

11 REF 2 R OUT SMA (f) connector, used as an output reference signal

ID 
Number 

Rear Panel 
Feature

Feature Description
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N4421A Front Panel

ID 
Number

Front Panel 
Feature

Feature Description

1 R1 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 OUT connector using a semirigid cable.

2 R1 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 1 RCVR R1 connector using a semirigid cable.

3 PORT 2 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)

4 GPIB 
STATUS

Three LEDs (R, T, and L) that display the GPIB status of the 
test set when it is communicating with the network analyzer. 
R = Remote Operation, T = Talk mode, L = Listen mode.

5 PORT 4 2.4 mm bulkhead test port connector that is connect to the 
DUT or fixture. (+17 dBm maximum operating level)
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6 R2 IN 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 RCVR R2 connector using a semirigid cable.

7 R2 OUT 2.4 mm (f) connector that connects to the network analyzer 
REFERENCE 2 OUT connector using a semirigid cable.

8 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 2 SOURCE OUT connector using a semirigid cable.

9 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR ARM connector using a semirigid cable.

10 B IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 B IN connector using a semirigid cable.

11 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 2 CPLR THRU connector using a semirigid cable.

12 AUXILIARY 15-pin ribbon (f) connector. Not currently used.

13 CPLR THRU 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR THRU connector using a semirigid cable.

14 A IN 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 A IN connector using a semirigid cable.

15 LINE ON/OFF switch that disconnects the mains circuits from the 
mains supply before other parts of the test set. The front 
panel POWER switch disconnects the mains circuits from the 
mains supply after the EMC filters and before other parts of 
the instrument.

16 CPLR ARM 2.4 mm (f) connector that connects to the network analyzer 
PORT 1 CPLR ARM connector using a semirigid cable.

17 SOURCE 
OUT

2.4 mm (f) connector that connects to the network analyzer 
PORT 1 SOURCE OUT connector using a semirigid cable.

ID 
Number

Front Panel 
Feature

Feature Description
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N4421A Rear Panel

ID 
Number

Rear Panel 
Feature

Feature Description

1 REF 2 R OUT  SMA (f) connector, used as an output reference signal

2 REF 2 R IN  SMA (f) connector, used as an input reference signal.

3 BUS 
ADDRESS

Switch that is used to set the GPIB address. Refer to “Step 7. 
Set Up the General Purpose Interface Bus (GPIB)” on 
page 21 for further information.

4 REF 1 R IN SMA (f) connector, used as an input reference signal

5 REF 1 R OUT  SMA (f) connector, used as an output reference signal

6 Power Cord 
Connector

Connector, 100-120 Vac or 220-250Vac input and 
Fuse, T 2.5 A 250 V (Agilent part number 2110-0681)

7 IEEE-488 24-pin IEEE-488/PCB (f) connector. The GPIB is the 
communication bus with the PC and the network analyzer.

8 PORT 2 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.
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9 PORT 2 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

10 PORT 4 
FUSE

Bias Fuse, 0.5 A, 250 V (Agilent part number 2110-0012)

11 PORT 4 BIAS BNC (f) connector. The bias port is used to supply a dc voltage 
to an active DUT, such as an amplifier or a transistor.

ID 
Number

Rear Panel 
Feature

Feature Description
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Troubleshooting and Maintenance
Electrostatic Discharge
Electrostatic Discharge
Although protected internally, test systems are sensitive to electrostatic discharge (ESD). 
Static discharges too small to feel can damage or degrade the test equipment or your devices.

Use standard precautions to protect against ESD before using the test system for calibration 
or measurement.

Use the following illustration and list of equipment to set up a static-safe workstation.

Figure 13-1 Static-Safe Workstation

• static-control table mat and earth ground wire: part number 9300-0797

• wrist-strap cord: part number 9300-0980

• wrist-strap: part number 9300-1367

• heel-straps: part number 9300-1308

• floor mat: not available through Agilent Technologies
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Troubleshooting
Troubleshooting 
Use the following table to help troubleshoot your test system.

Table 13-1 Troubleshooting the Test System

Symptom Cause Cure

One or more biases not 
applied.

Bias fuse blown. Check bias fuses. Replace 
blow fuse with fuse of the 
same type and rating. Refer to 
the test set rear-panel 
information in Chapter 12.

Control computer can’t 
communicate with the test 
set.

Accidental change to GPIB 
switch settings.

Set the GPIB address as 
needed. Restart the test 
system. See “Step 7. Set Up 
the General Purpose Interface 
Bus (GPIB)” on page 21.

The test set does not come 
on the first time you use it.

Line fuse not installed, or 
incorrect line fuse installed.

Install the line fuse. Refer to 
“Replacing the Test Set Line 
Fuse” on page 332.

Excessive ripple in data. Load termination damaged 
by excessive RF power.

Contact Agilent Technologies. 
See “Contacting Agilent” on 
page 350 for more 
information.

Loose connections between 
VNA and test set and/or 
between test set and DUT.

Check and torque the 
connectors.

Poor test cable repeatability. Replace test cables as needed. 
You can replace a single cable, 
without replacing the entire 
set.

High loss on one path with 
poor raw data match (as 
seen during analyzer 
sweep) or inability to make 
a good calibration.

Possible signal channel 
damage.

Contact Agilent Technologies. 
See “Contacting Agilent” on 
page 350 for more 
information.
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Additional Troubleshooting Assistance

Situation 

During installation, the PLTS software does not recognize the Agilent GPIB card. The GPIB 
card default address is “gpib0” (though it could be any address “gpib1” thru “gpib7” as well).

Background:   The software first looks for the presence of a National Instruments GPIB card 
by looking in the National Instruments library for addresses “gpib0” through “gpib7”. Because 
the software does not find the card because it is an Agilent GPIB card that is not supported by 
National Instruments. Then the software looks for the presence of a Hewlett-Packard HP-IB 
or Agilent Technologies GPIB card in the SICL library. The program looks for the following six 
addresses in this file: “hpib”, “hpib7”, “HPIB”, “HPIB7”, “Hpib”, and “Hpib7”. However, the 
Agilent GPIB address is not found.

Solution:   In Windows, select Start, Programs, Agilent IO Libraries, then IO Config. 
Click “gpib0” in the Configured Interfaces list, then click Edit. Change the SICL 
Interface Name to “hpib7” and click OK. Then click OK to confirm the change. Restarting 
the software should allow the software to recognize the Agilent GPIB card.
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Maintenance
This section provides basic maintenance information such as cleaning, fuse replacement, 
cable care, and connector care.

Cleaning

Clean the cabinet, using a dry or damp cloth only.

WARNING To prevent electrical shock, disconnect the Agilent Technologies 
(N4415A, N4416A, N4417A, N4418A, N4419A, and N4421A) S-parameter 
test set from mains before cleaning. Use a dry cloth or one slightly 
dampened with water to clean the external case parts. Do not attempt 
to clean internally.
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Replacing the Test Set Line Fuse

To replace the line fuse, disconnect the power cord from the rear of the test set, use a small 
screwdriver to pry open the line fuse holder and slide it open until it reaches its stop. Replace 
the fuse in use with the spare fuse and slide the fuse holder back into the instrument. 

WARNING For continued protection against fire hazard replace the test set line 
fuse only with same type and rating (115V and 230V operation: T2.5A 
250V). The use of other fuses or material is prohibited.

Figure 13-2 Line Fuse Replacement
Chapter 13332



Troubleshooting and Maintenance
Maintenance
Care of Test Cable Assemblies

Proper use and care of your test cable assemblies will yield positive results including:

• longer life

• higher performance

• better repeatability

Performing the routine inspection and cleaning of the test cable assemblies, especially the 
connectors, is very important to making the best possible measurements.

Connector Mating

Alignment of the center lines of the connectors of the test cables with the test set and DUT 
connectors before mating is important. It is possible to start the threads on the connector nuts 
without good alignment, but this will result in bent pins and damaged inserts. Resistance 
encountered while turning the connector nut may be due to one of the following:

• The pins are not aligned.

• The coupling nut is cross-threaded.

• The connector (or its mate) has been damaged by excessive torque.

Stop and determine the reason. To proceed without doing so risks the destruction of the 
assembly and the mating connector.

Holding a connector nut stationary while screwing the socket into the connector will wear 
away the connector plating and score the connector parts. If the pins lock up, serious damage 
can be caused.

Connector Torque

Make sure to grasp the body of the connector before applying final torque. If the connector 
body is allowed to rotate with the nut, the connector plating, outer interface rim, or pin 
assembly may be damaged. Excess torque applied to the connector will be transferred to the 
cable assembly. Refer to “Care of RF and Microwave Coaxial Connectors” on page 335 for more 
information. 
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Depending on the connector, over-torque can cause damage to connectors in a variety of ways: 

• mushroomed outer interface shells

• mushroomed pin shoulders

• recessed or protruding pins

• recessed or protruding dielectrics

• bent pins

• chipped plating

• coupling nut retaining ring damage

• damage to coupling threads

Cable Handling

The test cables have a 1 inch minimum bend radius. Exceeding this radius can result in poor 
measurements and poor repeatability. Be alert to tight bends where they are not necessarily 
obvious — like at the end of connector strain relief tubing.

Swept 90° adapters may be used (typically, at the test set front panel) to minimize cable 
bending. However, if the adapters are used, they must be in place during the calibration.

Cables are often stored in a coiled configuration. Coiled cable “set” (the tendency to stay 
coiled) can occur if the cables are left coiled. Use large coil diameters (one or two feet) to 
minimize cable set. Unroll coiled cables prior to use – never just pull out the loops.

Avoid pinching, crushing, or dropping objects on cable assemblies. Dragging a cable over a 
sharp edge will tend to flatten one side, and it is highly likely that the minimum bend radius 
will be exceeded.
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Care of RF and Microwave Coaxial Connectors

Proper connector care is critical for accurate and repeatable measurements. The following 
information will help you preserve the precision and extend the life of your connectors - saving 
both time and money. Prior to making connections to your test system, review the connector 
care information within this section.

This section is made up of three main subjects:

• Connector Care Reference
which contains information about:
❏ Safety Reminders
❏ Connector Cleaning Supplies
❏ Connector Care Quick Reference

• Connector Care Concepts
which contains information about:
❏ Connector Service Life
❏ Connector Grades and Performance
❏ Adapters as Connector Savers
❏ Connector Mating Plane Surfaces
❏ Gaging Fundamentals
❏ Handling and Storing Connectors

• Connector Care Procedures
which contains information about:
❏ Inspecting Connectors
❏ Cleaning Connectors
❏ Making Connections
❏ Separating Connections
❏ Gaging Connectors
❏ Using a Torque Wrench
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Connector Care Reference

This section includes the following information:

• Safety Reminders

• Connector Cleaning Supplies

• Connector Care Quick Reference

Safety Reminders  When cleaning connectors:

• Always use protective eyewear when using compressed air or nitrogen.

• Keep isopropyl alcohol away from heat, sparks and flame. Use with adequate ventilation. 
Avoid contact with eyes, skin and clothing. 

• Avoid electrostatic discharge (ESD). Wear a grounded wrist strap (having a 1 MΩ series 
resistor) when cleaning device, cable or test port connectors. 

Connector Cleaning Supplies  Products commonly used to clean connectors are listed 
below. To order these and other connector care products, contact Agilent Technologies.

Table 13-2 Connector Cleaning Supplies

Cleaning Supplies Description Agilent Part Number

Lint-Free Swabs, small 100 ct. 9301-1243

IPA 99.5% alcohol, 30 ml bottle 8500-5344

Compressed Air, 235 ml can 8500-6659
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Connector Care Quick Reference  Use the following table as a quick guide for connector 
care:

Table 13-3 Connector Care Quick Reference

Handling and Storage

Do Keep connectors clean Do Not Touch mating-plane surfaces

Extend sleeve or connector nut Set connectors contact-end down

Use plastic end-caps during storage

Visual Inspection

Do Inspect all connectors carefully Do Not Use a damaged connector - ever

Look for metal particles, scratches, 
and dents

Connector Cleaning

Do Try compressed air first Do Not Use any abrasives

Use isopropyl alcohol Get liquid into plastic support 
beads

Clean connector threads

Gaging Connectors

Do Clean and zero the gage before use Do Not Use an out-of-spec connector

Use the correct gage type

Use correct end of calibration block

Gage all connectors before first use

Making Connections

Do Align connectors carefully Do Not Apply bending force to connection

Make preliminary connection lightly Over tighten preliminary 
connection

Turn only the connector nut Twist or screw any connection

Use a torque wrench for final 
connect

Tighten past torque wrench 
“break” point
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Connector Care Concepts

This section includes the following concepts:

• Connector Service Life

• Connector Grades and Performance

• Adapters as Connector Savers

• Connector Mating Plane Surfaces

• Gaging Fundamentals

• Handling and Storing Connectors

Connector Service Life  Even though calibration standards, cables, and test set connectors 
are designed and manufactured to the highest standards, all connectors have a limited service 
life. This means that connectors can become defective due to wear during normal use. For best 
results, all connectors should be inspected and maintained to maximize their service life.

Visual Inspection should be performed each time a connection is made. Metal particles from 
connector threads often find their way onto the mating surface when a connection is made or 
disconnected. See Inspection procedure.

Cleaning the dirt and contamination from the connector mating plane surfaces and threads 
can extend the service life of the connector and improve the quality of your calibration and 
measurements. See Cleaning procedure.

Gaging connectors not only provides assurance of proper mechanical tolerances, and thus 
connector performance, but also indicate situations where the potential for damage to another 
connector may exist. See “Gaging Fundamentals” on page 341.

Proper connector care and connection techniques yield:

• Longer Service Life

• Higher Performance

• Better Repeatability
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Connector Grades and Performance  The three connector grades (levels of quality) for the 
popular connector families are listed below. Some specialized types may not have all three 
grades.

• Production grade connectors are the lowest grade and the least expensive. It is the 
connector grade most commonly used on the typical device under test (DUT). It has the 
lowest performance of all connectors due to its loose tolerances. This means that 
production grade connectors should always be carefully inspected before making a 
connection to the analyzer. Some production grade connectors are not intended to mate 
with metrology grade connectors. 

• Instrument grade is the middle grade of connectors. It is mainly used in and with test 
instruments, most cables and adapters, and some calibration standards. It provides long 
life with good performance and tighter tolerances. It may have a dielectric supported 
interface and therefore may not exhibit the excellent match of a metrology grade 
connector. 

• Metrology grade connectors have the highest performance and the highest cost of all 
connector grades. This grade is used on calibration standards, verification standards, and 
precision adapters. Because it is a high precision connector, it can withstand many 
connections and disconnections and, thus, has the longest life of all connector grades. This 
connector grade has the closest material and geometric specifications. Pin diameter and 
pin depth are very closely specified. Metrology grade uses an air dielectric interface and a 
slotless female contact which provide the highest performance and traceability.

NOTE In general, Metrology grade connectors should not be mated with Production 
grade connectors.

Adapters as Connector Savers  Make sure to use a high quality (Instrument grade or 
better) adapter when adapting a different connector type to the analyzer test ports. It is a 
good idea to use an adapter even when the device under test is the same connector type as the 
analyzer test ports. In both cases, it will help extend service life, and protect the test ports 
from damage and costly repair. 

The adapter must be fully inspected before connecting it to the analyzer test port and 
inspected and cleaned frequently thereafter. Because calibration standards are connected to 
the adapter, the adapter should be the highest quality to provide acceptable RF performance 
and minimize the effects of mismatch. 
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Connector Mating Plane Surfaces  An important concept in RF and microwave 
measurements is the reference plane. For a network analyzer, this is the surface or point that 
measurements are referenced to at calibration. In connectors, the reference plane is defined 
as the plane where the mating plane surfaces meet. Good connections require perfectly flat 
contact between connectors at all points on the mating plane surfaces (see Figure 13-3).

Figure 13-3 Connector Mating Surfaces (Reference Plane)
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Gaging Fundamentals  Connector gages are important tools used to measure center 
conductor pin depth in connectors. See Figure 13-4. Connector pin depth is generally the 
distance between the mating plane of the outer conductor and the end of the center conductor, 
or the shoulder of the center conductor for a stepped male pin. 

Figure 13-4 Typical Connector Gage
Chapter 13 341



Troubleshooting and Maintenance
Maintenance
Recession and Protrusion  Pin depth is negative (recession) if the center conductor is 
recessed below the outer conductor mating plane, usually referred to as the “reference plane”. 
Pin depth is positive (protrusion) if the center conductor projects forward from the connector 
reference plane. See Figure 13-5.

Figure 13-5 Connector Pin Depth

1. Recession of female contact

2. Recession of male pin shoulder

Some connectors, like Type-N connectors, have the mating plane of the center conductors 
offset from the connector reference plane. In this case the zero setting “gage masters” 
generally offset the nominal distance between the center conductor mating plane and the 
connector reference plane.

When to Gage Connectors  Connectors should be gaged at each of the following events:

• Before using a connector or adapter the first time.

• When visual inspection or electrical performance suggests the connector interface may be 
out of range.

• After every 100 connections, depending on use. 
Chapter 13342



Troubleshooting and Maintenance
Maintenance
Connector Gage Accuracy  Connector gages (those included with calibration and 
verification kits), are capable of performing coarse measurements only. This is due to the 
repeatability uncertainties associated with the measurement. It is important to recognize 
that test port connectors and calibration standards have mechanical specifications that are 
extremely precise. Only special gaging processes and electrical testing (performed in a 
calibration lab) can accurately verify the mechanical characteristics of these devices. The pin 
depth specifications in the Agilent calibration kit manuals provide a compromise between the 
pin depth accuracy required, and the accuracy of the gages. The gages shipped with 
calibration and verification kits allow you to measure connector pin depth and avoid damage 
from out-of-specification connectors. 

NOTE Before gaging any connector, the mechanical specifications provided with that 
connector or device should be checked.

Handling and Storing Connectors   Use the following precautions when handling or 
storing connectors.

• Install protective end caps when connectors are not in use.

• Never store connectors, airlines, or calibration standards loose in a box. This is a common 
cause of connector damage.

• Keep connector temperature the same as analyzer. Holding the connector in your hand or 
cleaning connector with compressed air can significantly change the temperature. Wait for 
connector temperature to stabilize before using in calibration or measurements.

• Do not touch mating plane surfaces. Natural skin oils and microscopic particles of dirt are 
difficult to remove from these surfaces.

• Wear a grounded wrist strap and work on a grounded, conductive table mat. This helps 
protect the analyzer and devices from electrostatic discharge (ESD).

• Wear a grounded wrist strap and work on a grounded, conductive table mat. This helps 
protect the analyzer and devices from electrostatic discharge (ESD).
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Connector Care Procedures

This section includes the following procedures:

• Inspecting Connectors

• Cleaning Connectors

• Making Connections

• Separating Connections

• Gaging Connectors

• Using a Torque Wrench

Inspecting Connectors  Use the following procedures when inspecting connectors.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Use a magnifying glass (>10×) and inspect the connector for the following conditions:

• Badly worn plating or deep scratches

• Deformed threads

• Metal particles on threads and mating plane surfaces 

• Bent, broken, or mis-aligned center conductors

• Poor connector nut rotation

CAUTION A damaged or out-of-specification device can destroy a good connector attached 
to it even on the first connection. Any connector with an obvious defect should 
be marked for disposal or sent out for repair. 
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Cleaning Connectors  Use the following procedures when cleaning connectors.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Use clean, low-pressure air to remove loose particles from mating plane surfaces and 
threads (see Figure 13-6). Inspect connector thoroughly. If additional cleaning is required, 
continue with the following steps.

Figure 13-6 Removing Loose Particles using Clean, Low Pressure Air

3. Moisten-do not saturate-a lint-free swab with isopropyl alcohol. See Cleaning Supplies for 
recommended type.

4. Clean contamination and debris from mating plane surfaces and threads. When cleaning 
interior surfaces, avoid exerting pressure on center conductor and keep swab fibers from 
getting trapped in the female center conductor. See Figure 13-7.

Figure 13-7 Cleaning Surfaces using a Lint-Free Swab

5. Let alcohol evaporate-then use compressed air to blow surfaces clean.

6. Inspect connector. Make sure no particles or residue remains.

7. If defects are still visible after cleaning, the connector itself may be damaged and should 
not be used. Determine the cause of damage before making further connections. 
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Gaging Connectors  Use the following procedures when gaging connectors.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Select proper gage for device under test (DUT).

3. Inspect and clean gage, gage master, and DUT.

4. Zero the connector gage.

a. While holding gage by the barrel, carefully connect gage master to gage. Finger-tighten 
connector nut only.

b. Use proper torque wrench to make final connection. If needed, use additional wrench to 
prevent gage master (body) from turning.

c. The gage pointer should line up exactly with the zero mark on gage. If not, adjust “zero 
set” knob until gage pointer reads zero. On gages having a dial lock screw and a 
movable dial, loosen the dial lock screw and move the dial until the gage pointer reads 
zero. Gages should be zeroed before each set of measurements to make sure zero setting 
has not changed.

d. Remove gage master.

5. Gage the DUT.

a. While holding gage by the barrel, carefully connect DUT to gage. Finger-tighten 
connector nut only.

b. Use proper torque wrench to make final connection and, if needed, use additional 
wrench to prevent DUT (body) from turning.

c. Read gage indicator dial for recession or protrusion and compare reading with device 
specifications. 

CAUTION If the gage indicates excessive protrusion or recession, the connector should be 
marked for disposal or sent out for repair.

6. For maximum accuracy, measure the device a minimum of three times and take an 
average of the readings. After each measurement, rotate the gage a quarter-turn to reduce 
measurement variations.

7. If there is doubt about measurement accuracy, be sure the temperatures of the parts have 
stabilized. Then perform the cleaning, zeroing, and measuring procedure again.
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Making Connections  Use the following procedures when making connections.

1. Wear a grounded wrist strap (having a 1 MΩ series resistor) when cleaning device, cable or 
test port connectors.

2. Inspect, clean, and gage connectors. All connectors must be undamaged, clean, and within 
mechanical specification.

3. Carefully align center axis of both devices. The center conductor pin-from the male 
connector-must slip concentrically into the contact finger of the female connector. See 
Figure 13-8.

Figure 13-8 Aligning the Center Axis of Both Connectors

4. Carefully push the connectors straight together so they can engage smoothly. Rotate the 
connector nut (not the device itself) until finger-tight, being careful not to cross the 
threads. See Figure 13-9.

Figure 13-9 Pushing the Connectors Together and Rotating the Nut
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5. Use a torque wrench to make final connection. Tighten until the “break” point of the 
torque wrench is reached. Do not push beyond initial break point. Use additional wrench, 
if needed, to prevent device body from turning. See Figure 13-10.

Figure 13-10 Using a Torque Wrench to Make the Final Connection

Separating Connections  Use the following procedures when separating connections.

1. Support the devices to avoid any twisting, rocking or bending force on either connector.

2. Use an open-end wrench to prevent the device body from turning.

3. Use another open-end wrench to loosen the connector nut.

4. Complete the disconnection by hand, turning only the connector nut.

5. Pull the connectors straight apart.
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Using a Torque Wrench  Use the following procedures when using a torque wrench.

1. Make sure torque wrench is set to the correct torque setting. 

2. Position torque wrench and a second wrench (to hold device or cable) within 90° of each 
other before applying force. Make sure to support the devices to avoid putting stress on the 
connectors. See Figure 13-11.

Figure 13-11 Positioning the Wrenches

3. Hold torque wrench lightly at the end of handle-then apply force perpendicular to the 
torque wrench handle. Tighten until the “break” point of the torque wrench is reached. Do 
not push beyond initial break point. See Figure 13-12.

Figure 13-12 Torquing with the Torque Wrench
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Contacting Agilent

You may use the following table to contact Agilent Technologies for assistance with any 
Agilent product.

Table 13-4 Contacting Agilent

Online assistance: www.agilent.com/find/assist

United States
(tel) 1 800 452 4844

Latin America
(tel) (305) 269 7500
(fax) (305) 269 7599

New Zealand
(tel) 0 800 738 378
(fax) (+64) 4 495 8950

Japan
(tel) (+81) 426 56 7832
(fax) (+81) 426 56 7840

Malaysia
(tel) 1 800 828 848
(fax) 1 800 801 664

India
(tel) 1-600-11-2929
(fax) 000-800-650-1101

Taiwan
(tel) 0800-047-866
(fax) (886) 2 25456723

Hong Kong
(tel) 800 930 871
(fax) (852) 2506 9233

Canada
(tel) 1 877 894 4414
(fax) (905) 282-6495

Europe
(tel) (+31) 20 547 2323
(fax) (+31) 20 547 2390

Australia
(tel) 1 800 629 485
(fax) (+61) 3 9210 5947

Singapore
(tel) 1 800 375 8100
(fax) (65) 836 0252

Thailand
(tel) outside Bangkok: (088) 226 008
(tel) within Bangkok: (662) 661 3999
(fax) (66) 1 661 3714

People’s Republic of China
(tel) (preferred): 800-810-0189
(tel) (alternate): 10800-650-0021
(fax) 10800-650-0121

Philippines
(tel) (632) 8426802
(tel) (PLDT subscriber only): 1 800 16510170

(fax) (632) 8426809
(fax) (PLDT subscriber only): 1 800 16510288 
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Make sure have the following information readily available when you call:

• the serial number of the test set

• a list of any options or accessories installed in or in use with the test set

• the type of GPIB board in your computer

• any information you can supply about the DUT

• the nature of the problem

• the version number of software

Shipment for Service 

If you are sending the instrument to Agilent Technologies for service, ship the test set to the 
nearest service center for repair, including a description of any failed test and any error 
message. Ship the instrument using the original or comparable antistatic packaging 
materials.

Refer to “Contacting Agilent” on page 350 for additional information.
Chapter 13 351



Troubleshooting and Maintenance
Maintenance
Chapter 13352



14 Safety and Regulatory Information
353



Safety and Regulatory Information
Safety Information
Safety Information
Review to the safety information in this section before operating your physical layer test 
system. 

Safety Symbols 

The following safety symbols are used throughout this manual. Familiarize yourself with each 
of the symbols and its meaning before operating the physical layer test system.

CAUTION Caution denotes a hazard. It calls attention to a procedure that, if not correctly 
performed or adhered to, would result in damage to or destruction of the 
instrument. Do not proceed beyond a caution note until the indicated conditions 
are fully understood and met.

WARNING Warning denotes a hazard. It calls attention to a procedure which, if 
not correctly performed or adhered to, could result in injury or loss of 
life. Do not proceed beyond a warning note until the indicated 
conditions are fully understood and met.
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Instrument Markings

Familiarize yourself with each of the markings and its meaning before operating the physical 
layer test system.

The ON symbol. The ON symbol is used to mark the positions of the 
instrument line switch.

The OFF symbol. The OFF symbol is used to mark the positions of the 
instrument line switch.

The ON symbol. The ON symbol is used to mark the positions of the 
instrument line switch.

The OFF symbol. The OFF symbol is used to mark the positions of the 
instrument line switch.

The AC symbol. The AC symbol is used to indicate the required nature 
of the line module input power.

The instruction documentation symbol. The product is marked with 
this symbol when it is necessary for the user to refer to the instructions 
in the documentation.

The CE mark is a registered trademark of the European Community. 
(If accompanied by a year, it is when the design was proven.)

The CSA mark is a registered trademark of the Canadian Standards 
Association.

This is a symbol of an Industrial Scientific and Medical Group 1 Class 
A product.

ICES / NMB-001 This is a marking to indicate product compliance with the Canadian 
Interference-Causing Equipment Standard (ICES-001).

The C-Tick mark is a registered trademark of the Australian Spectrum 
Management Agency.
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Safety Considerations 

Familiarize yourself with each of the safety considerations before operating the physical layer 
test system.

NOTE Positioning the Test System for Use

When setting up the physical layer test system for use, position the equipment 
so that the front panel power switch is easy to reach.

NOTE This instrument has been designed and tested in accordance with the 
standards listed on the Manufacturer’s Declaration of Conformity and has been 
supplied in a safe condition. This instruction documentation contains 
information and warnings which must be followed by the user to ensure safe 
operation and to maintain the instrument in a safe condition.

Safety Earth Ground 

WARNING This is a Safety Class 1 product (provided with a protective earthing 
ground incorporated in the power cord). The mains plug shall only be 
inserted in a socket outlet provided with a protective earth contact. 
Any interruption of the protective conductor, inside or outside the 
instrument, is likely to make the instrument dangerous. Intentional 
interruption is prohibited.

CAUTION Always use the three-prong AC power cord supplied with this product. Failure 
to ensure adequate earth grounding by not using this cord may cause product 
damage.
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Before Applying Power 

CAUTION Install the instrument so that the ON/OFF switch is readily identifiable and is 
easily reached by the operator. The ON/OFF switch or the detachable power 
cord is the instrument disconnecting device. It disconnects the mains circuits 
from the mains supply before other parts of the instrument. Alternately, an 
externally installed switch or circuit breaker (which is readily identifiable and 
is easily reached by the operator) may be used as a disconnecting device.

CAUTION Before switching on this instrument, make sure that the correct fuse is 
installed and the supply voltage is in the specified range.

Servicing 

WARNING No operator serviceable parts inside. Refer servicing to qualified 
personnel. To prevent electrical shock, do not remove covers.

WARNING These servicing instructions are for use by qualified personnel only. To 
avoid electrical shock, do not perform any servicing unless you are 
qualified to do so.

WARNING The opening of covers or removal of parts is likely to expose dangerous 
voltages. Disconnect the instrument from all voltage sources while it is 
being opened.

WARNING The power cord is connected to internal capacitors that may remain 
live for 5 seconds after disconnecting the plug from its power supply. 

WARNING For continued protection against fire hazard replace line fuse only 
with same type and rating (115V and 230V operation: T2.5A 250V). The 
use of other fuses or material is prohibited.
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General 

WARNING To prevent electrical shock, disconnect the Agilent Technologies 
(N4415A, N4416A, N4417A, N4418A, N4419A, and N4421A) S-parameter 
test set from mains before cleaning. Use a dry cloth or one slightly 
dampened with water to clean the external case parts. Do not attempt 
to clean internally.

WARNING If this product is not used as specified, the protection provided by the 
equipment could be impaired. This product must be used in a normal 
condition (in which all means for protection are intact) only.

CAUTION This product is designed for use in Installation Category II and Pollution 
Degree 2 per IEC 1010 and 664 respectively.

CAUTION VENTILATION REQUIREMENTS: When installing the product in a cabinet, 
the convection into and out of the product must not be restricted. The ambient 
temperature (outside the cabinet) must be less than the maximum operating 
temperature of the product by 4° C for every 100 watts dissipated in the 
cabinet. If the total power dissipated in the cabinet is greater that 800 watts, 
then forced convection must be used.
Chapter 14358



Safety and Regulatory Information
Regulatory Information
Regulatory Information
The Agilent Technologies S-Parameter test system complies with the regulatory requirements 
listed in this section.

Compliance with Canadian EMC Requirements 

This ISM device complies with Canadian ICES-001.

Cet appareil ISM est conforme a la norme NMB du Canada.

Compliance with German Noise Requirements 

This is to declare that this instrument is in conformance with the German Regulation on 
Noise Declaration for Machines (Laermangabe nach der Maschinenlaermrerordung −3. GSGV 
Deutschland).

Acoustic Noise Emission/Geraeuschemission 

LpA <70 dB LpA <70 dB

Operator position am Arbeitsplatz

Normal position normaler Betrieb

per ISO 7779 nach DIN 45635 t. 19
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Appendices is a collection of supplementary information that you may find useful.

Appendix A, “Glossary” Defines terms that you may encounter while performing 
measurements using the physical layer test system.

Appendix B, “Procedures” Provides procedures that may be needed but are not 
commonly used while using the physical layer test system.
362



A Glossary
363



Glossary
− Symbols −

.SnP .SnP data format creates component data files that describe 
frequency dependent linear network parameters for n port 
components. This format is used to import/export S-parameter 
data.

γ (Gamma) Gamma is the complex propagation constant. γ = α +βj where α is 
the attenuation per length and β is related to the wave velocity.

σ (Sigma) Sigma represents standard deviation, which is the measure of the 
dispersion or spread of the statistical average of all results for a 
particular measurement. See “Standard deviation” on page 374.

− Numeric −

2-Level A 2-level data signal generates 1 bit per symbol.

4-Level A 4-level data signal generates 2 bits per symbol consuming half 
the bandwidth of a 2-level signal.

− A −

Attenuation Attenuation is the process of reducing the amplitude of a waveform 
without introducing significant distortion. For example, the input 
waveform to a standard 10:1 probe will be reduced, or attenuated, 
by a factor of 20 dB. 

Averaging Averaging is a waveform acquisition mode in which the instrument 
acquires waveforms from multiple data acquisitions and then 
averages the waveforms together, point by point. Averaging 
significantly reduces noise and improves resolution of the displayed 
waveform. The noise sources can average to zero over time while 
the underlying waveform is preserved. The effective resolution of 
the displayed waveform increases as more acquisitions are 
averaged together. This improves the stability of both the display 
and waveform measurements.

− B −

Balanced device A balanced device is composed of two nominally identical halves. 
Practically speaking, the signals on each side of the device can have 
any relative amplitude and phase relationship, but they can be 
decomposed into a differential-mode (anti-phase) component, and a 
common-mode (in-phase) component.
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− C −

C (capacitance) Capacitance (farads) is a measure of stored electric charge.

Calibration In instrumentation, calibration is the process of periodically 
(usually annually) verifying an instrument is performing to 
specification. A calibration certificate is awarded after verification.

In network analyzers, calibration is the process of removing 
systematic errors from measurements (also known as accuracy 
enhancement or error correction).

Calibration Kit A calibration kit contains hardware and software required to 
perform error correction on a network analyzer for a specific 
measurement and/or test set.

Calibration, SOLT SOLT is a calibration using four known standards: 
Short-Open-Load-Through. 

Characteristic 
Impedance

Characteristic impedance is the impedance looking into the end of 
an infinitely long lossless transmission.

CITIfile CITIfile (Common Instrumentation Transfer and Interchange file) 
is an ASCII data format that is useful when exchanging data 
between computers and instruments. 

Common Mode Common mode is the in-phase mode of a balanced measurement.

Continuous Sweep 
Mode

Continuous sweep mode is the analyzer condition where traces are 
automatically updated each time trigger conditions are met.

Crossing Percentage Crossing percentage is a measure of the amplitude of an eye 
diagram crossing points relative to the one level and zero level. 
Crossing percentage is determined as:

Crossing Point (Eye) Crossing point (eye) is the point in time, in an eye diagram, where 
the rising edge of a waveform intersects with the falling edge.

Crossstalk Crosstalk is the occurrence of a signal at one port of a device being 
affected by a signal in any other path. Isolation is the measurement 
of crosstalk.

Cros gPercentagesin 100 VCross

VZeroLevel

VOneLevel VZeroLevel–
-----------------------------------------------------– 

 =
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De-embedding De-embedding is the process of removing the effect of test 
fixtures and adapters from a measurement using the software to 
establish the reference planes of your device under test (DUT). 
The software can use measured files of the adapter or test fixture 
to remove their effects from the measurement of the DUT. 

Differential Mode Differential mode is the anti-phase mode of a balanced 
measurement.

DUT DUT is an acronym commonly used for the device under test.

Dynamic Range Dynamic range specifies the amplitude (size) of a signal that can be 
input into the instrument at a particular vertical scale without 
overdriving the front end, resulting in an inaccurate acquisition of 
data.

− E −

Ethernet Ethernet is a network that adheres to the IEEE 802.3 Local Area 
Network standard.

Extinction Ratio Extinction ratio is the ratio of the one level and the zero level of an 
eye diagram. This measurement is made in a section of the eye 
referred to as the eye window. 

Eye Diagram or 
Pattern

An eye diagram is a waveform display that is typically produced by 
convolving the time domain impulse response of SDD21 with a 
repetitive bit pattern.

Eye Height Eye height is a measure of the vertical opening of an eye diagram. 

Eye Opening Factor Eye Opening Factor is a measure of the vertical opening of an eye 
diagram.

Eye Width Eye width is a measure of the horizontal opening of an eye diagram. 

Eye Window The eye window provides the time boundaries within which signal 
parameters for eye diagrams are measured.
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Fall Time Fall time is a measure of the mean one level to zero level transition 
time of the data of an eye diagram. The data crosses through the 
following thresholds: the upper, middle, and lower thresholds, as 
well as through eye crossing points.

Fixturing Fixturing is the process of using a test fixture which as an 
interface between your test equipment and your device under test 
(DUT). The test fixture is used to hold the DUT, route signals to 
and from the DUT, and to apply bias voltages and ground paths 
to the DUT. 

FR-4 FR-4 is a common, epoxy-resin glass laminate that is used as 
substrate for PC boards. 

Frequency Frequency is the number of periodic oscillations, vibrations, or 
waves per unit of time, usually expressed in cycles per second, or 
Hertz (Hz).

Frequency Accuracy Frequency accuracy is the uncertainty with which the frequency of 
a signal or spectral component is indicated, either in an absolute 
sense or relative to another signal or spectral component. Absolute 
and relative frequency accuracies are specified independently.

Frequency Range Frequency range is the range of frequencies over which a device or 
instrument performance is specified.

Frequency Response In frequency mode, frequency response is the peak-to-peak 
variation in the displayed amplitude response over a specified 
center frequency range. Frequency response is typically specified in 
terms of dB, relative to the value midway between the extremes.

Frequency Span Frequency span is represented by the horizontal axis of the display. 
Generally, frequency span is given as the total span across the full 
display. Sometimes frequency span (scan width) is represented as a 
per-division value.

Functions (Math) Functions (Math) are mathematical operations (such as Add, 
Subtract, Multiply, Integrate, Versus for XY plots) that can be 
performed on input waveforms, stored waveform memories, or even 
other functions. 
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G (conductance) Conductance is the resistive component in shunt impedance across 
transmission lines.

Gamma (γ) Gamma is the complex propagation constant. γ = α +βj where α is 
the attenuation per length and β is related to the wave velocity.

Golden Device A device under test that is measured and its test results are saved 
for comparison against future measurements as a metric of 
calibration quality.

Graticule The graticule is the enclosed area where all the waveform data and 
markers are displayed on the screen. The display graticule is also 
referred to as the display grid or waveform viewing area. 

− H −

Horizontal Scale Horizontal scale is an instrument control that controls the x-axis or 
time per division of displayed waveforms. Horizontal scale is often 
referred to as sweep speed in some instruments.

− I −

Impedance Impedance is the ratio of voltage to current at a port of a circuit, 
expressed in ohms.

Insertion Loss Insertion loss is the difference between the power measured before 
and after the insertion of a device or the attenuation between the 
input and output of a device.

Isolation Isolation is the specification or measure of the immunity that one 
signal has to being affected by another adjacent signal. The 
occurrence is known as crosstalk

− J −

Jitter Jitter is the measure of the time variances of the rising and falling 
edges of an eye diagram as these edges affect the crossing points of 
the eye. 

− K −

K28.5 K28.5 is an industry standard finite length bit sequence (comma 
character, 8B/10B encoding).
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L (inductance) Inductance (henries) is stored magnetic charge.

Load A load is a one port microwave device used to terminate a path in 
its characteristic impedance.

Load A Load is a calibration standard that is an actual line that 
terminates a path with the path’s characteristic impedance. See 
SOLT.

Load Match Load match is a measure of how close the device's terminating load 
impedance is to the ideal transmission line impedance. Match is 
usually measured as return loss or standing wave ratio (SWR) of 
the load.

Log Display Log display (logarithmic display) is the display mode in which 
vertical deflection is a logarithmic function of the input signal 
amplitude. The display calibration is set by selecting the value of 
the reference level position and scale factor in dB per division.

− M −

Magnitude Magnitude is the amplitude of a signal measured in its 
characteristic impedance without regard to phase.

Markers Marker lines are used to determine the position or amplitude of the 
selected point on the display graticule. Marker lines can be 
positioned on either:

• a selected waveform source (input channel, waveform memory or 
waveform function)

• independently anywhere on the display graticule

 

Mask A mask is a template consisting of numbered, shaded regions on the 
instrument display screen. The input waveform must remain 
within these regions in order to comply with industry standards. 
The waveforms that intrude these regions are mask violations. 

Mask Test A mask test is a test process used to verify that waveforms 
generated by a test device conform to industry standards. 
Appendix A 369



Glossary
Measurement 
Uncertainty

Measurement uncertainty is the quantified amount of error in a 
measurement situation. Calibrations are intended to reduce the 
amount of uncertainty. The following are sources of measurement 
errors that lead to uncertainty:

• Systematic errors (imperfections in calibration standards, 
connectors, cables, and instrumentation)

• Random errors (noise, connector repeatability)

• Drift (source and instrumentation)

Microstrip Microstrip is a planar transmission line that consists of a thin 
conductive trace (or traces) printed or etched on one side of an 
insulating substrate with a parallel ground plane (backplane) on 
the other side of the substrate. Microstrips are also used for 
antennas and antenna arrays.

Mixed Mode 
S-parameters

Mixed mode S-parameters describe the performance of a device 
when measuring a balanced device. Each balanced port will support 
both a common-mode and a differential mode signal.

− N −

Noise Noise is an unwanted disturbance (voltage or current) 
superimposed on a useful waveform.

Non-insertable 
Calibration

A non-insertable calibration is one in which the test port connectors 
are of the same gender (male-to-male or female-to-female).

− O −

Offset Offset is used to move or set off a determined amount. Used in 
instruments for offsetting frequencies, limits, delay, loss, 
impedance, etc.

One Level One level is a measure of the mean value of the logical 1 of an eye 
diagram. 

Open An Open is a calibration standard that is an actual line that 
terminates a path with an electrical open. See SOLT.
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Phase In network analysis, the phase response of the device under test is 
the change in phase as a function of frequency between the input 
stimulus and the measured response.

Physical Layer The physical layer is layer 1, the lowest layer, of the seven-layer 
Open System Interconnection (OSI) model. In broad terms, the 
physical layer is responsible for activating and using physical 
connections for transfer of electronic bits (zeros and ones) between a 
device and its transmission medium. The physical layer defines the 
electrical, mechanical, and handshaking protocols that govern 
transmission media and signals over the interface connecting a 
device to the transmission medium. In doing so, the physical layer 
insulates the data link layer (layer 2) from the physical 
characteristics of the transmission medium, such as baseband, 
broadband, or fiber-optic transmission. The physical layer is 
subdivided into the physical medium-dependent (PMD) sublayer 
and the transmission convergence (TC) sublayer.

Port A port is the physical input or output connection of an instrument 
or device.

Power Level Power level (dBm) is the stimulus level at the test port required for 
the measurement of the device under test.

Probing Probing is the process of using a probe to perform on-circuit 
measurements. The probe is a stylus-like device that is connected 
to the test equipment on one end with a cable. The other end of 
the probe is pressed onto your device under test (DUT) to 
measure the signal. The end that is being used to probe often has 
multiple conductors for signal and ground paths. It is also often 
spring loaded to apply a constant pressure to the DUT. 

PRBS (Pseudo 
Random Binary 
Sequence)

PRBS is a repetitive, random, digital signal pattern.

− R −

R (resistance) Resistance (ohms) is the opposition to the flow of current in a 
transmission line.
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Rack Units A rack unit (U) is the vertical distance (height) between screw holes 
in an equipment rack. One rack unit (1U) equals 1.75 inches (44.45 
mm) of rack space for equipment. 2U provides 3.5 inches of rack 
space for equipment, and so forth.

Record Length Record length is the number of points per waveform trace acquired. 
You can set the record length of the data acquisition to a value of 16 
to 4096 points per waveform.

Reference Level Reference level is an instrument function that allows the user to set 
the amplitude value at the reference position. On network 
analyzers, the reference position is also selectable. 

Reference Plane A reference plane is the electrical location at which a network 
analyzer assumes the system connectors and fixturing ends and the 
DUT begins. The reference plane is set by using calibration 
standards with known electrical length. The closer the reference 
plane is to the device under test (DUT), the better the 
characterization of the device because of the elimination of test 
system uncertainties.

Reference Plane 
Rotation

Reference plane rotation is a technique to remove the time delay 
caused by a fixture. Since the SOLT calibration only calibrates to 
the end of the test cables, the effects added by the test fixture can 
be removed mathematically. Reference plane rotation moves the 
reference plane from the end of the test cables to the connection 
between the fixture and the DUT by accounting for the electrical 
length of each fixture path. Other terms for this process are phase 
skew and port extension.

Reflection Reflection is the phenomenon in which a traveling wave strikes a 
discontinuity and returns to the original medium.

Reflection 
Coefficient

The reflection coefficient is the ratio of the reflected voltage to the 
incident voltage into a transmission line or circuit. If a 
transmission line is terminated in its characteristic impedance, the 
reflection coefficient is zero. If the line is shorted or open, the 
coefficient is 1. 

Rho Rho (ρ) in time domain is the ratio between the incident and the 
reflected voltages and can be either positive or negative.
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Rise Time Rise time is a measure of the mean transition time of the data on 
the upward slope of an eye diagram. The data crosses through the 
following thresholds: the lower, middle, and upper thresholds, as 
well as through the crossing points of eyes.

RMS RMS is the root-mean-square (rms) of the voltage values of a 
waveform. Typically, the rms is taken over the first period of the 
displayed waveform.

− S −

S-parameters 
(scattering 
parameters)

A convention used to characterize the way a device modifies signal 
flow using a network analyzer. A four port device has sixteen 
S-parameters: including forward transmission and reverse 
transmission, and forward reverse reflection for each set of ports.

 Scale (horizontal) Horizontal scale is an instrument control that controls the x-axis or 
time per division of displayed waveforms. Horizontal scale is often 
referred to as sweep speed in some instruments.

Scale (vertical) Vertical scale is an instrument control that controls the y-axis or 
volts per division for the selected channel. This control allows you to 
adjust the sensitivity of the instrument.

Short A Short is a calibration standard that is an actual line that 
terminates a path with an electrical short. See SOLT.

Signal-to-Noise 
Ratio

Signal-to-noise is a ratio of the signal difference between one level 
and zero level relative to the noise present at both levels.

Single-ended A singled-ended or unbalanced device, has all of its signals 
referenced to a common ground potential.

Single-ended device A single-ended device has all of its signals referenced to a common 
ground potential.

Skew Skew changes the horizontal position of a waveform on the display 
independent of any other waveforms on the display. Skew is 
typically used for overlaying waveforms, or eliminating timing 
difference caused by different cable and probe lengths. The time 
base position control moves all of the waveforms on the display at 
the same time, whereas skew moves individual waveforms..

Slope (power) See Power Slope.
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SOLT SOLT is a calibration using four known standards: 
Short-Open-Load-Thru. 

Source The source (input channel, function, waveform memory, or 
constant) used when performing tasks, such as measurements, 
math, or mask tests.

Standard deviation Standard deviation is the measure of the dispersion or spread of the 
statistical average of all results for a particular measurement.

Standard deviation is represented by the Greek letter sigma (σ). In 
a Gaussian distribution, two sigma, or within ±1σ of the mean is 
where 68.3 percent of the data points reside. Six sigma, or within 
±3σ of the mean is where 99.7 percent of the data points reside. 

Stop/Start 
Frequency

Terms used in association with the stop and start points of the 
frequency measurement range. Together they determine the span of 
the measurement range.

Stripline Stripline is a planar transmission line that consists of a thin 
conductive trace (or traces) printed or etched on one side of an 
insulating substrate with a parallel ground plane (backplane) on 
the other side of the substrate. Another insulating substrate, also 
with a parallel ground plane on the other side, is placed over the 
conductive trace, encasing or sandwiching the trace between two 
pieces of substrate with ground planes.

Sweep A sweep is the ability of the source to provide a specified signal level 
over a specified frequency range in a specified time period. 

Sweep Cycle Time Sweep cycle time is the time required for making a complete sweep 
and preparing for the next sweep. It can be measured as the time 
from the start of one sweep to the start of the next sweep. 

Sweep Mode Sweep mode is the way in which a sweep is initiated or selected.

Sweep Type Sweep type is the method of sweeping the source, e.g., linear, log, or 
frequency step.

− T −

Termination A termination is a load connected to a transmission line or other 
device.
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Test Set A test set is the arrangement of hardware (switches, couplers, 
connectors and cables) that connect a test device input and output 
to the network analyzer’s source and receiver to make S-parameter 
measurements

Thru A Thru (through) is a calibration standard that is an actual through 
line. See SOLT.

Time Domain 
Network Analysis 
(TDNA)

TDNA includes both time domain reflectometry (TDR) and time 
domain transmission (TDT) measurements. 

Time Domain 
Reflectometry (TDR)

TDR gives an intuitive measurement of any discontinuities in a 
circuit. It measures the location, electrical length, nature of circuit 
(resistive, capacitive, inductive), and amount of reflection from 
discontinuities.

Time Domain 
Transmission (TDT)

TDT is a measurement technique that measures both attenuation 
and propagation delay of your device under test. 

TRL 
(Thru-Reflect-Line) 
Calibration

Microstrip devices in the form of chips, MMIC’s, packaged tran-
sistors, or beam-lead diodes cannot be connected directly to the 
coaxial ports of the test system. The DUT must be physically 
connected to the test system by some kind of transition network 
or fixture. 

A calibration at the coaxial ports of the test system removes the 
effects of the system and any cables or adapters before the fix-
ture; however, the effects of the fixture itself are not accounted 
for. An in-fixture calibration is preferable, but high-quality SOLT 
standards may not be readily available to allow a conventional 
full 4-port calibration at the desired measurement plane of the 
device. In microstrip, a short circuit is inductive, an open circuit 
radiates energy, and a high-quality purely resistive load is diffi-
cult to produce over a broad frequency range. The TRL calibra-
tion is an alternative to the full 4-port SOLT calibration technique 
that utilizes simpler, more convenient standards for device mea-
surements in the microstrip environment.
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TRL (continued) TRL calibration is convenient in that calibration standards can be 
fabricated for a specific measurement environment, such as a 
transistor test fixture or microstrip. The TRL calibration relies on 
the characteristic impedance of simple transmission lines rather 
than on a set of discrete impedance standards. Since transmission 
lines are relatively easy to fabricate (in a microstrip, for 
example), the impedance of these lines can be determined from 
the physical dimensions and substrate’s dielectric constant. 

− V −

Velocity Factor Velocity factor is a numerical value related to the speed of energy 
through transmission lines with different dielectrics (.66 for 
polyethylene). In making time domain measurements, a velocity 
factor of 1 = speed of light =299.7925 x 106 m/s.

Vertical Resolution Vertical resolution is the degree to which an instrument can 
differentiate amplitude between two signals.

− W −

Waveform A waveform is a representation of a signal plotting amplitude 
versus time.

− Z −

Zero Level Zero level is a measure of the mean value of the logical 0 of an eye 
diagram.

Zo Zo is the characteristic impedance of a transmission line.
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Procedures
The procedures in this appendix may be required while using the physical layer test system; 
however, they are not used commonly. The following is a list of the procedures.

• Using the Network Analyzer to Make 2-Port Measurements is used when you want to 
make 2-port measurements using only the network analyzer.

• Converting a CitiFile to a PLTS Adapter File is used when you want to convert a citifile 
(“.cit”) containing measured data to an adapter file (“.txs”) for de-embedding.

• IF Gain Adjustment is used to set up the N8362A or N8364A PNA network analyzer, with 
firmware revision less than 3.0, to be used in the PLTS system.
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Using the Network Analyzer to Make 2-Port Measurements
You can make two port measurements using the front panel control of the network analyzer 
without having to disconnect the network analyzer from the test set using the following 
procedure.

1. Turn off the PLTS software.

2. Toggle the power on the test set to reset the switches.

3. Leave the power of the test set in the ON position.

4. Use the network analyzer from the front panel.
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Converting a CitiFile to a PLTS Adapter File
The Physical Layer Test System uses adapter files to de-embed measurement data. PLTS 
adapter files (“.txs” files) can be created by adding a two-line comment near the top of an 
S-parameter citifile (“.cit” file) as shown below. You can use an MS Windows-based ASCII text 
editor such as Notepad to perform this procedure. The following shows a citifile for a thru 
device with 3.5mm connector at each end. (The measurement data within this example file 
has been replaced with a vertical ellipsis only as a space savings for this example.)

CITIFILE A.01.00
NAME S-Parameters
VAR FREQ MAG 400
DATA S[1,1] RI
DATA S[1,2] RI
DATA S[2,1] RI
DATA S[2,2] RI
SEG_LIST_BEGIN
SEG 50000000 20000000000 400
SEG_LIST_END
BEGIN
.
.
.
END

Using the two comment lines shown below, identified with “#TXS”, the type of device and the 
connector type of its ports are identified.

#TXS TYPE=THRU
#TXS PORT1=3.5MM   PORT2=3.5MM

These two comment lines are inserted be the first and second line of the citifile as shown 
below. This is then saved as a “.txs” file in the PLTS deembedding directory.

CITIFILE A.01.00
#TXS TYPE=THRU
#TXS PORT1=3.5MM   PORT2=3.5MM
NAME S-Parameters
VAR FREQ MAG 400
DATA S[1,1] RI
DATA S[1,2] RI
DATA S[2,1] RI
DATA S[2,2] RI
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SEG_LIST_BEGIN
SEG 50000000 20000000000 400
SEG_LIST_END
BEGIN
.
.
.
END
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IF Gain Adjustment
This procedure is for N8362A and N8364A PNA network analyzers that have firmware 
revisions less than Revision 3.0.

It is recommended that the Service IF Gain Adjustment test be run before using the test set. 
This routine adjusts the R Channel receivers ALC gain to ensure phase lock over the entire 
frequency range of the PNA Series Network Analyzer. Connect the test set to the analyzer 
before adjusting the IF gain. 

NOTE When the analyzer is removed from the test set for service, or for other 
applications that do not require the test set, the IF gain adjustment must be 
run again to return the R Channel receiver ALC gain back to normal.

Adjustment Test

1. Close the PNA Series Network Analyzer window.

2. Open “My Computer”, located on the desk top, double click on “Hard Disk (c:).”
(You may also use Explorer). Refer to Figure B-1.

3. Open the following folder path: Programs Files/Agilent/Network Analyzer/Service
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Figure B-1 File Path on PNA Network Analyzer Window

4. Double click “ifgainadjust.exe.”

5. Minimize the PNA Network Analyzer window when it appears. You should see the IF Gain 
Adjust window.

Figure B-2 IF Gain Adjustment Window

6. Select the test set in the “Select Specials, if any” pull down menu and click on “Begin Adj.” 
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Index
Symbols
.cal file extension, 91, 106
.cit file extension, 380
.ecl file extension, 94
.txs file extension, 113, 380

Numerics
2-port measurements, making, 379
4 box thru configuration, 87, 88
4 cross thru configuration, 87, 88
4-channel SOLT calibration, 82, 83, 84
4-channel TRL calibration, 83
4-channel TRL calibration procedure, 100
50 ohm cable option, 9
6 cross thru configuration, 87, 88

A
A IN connector, 303, 306, 310
A OUT connector, 303, 307, 311
About PLTS menu selection, 276
ac power, 23

cord, 8
frequency range, 23

AC symbol, 355
accessories, 8
acoustic noise emission, 359
actual measured parameters, 207
Actual Measured Parameters menu 

selection, 232
adapter

all others characterization category, 108
characterization, 107–113
characterization file, 95, 113
check box, 95
in-series, same-sex characterization 

category, 108
marking, 107, 255
orientation, 107, 255
reverse orientation, 221

adapter file, 380
Adapter Installation window, 109
address switch, 21, 304, 308, 312, 316, 320
address, GPIB, 21
Adjust Port Reference Plane menu selection, 

253
adjustment, IF gain, 23, 382
ADS, 205, 207
ADS menu selection, 232
advanced, 67
Advanced button, 82
Agilent Technologies offices, 350, 351

All menu selection, 267, 272
all others adapter characterization category, 

108
altitude, 23, 297
amplitude, eye, 168
analysis type, 72
analysis type, selecting the, 71
analyzer model number, 64
analyzer setup, 10
analyzing measurement data, 72
Apply menu selection, 260, 262
arbitrary bitstream, 173, 174
assistance, 350
Australian Spectrum Management Agency, 

355
AUXILIARY connector, 303, 307, 311, 315, 

319

B
B IN connector, 303, 307, 311
B OUT connector, 303, 307, 311
Balanced 1234, 230, 231
Balanced 1324, 230, 231
balanced measurement system 

interconnections, 48, 54–57
balanced S-parameters, 120–121
balanced transmission line pc board, 8
balanced transmission line, connecting a, 70
bandwidth, setting the IF, 68
bar

cursor, 38
format, 35
information, 36
menu, 34
parameter, 39
scaling, 39
scaling for frequency domain, 132
scaling for RLCG, 201
scaling for time domain, 159
status, 38
title, 34
tool, 41

before applying power safety considerations, 
357

bench top installation, 16
bending, cable, 334
bent connector center pin, 333
bias fuse, 329
bias range, 286
bit pattern

choosing a, 173
creating a, 169
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menu selection, 169, 261
saving, 171

bit rate, 168
bit representation area, 170
bitstream, arbitrary, 173, 174
browser, 40
Browser menu selection, 241
BUS ADDRESS switch, 304, 308, 312, 316, 

320
bus connector, 304, 308, 313, 316, 320

C
cable

bends, 334
care, 333
center pins, 333
GPIB, 22
handling, 334
option, 9

cables, 20
connecting ECal, 93
semirigid interconnect, 8

calculations, time domain, 72, 150
Calibrate menu selection, 247
calibrate, reason to, 78
calibrating hardware, 67
calibration, 278

changing parameters, 82
checking the data, 81
comparing thru path, 88
electronic, 92–95
icon color changes, 88, 90
interface, mechanical, 86
kit, 9
kit frequency range, 85
kit minimum rise time, 85
kit, defining a, 96
kit, selecting a, 82, 83, 84, 85, 100
loading existing data, 66
mechanical, 85–91
parameters window, 82
performing, 69
performing a new, 66
procedure, 82–113
prompt, 90
saving data, 91, 106
short/open/load, 89
SOL, 89
thru, 87
thru icon, 88

TRL, 96–106
type, selecting, 83, 84, 100
type, selecting a, 82
without prompts, 89

Calibration menu selection, 247
calibration procedure, TRL, 100
Canadian

EMC requirements, 359
Interference-Causing Equipment Standard 

symbol, 355
Standards Association symbol, 355

care of connectors, 335
cautions

before applying power, 357
definition, 354
general, 358
safety earth ground, 356
servicing, 357

CD-ROM, 5, 8
CE symbol, 355
changing parameters, 82
changing range, 68
Channel Reference Impedance menu 

selection, 253
characteristic impedance, 193
characteristic T-Line, 195
characteristics, 277–298
characterization file

adapter, 95, 113
ECal module, 94, 95

Characterize Adapter menu selection, 107, 
254

characterize adapters, 107–113
check box, adapter, 95
check box, reverse orientation, 95
checking the calibration, 81
chirp-z transform, 138
CitiFile, 113
Citifile menu selection, 230, 232
CitiFile, converting a, 380
cleaning connectors, 337
cleaning the test set, 331
cm, 158
cm menu selection, 269
colors

calibration icon changes, 88, 90
of icons, 88, 89

common mode, 190
communication bus connector, 304, 308, 313, 

316, 320
comparing thru path calibrations, 88
compatible network analyzer options, 10
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compliance with
Canadian EMC requirements, 359
German noise requirements, 359

computer requirements, 5
conformity, declaration of, 360
connecting the device under test, 70
connector

care, 335
mating, 333
torque, 333

Continuous sweep indicator, 38
Continuous Sweep menu selection, 238
cord, ac power, 8
corrected, 278
coupled transmission line, 187

RLCG extraction, 190
COUPLER connector, 302, 303, 314, 315, 318, 

319
COUPLER IN connector, 306, 307, 310, 311
CSA symbol, 355
C-Tick mark, 355
cursor bar, 38
cursors

delta, 134, 162, 179, 204
using eye diagram, 178
using frequency domain, 134
using RLCG, 203
using time domain, 161

Cursors menu selection, 242
Custom Adapter Characterization Wizard, 

108–112

D
damage from shipment, 6
damage level, 282, 286, 290, 295
Data menu, 266
Data Sharing menu selection, 257
dB, angle menu selection, 232
DC bias range, 286
declaration of conformity, 360
de-embedding, 218–222

file, 380
indicator, 38, 222
menu selection, 220, 251

delta, cursor, 134, 162, 179, 204
depth, 298
Design menu selection, 260, 261
detecting hardware, 64
deterministic jitter, 168
device under test

connecting, 70

sample, 8
device, golden, 81
dielectric loss, 186
Diff/Com parameters, 190
difference, cursor, 134, 162, 179, 204
differential mode, 190
digital pattern

choosing a, 173
creating a, 169
generator, 169

dimensions, 298
directivity, 280, 284, 288, 293
drift errors, 78
dynamic range, 279, 283, 287, 292

E
earth ground wire, 328
ECal, 92–95

connecting the cables, 93
kit option, 9
module, 92
module characterization file, 94, 95
module connections, 92
module connector, 303, 307, 311, 315, 319
using adapters, 95
window, 92

Edit Cal Kit menu selection, 248
Edit TRL Calibration Kit, 250
electronic calibration, 92
electronic calibration. See also ECal
electrostatic discharge. See ESD
EMC requirements, Canadian, 359
environment operating conditions, 297
environment, operating, 23
equations, telegraphers, 187
equipment rack installation, 17
errors, 78
ESD

precautions, 328
supplies, 328

European Community symbol, 355
even mode, 190
existing calibration data, loading, 66
Exit menu selection, 237
Export menu selection, 231
exporting RLCG data, 205
exporting transmission line data, 205
extension, port, 217, 218
extraction, RLCG, 190
eye amplitude, 168
eye diagram, 167, 168

bit rate, 168
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choosing a digital pattern, 173
creating a digital pattern, 169
deterministic jitter, 168
eye amplitude, 168
eye width, 168
fall time, 168
one level, 167
opening plots, 172
rise time, 167
viewing all plots, 175
viewing custom plots, 177
viewing plots, 172–177
viewing single plots, 176
zero level, 167

eye height, 168
eye width, 168

F
factor, changing velocity, 68
fall time, 168
File menu, 227
filtering, 147
flange kit, 17
floor mat, static-control, 328
format bar, 35

frequency domain, 128
menu selection, 244
time domain, 157

format menu, 269
frequency domain, 128
time domain, 157

formats
selecting frequency domain, 128
selecting time domain, 157

forward orientation of adapters, 110, 111
frequency

range, 7, 85, 282, 286, 290, 295
range of power supply, 282, 286, 291, 296
setting start and stop, 68
step, setting, 68

frequency domain
changing parameters, 82
changing scale, 132
format bar, 35, 128
format menu, 128
menu selection, 233
modifying measurement parameters, 67
opening plots, 122
scale units, 133
selecting formats, 128

view parameters window, 71
viewing all plots, 123
viewing custom plots, 127
viewing plots, 122–127
viewing single plots, 125

front panel
N4415A, 302
N4416A, 306
N4417A, 310
N4418A, 314
N4419A, 318
N4421A, 322

fuse, bias, 304, 308, 312, 316, 320
fuse, power, 305, 309, 313, 317, 321

G
gaging connectors, 337
gain, IF, 23, 382
gating, 163, 211–216

adding a gate, 211
changing gate values, 216
deleting a gate, 215
menu selection, 211, 256
moving a gate, 215

Gating Bar menu selection, 243
general safety considerations, 358
generator, digital pattern, 169
Geraeuschemission, 359
German noise requirements, 359
glossary, 364
golden device, 81
GPIB, 5

address, 21, 329
address switch, 21, 304, 308, 312, 316, 320
address, viewing the, 64
card, 5
connecting the able, 22
connector, 304, 308, 313, 316, 320
STATUS LEDs, 302, 306, 310, 314, 318

ground wire, 328
Group Delay format, 128
G-S-G-S-G probe, 182

H
handle kit, 17
handles, 8
handling cables, 334
handling connectors, 337
hardware

auto-detection, 64
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calibration values, 67
indicator, 38
rescan, 65

heel straps, ESD, 328
height, 298
help, 350
Help menu, 276
Help menu selection, 276
hSpice, 205

menu selection, 232
humidity, 23, 297

I
ICES-001, 359
icon color, 88, 89
icon, software, 28
IEEE-488 connector, 304, 308, 313, 316, 320
IF bandwidth

setting, 68
IF gain, 23, 382
Imaginary format, 129
impedance, 282, 286, 290, 295

channel reference, 253
characteristic, 193
format selection, 157
indicator, 38
port, 253

Impedance menu selection, 269
Import menu selection, 230
Impulse, 157
impulse

reflection, 141
transmission, 141

Impulse menu selection, 269
IN connector, 315, 319
incompatible network analyzer options, 10
Industrial Scientific and Medical Group 1 

Class A product, 355
information bar, 36
Information Bar menu selection, 246
initial software setup, 64–69
input voltage, 23
input voltage range of power supply, 282, 

286, 291, 296
in-series, same-sex adapter characterization 

category, 108
insertion loss, 282, 286, 290, 295
inspecting connectors, 337
installation, 3–30

bench top, 16
equipment rack, 17
software, 25

instrument documentation symbol, 355
instrument markings, 355
interconnect cables, 8
interconnections, 20, 42–57
inverse Fourier transform, 138
ISM1-A symbol, 355
isolation, 282, 286, 290, 295

J
jitter, deterministic, 168

K
key, piano, 170
kit, defining a calibration, 96
kit, selecting a calibration, 82, 83, 84, 85, 100

L
LEDs, GPIB STATUS, 302, 306, 310, 314, 318
level

damage, 282, 286, 290, 295
operating, 282, 286, 290, 295

licence the software, 26
licensing, iii
line fuse, 329
Linear Mag, 128
list of open measurement windows, 275
load

icon, 89
match, 280, 284, 288, 293
measurement button, 62
termination, 329

loading existing calibration data, 66
Log Mag, 157
Log Mag format, 128
Log Mag menu selection, 269, 270
loss

insertion, 282, 286, 290, 295
transmission line, 186

lossless symmetrical coupled transmission 
line, 187

M
mag, angle menu selection, 232
magnitude, reflection, 281, 285, 289, 294
magnitude, transmission, 281, 285, 289, 294
main window, 33
maintenance, 331
making a measurement, 70–72
making connections, 337
manual, 8
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markers, 38
using eye diagram, 178
using frequency domain, 134
using RLCG, 203
using time domain, 161

markings, 355
masking, 146
mat, floor, static-control, 328
mat, table, static-control, 328
match

load, 280, 284, 288, 293
source, 280, 284, 288, 293

Math menu selection, 259
maximum time base, 67
Measure button, 72, 110
Measure menu, 238
measurement, 72

indicator, 38
Load Measurement button, 62
making a, 70–72
New Measurement button, 62
parameters, resetting, 67
port, 280, 284, 288, 293
uncertainty, 281, 285, 289, 294
viewing and analyzing results, 72
window, 70
window list, 275

measurements, making 2-port, 379
mechanical calibration, 85–91

interface, 86
menu

bar, 34
Data, 266
File, 227
Format, 269
Help, 276
Measure, 238
Options, 273
RLCG, 271
Tools, 259
Utilities, 247
View, 240
Window, 275

menu selection, 267
About PLTS, 276
Actual Measured Parameters, 233
Adjust Port Reference Plane, 253
ADS, 232
All, 267, 272
Apply, 260, 262

Bit Pattern, 169, 261
Browser, 241
Calibrate, 247
Calibration, 247
Channel Reference Impedance, 253
Characterize Adapter, 254
Citifile, 230, 232
cm, 269
Continuous Sweep, 238
Cursors, 242
Data Sharing, 257
dB, angle, 232
De-embedding, 220, 251
Design, 260, 261
Edit Cal Kit, 248
Exit, 237
Export, 231
Format Bar, 244
Frequency Domain, 233
Gating, 211, 256
Gating Bar, 243
Help, 276
hSpice, 232
Impedance, 269
Import, 230
Impulse, 269
Information Bar, 246
Log Mag, 269, 270
mag, angle, 232
Math, 259
ML2CTL, 233
New, 228
New Plot, 268, 272
New Trace, 268, 272
New Window, 275
ns, 269
Open, 228
open measurement window list, 275
Parameter Bar, 242
Plots to Clipboard, 231
Plots to Image, 231
Position Bar, 243
Print, 236
Print Setup, 235
Real, 269
real, imaginary, 232
Recent Files, 237
RLCG, 232
S11 through S44, 266, 267, 271
390



Index
Save, 229
Save As, 229
Scaling Bar, 245
SCC11 through SDC22, 267
SCD11 through SCD22, 267
SDC11 through SDC22, 267
SDD11 through SDD22, 267
Set Velocity Factor, 265
Start, 238
Status Bar, 241
Step, 269
Stimulus, 239
Stop, 238
TCC11 through TDC22, 266
TCD11 through TCD22, 266
TDC11 through TDC22, 266
TDD11 through TDD22, 266
Time Domain, 232
Time Domain Window, 147, 265
T-Line Characteristics, 263, 264
Toolbar, 240
Touchstone, 231, 232
User Preferences, 273
Volts, 269

microwave connector care, 335
minimum rise time, 67
mixed-mode S-parameters, 120–121
ML2CTL menu selection, 233
ML2CTL model, 207
model number

network analyzer, 7, 64
test set, 7, 64

modify time and frequency parameters, 67, 
82

module characterization file, 94
module connections, 92

N
N1947A interconnections, 44
N1948A interconnections, 46
N1951A interconnections, 48
N1953A interconnections, 50
N1957A interconnections, 52
N4443A interconnections, 56
N4444A interconnections, 54
N4446A interconnections, 48
network analyzer

model number, 64
options, 7
setup, 10

new calibration, performing a, 66
new measurement button, 62
New menu selection, 228
New Plot, 39
New Plot menu selection, 268, 272
New Trace, 39
New Trace menu selection, 268, 272
New Window menu selection, 275
noise emission, acoustic, 359
noise requirements, German, 359
nominal, 278
ns, 158
ns menu selection, 269
number of points

changing, 68

O
odd mode, 190
off symbol, 355
offices of Agilent Technologies, 350, 351
on symbol, 355
ON/OFF switch, 303, 307, 311, 315, 318
one level, 167
online assistance, 350
open icon, 89
open measurement window list, 275
Open menu selection, 228
opening plots

choosing a digital pattern for eye 
generation, 173

eye diagram, 172
frequency domain, 122
RLCG, 194
time domain, 151

opening the startup wizard, 82
operating environment, 23, 297
operating level, 282, 286, 290, 295
option

060, 9
1CP, 9
B20, 9
UNK, 286

options, 9
network analyzer, 7, 10

Options menu, 273
orientation of adapters, 107, 255

forward, 110, 111
reverse, 112, 221

original values, 67
OUT connector, 315, 319
output plots, RLCG, 192
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P
packing materials, 351
parameter bar, 39
Parameter Bar menu selection, 242
parameters

actual measured, 207
changing, 82
mixed-mode (balanced) S, 120–121
recalculating, 82
RLCG, 189
S, 117–121
single-ended (unbalanced) S, 118–119
Spice, 189
view window, 71
window, 82

pattern, bit, 169, 173
pc board

sample balanced transmission line, 8
PC requirements, 5
Pentium, 5
Phase format, 128
phase skew, 217–219
phase uncertainty, 281, 285, 289, 294
physical characteristics, 298
physical layer test system interconnections, 

44–53
piano key, 170
plane, adjust reference, 253
plane, rotating the reference, 217, 218
plot window, 37
plots

opening eye diagram, 172
opening frequency domain, 122
opening RLCG, 194
opening time domain, 151
RLCG output, 192
viewing all eye diagram, 175
viewing all frequency domain, 123
viewing all RLCG, 197
viewing all time domain, 152
viewing custom eye diagram, 177
viewing custom frequency domain, 127
viewing custom RLCG, 200
viewing custom time domain, 156
viewing eye diagram, 172–177
viewing frequency domain, 122–127
viewing RLCG, 194–200
viewing single eye diagram, 176
viewing single frequency domain, 125
viewing single RLCG, 198

viewing single time domain, 154
viewing time domain, 151–156

Plots to Clipboard menu selection, 231
Plots to Image menu selection, 231
points, changing the number of, 68
Polar Chart format, 129
PORT 2 BIAS connector, 304, 308, 312, 316, 

320
PORT 2 connector, 302, 306, 310, 314, 318
PORT 2 FUSE, 304, 308, 312, 316, 320
PORT 4 BIAS connector, 308, 312, 316, 320
PORT 4 connector, 302, 307, 311, 315, 318
PORT 4 FUSE, 304, 308, 312, 316, 320
port extension, 217, 218
port impedance, 253
Position Bar menu selection, 243
power

setting, 68
power cord, 8
power cord connector, 305, 309, 313, 317, 321
power source requirements, 23
power supply requirements, 282, 286, 291, 

296
POWER switch, 303, 307, 311, 315, 318
Print menu selection, 236
Print Setup menu selection, 235
probing, transmission line, 182
procedures, 377–383
prompt, calibration, 90
propagation constant, 193

R
R IN connector, 303, 315, 319
R OUT connector, 303, 315, 319
R1 IN connector, 306, 310
R1 OUT connector, 307, 311
R2 IN connector, 307, 311
R2 OUT connector, 307, 311
rack mount option, 9
rail set, 17
RAM, 5
random errors, 78
range

DC bias, 286
frequency, 282, 286, 290, 295
resolution, 149
resolution, setting, 68
system dynamic, 279, 283, 287, 292

Real, 157
Real format, 129
Real menu selection, 269
real, imaginary menu selection, 232
392



Index
rear panel
N4415A, 304
N4416A, 308
N4417A, 312
N4418A, 316
N4419A, 320
N4421A, 324

recalculate parameters, 68
Recalculate Parameters button, 82, 109
Recent Files menu selection, 237
record length, 67
REF 1 R IN connector, 305, 308, 312, 317, 320
REF 1 R OUT connector, 304, 308, 312, 316, 

320
REF 2 R IN connector, 308, 312, 316, 320
REF 2 R OUT connector, 309, 313, 316, 321
reference plane, 253
reference plane, rotating the, 217, 218
reflection magnitude, 281, 285, 289, 294
reflection tracking, 280, 284, 288, 293
reflection, impulse, 141
reflection, step, 141
Ref-Z indicator, 38
repairs, 351
requirements, computer, 5
rescanning for hardware, 65
resetting parameter values, 67
resolution, 68

range, 149
response, 149

response resolution, 149
reverse adapter orientation, 112, 221

check box, 95
RF connector care, 335
RF power, 329
ripple, 329
rise time, 167

minimum, 67, 85
setting, 68

RLCG
changing scale, 201
exporting data, 205
extraction, 190
menu, 271
menu selection, 232
opening plots, 194
output plots, 192
parameters, 181–207
scale units, 202
viewing all plots, 197
viewing custom plots, 200

viewing plots, 194–200
viewing single plots, 198

rotating the reference plane, 217, 218
run the software, 28

S
S11 through S44 menu selection, 266, 267, 

271
safety considerations, 356–358

before applying power, 357
general, 358
safety earth ground, 356
servicing, 357

safety earth ground safety considerations, 
356

safety symbols, 354
sample device under test, 8
sample pc board, 8
Save As menu selection, 229
Save menu selection, 229
saving

a bit pattern, 171
calibration data, 91, 106

scale
changing frequency domain, 132
changing RLCG, 201
changing time domain, 159
frequency domain horizontal, 133
frequency domain units, 133
frequency domain vertical, 133
RLCG horizontal, 202
RLCG units, 202
RLCG vertical, 202
time domain horizontal, 160
time domain units, 160
time domain vertical, 160

scaling bar, 39
frequency domain, 132
RLCG, 201
time domain, 159

Scaling Bar menu selection, 245
scanning for hardware, 65
SCC11 through SDC22 menu selection, 267
SCD11 through SCD22 menu selection, 267
screen, main, 33
SDC11 through SDC22 menu selection, 267
SDD11 through SDD22 menu selection, 267
Select Adapter Files, 95
selecting the analysis type, 71
self parameters, 190
semirigid interconnect, 20
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semirigid interconnect cables, 8, 20
servicing safety considerations, 357
Set Velocity Factor menu selection, 265
Setup Stimulus button, 109
setup, software, 64–69
shipment damage, 6
shipment for service, 351
shipping materials, 351
short icon, 89
short/open/load calibration, 89
signatures, time domain, 141
single-ended S-parameters, 118–119
skew, phase, 217–219
Smith Chart format, 129
software

CD-ROM, 8, 25
icon, 28
initial setup, 64–69
installation, 25
licence, 26
window, 33

SOL calibration, 89
SOLT calibration, 83, 84

interface, 86
source match, 280, 284, 288, 293
SOURCE OUT connector, 307, 311
S-parameters, 117–121

mixed-mode (balanced), 120–121
single-ended (unbalanced), 118–119

specifications, 277–298
Spice parameters, 189, 190
start frequency, setting the, 68
Start menu selection, 238
start the software, 28
startup wizard, 62

opening, 82
static-safe workstation, 328
Status bar, 38, 222
Status Bar menu selection, 241
Step, 157
step

reflection, 141
setting frequency, 68
transmission, 141

Step menu selection, 269
stepped measurement parameter, 68
stepped measurement, selecting, 68
Stimulus menu selection, 239
Stimulus Parameters window, 109
stimulus, view window, 71
stop frequency, setting the, 68
Stop menu selection, 238

storage altitude, 297
storing connectors, 337
sweep, continuous indicator, 38
swept measurement parameter, 68
switch

BUS ADDRESS, 304, 308, 312, 316, 320
GPIB address, 21
POWER, 303, 307, 311, 315, 318

SWITCH connector, 302, 303, 314, 315, 318, 
319

symbols, 355
symmetrical lossless coupled transmission 

line, 187
system

configurations, 7
dynamic range, 279, 283, 287, 292
interconnections, 42–57
warmup time, 85, 92, 100
weight, 6

systematic errors, 78

T
T11 through T44 menu selection, 267
table mat, static-control, 328
TCC11 through TDC22 menu selection, 266
TCD11 through TCD22 menu selection, 266
TDC11 through TDC22 menu selection, 266
TDD11 through TDD22 menu selection, 266
telegraphers equations, 187
telephone numbers, Agilent, 350
temperature, 297
temperature requirements, 23
test

cable, care of, 333
port connector type, 282, 286, 290, 295
set model number, 64
set performance, 282, 286, 290, 295
set ports, 107, 255

thru
calibration, 87
configuration, 88
configuration options, 87
configuration patterns, 88
icon, 88
path calibrations, comparing, 88
paths, 87

time base
maximum, 67
setting, 68

time domain
calculation, 150
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changing parameters, 82
changing scale, 159
comparison to frequency domain, 138
filtering, 147
format bar, 35, 157
format menu, 157
gating, 163, 211–216
horizontal axis, 158
masking, 146
measurement, 138
menu selection, 232
modifying measurement parameters, 67
opening plots, 151
range resolution, 149
response resolution, 149
scale units, 160
selecting formats, 157
signatures, 141
stimulus, 157
vertical axis, 157
view parameters window, 71
viewing all plots, 152
viewing custom plots, 156
viewing plots, 151–156
viewing single plots, 154
windowing, 147, 265

Time Domain Window menu selection, 147, 
265

time, warmup, 85, 92, 100
title bar, 34
T-Line characteristic, 195
T-Line Characteristics menu selection, 263, 

264
toolbar, 41
Toolbar menu selection, 240
Tools menu, 259
torque, connector, 333
torque, interconnect cable, 20
Touchstone menu selection, 231, 232
tracking

reflection, 280, 284, 288, 293
transmission, 280, 284, 288, 293

transforms, balanced measurement, 72
transmission

impulse, 141
magnitude, 281, 285, 289, 294
step, 141
tracking, 280, 284, 288, 293

transmission line
connecting the sample, 70

coupled, 187
exporting data, 205
loss versus frequency, 186
lossless symmetrical coupled, 187
model, 184
parameters, 181–207
RLCG extraction, 190

transmission line. See also RLCG
triggers to calibrate, 80
TRL calibration, 83, 96–106
TRL calibration procedure, 100
typical, 278

U
unbalanced S-parameters, 118–119
uncertainty, 281, 285, 289, 294

phase, 281, 285, 289, 294
uncorrected, 278
unpacking the system, 6
User Preferences menu selection, 273
user’s guide, 8
Utilities menu, 247

V
validity of a time domain calculation, 150
velocity factor

changing, 68
ventilation requirements, 15, 358
View menu, 240
view, stimulus window, 71
Viewing, 123
viewing measurement data, 72
viewing plots

all eye diagram, 175
all frequency domain, 123
all RLCG, 197
all time domain, 152
custom eye diagram, 177
custom frequency domain, 127
custom RLCG, 200
custom time domain, 156
eye diagram, 172–177
frequency domain, 122–127
RLCG, 194–200
single eye diagram, 176
single frequency domain, 125
single RLCG, 198
single time domain, 154
time domain, 151–156

voltage requirements, 23
 395
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Volts, 157
Volts menu selection, 269

W
warmup time, 85, 92, 100
warnings

before applying power, 357
definition, 354
general, 358
safety earth ground, 356
servicing, 357

weight, 6, 298
welcome screen, 62
when to calibrate, 80
width, 298
window

Adapter Installation, 109
ECal, 92
main, 33
plot, 37
Stimulus Parameters, 109

Window menu, 275
windowing, time domain, 147, 265
Windows, 5
wizard

custom adapter characterization, 108–112
startup, 62

workstation, static-safe, 328
wrist strap, ESD, 328

Z
zero level, 167
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